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l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions tomeet your business
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Chapter 1: Introduction
The HP Operations Agent helps you tomonitor a system by collectingmetrics that indicate the health,
performance, and availability of essential elements of the system. While HP Operations Manager
(HPOM) presents you with the framework tomonitor andmanagemultiple systems through a single,
interactive console, the HP Operations Agent deployed on individual nodes helps you gather vital
information to facilitate themonitoring process.

TheHP Operations Agent and Infrastructure SPIs 12.00DVD media provides you with the HP
Operations Smart Plug-ins for Infrastructure (Infrastructure SPIs). If you want to install the
Infrastructure SPIs with the electronic media, make sure to download themedia for all node platforms
(and not a platform-specific ISO file). Platform-specific ISO files do not contain the Infrastructure SPIs.

Convention Used in this Document
The following convention is used in this document.

Convention Description

<OvInstallDir>

The installation directory for the HP Operations
Agent.

<OvInstallDir> is used in this document to
denote the following location:

l OnWindows: %ovinstalldir%

l OnHP-UX/Linux/Solaris: /opt/OV/

l OnAIX: /usr/lpp/OV/

<OvDataDir>

The directory for HP Operations Agent
configuration and runtime data files.

<OvDataDir> is used in this document to
denote the following location:

l OnWindows: %ovdatadir%

l OnHP-UX/Linux/Solaris: /var/opt/OV/

l OnAIX: /var/opt/OV/
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<OvInstallBinDir>

The bin directory contains all the binaries
(executables) of HP Operations Agent.

<OvInstallBinDir> is used in this document to
denote the following location:

l OnWindows x64:
%ovinstalldir%\bin\win64\

l OnWindows x32:
%ovinstalldir%\bin\win32\

l OnHP-UX/Linux/Solaris: /opt/OV/bin

l OnAIX: /usr/lpp/OV/bin

Best Practises for Installation of HP Operations Agent

Methods of Deploying HP Operations Agent

You can use one of the followingmethods to simplify the deployment of HP Operations Agent in large
environments:
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Formore information see:

1. Installing the HP Operations Agent Manually on the Node.

2. Installing from the HPOMConsole and Installing HP Operations Agent in a Single Step.

3. Installing HP Operations Agent from HP OMi. For more information see the topic Connecting HP
Operations Agents to OMi in the chapterMonitored Nodes in theOMi Administration Guide.

4. Installing HP Operations Agent using Agent Installation Repository.

5. Installing HP Operations Agent using the Puppet Environment

6. Installing and configuring HP Operations Agent on Linux using YUM
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7. Installing HP Operations Agent Using Red Hat Network Satellite Server

8. Installing HP Operations Agent Using HP Server Automation

Installing HP Operations Agent in a Single Step

The single step installer enables you to install the base version of HP Operations Agent along with
patches and hotfixes. The pre-requisites check occurs only once before the installation.

You can use the oainstall script to install HP Operations Agent locally on amanaged node, or use
the HPOM console to install HP Operations Agent remotely.

Using oainstall Script to Install HP Operations Agent

1. Log on to the node as root or administrator.

2. Download and extract themedia, patches, and hotfix packages to the same directory.

3. Go to the directory where you extracted the bits.

4. Run the following command:

On Windows

cscript oainstall.vbs –i -a

On HP-UX/Linux/Solaris

./oainstall.sh –i –a

Base version of HP Operations Agent along with patches and hotfixes are installed.

Installing HP Operations Agent from HPOM for Windows Management Server

Scenario 1: If the HP Operations Agent 12.00 is not installed on a node, follow the steps to install base
version, patches and hotfixes:
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Scenario 2: If the HP Operations Agent 12.00 is already installed on a node, follow the steps to install
patches and hotfixes:
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Installing HP Operations Agent from HPOM for UNIX Management Server

Scenario: If the HP Operations Agent 12.00 is not installed on a node, follow the steps to install base
version, patches and hotfixes:
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Co-existence of HP Operations Agent with other HP products

If you want to install or upgrade HP Operations Agent on a system where other HP products are
running, ensure you stop all the processes of HP products before you install or upgrade HP Operations
Agent. Restart the processes only after installation or upgrade is complete.

Installing the HP Operations Agent on Platforms Supported with
Limitation

To install the HP Operations Agent 12.00 remotely from the HPOM forWindows or UNIX console on
platforms supported with limitation, youmust set the variable MINPRECHECK to True in the profile
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file. Add the following content in the profile file:

set nonXPL.config:MINPRECHECK=True

Formore information see Installing the HP Operations Agent on Platforms Supported with Limitation.

See the HP Operations Agent Support Matrix document for more details on platforms supported with
limitation.

Enabling Secure Communication

To enable secure communication without allowing inbound traffic to the Communication Broker port,
youmust configure a reverse channel proxy (RCP).

Follow the steps to configure a RCP:

1. On a RCP node set the following configurations to enable RCP on a specific port number:

[bbc.rcp]

SERVER_PORT=<port number>

2. On the HPOMManagement server present in the trusted zone, set the following configurations to
open an Reverse Admin Channel (RAC):

[bbc.cb]

RC_CHANNELS=<RCP node name>:<port number>

ENABLE_REVERSE_ADMIN_CHANNELS=True

3. On a RCP node set the following to enable RCP on a specific port number:

[bbc.rcp]

SERVER_PORT=<port number>

4. On the HP Operations Agent nodes present in the untrusted zone, set the following configurations
to enable communication through RCP:

[bbc.http]

PROXY=<RCP node name>:<port number>+(<nodes to be included>)-(<Nodes to be
excluded>)

For example:

1. Onmyserver.serverdomain.com set the following configurations:

[bbc.cb]

RC_CHANNELS=myrcp.mydomain.com:1025

ENABLE_REVERSE_ADMIN_CHANNELS=True
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2. Onmyrcp.mydomain.com set the following:

[bbc.rcp]

SERVER_PORT=1025

3. Onmyagent.mydomain.com set the following:

[bbc.http]

PROXY=myrcp.mydomain.com:1025+(*)-
(myrcp.mydomain.com,myrcp,myagent.mydomain.com,myagent)

In this instance:

n myserver.serverdomain.com is the HPOMManagement server

n myrcp.mydomain.com is the Reverse Channel Proxy node

n myagent.mydomain.com is the HP Operations Agent node

n * specifies that all nodes must be included

For more information see, Introduction to the Reverse Channel Proxy.

On the RCP system, register ovbbcrcpwith ovc so that this process is started, stopped, and
monitored by ovc.

For example:

On Windows

cd "c:\program files\hp openview\newconfig\datadir\conf\bbc"

"c:\program files\hp openview\bin\ovcreg" -add ovbbcrcp.xml

On HP-UX/Linux/Solaris

/opt/OV/bin/ovcreg –add \ /opt/OV/newconfig/DataDir/conf/bbc/ovbbcrcp.xml

Planning the Installation of HP Operations Agent
Installing the HP Operations Agent Remotely from the HPOM Management Server

In a centralizedmonitoring environment with HPOM, you can register the deployment packages for the
HP Operations agent 12.00 on themanagement server, and then centrally deploy the agent packages
on different nodes from the HPOM console.

This process involves:
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1. Install the HP Operations Agent 12.00 on the HPOMmanagement server.

2. Registering the HP Operations Agent 12.00 deployment packages on the HPOMmanagement
server.

Tip: A registration process ensures that the HP Operations agent deployment package is
placed in the appropriate location on the deployment server (a server from which you can
deploy the agent on nodes).

The process of registering the HP Operations Agent deployment packages automatically installs
the Infrastructure SPIs on the HPOM server. You can configure the installer to skip the installation
of the Infrastructure SPIs.

3. Installing the HP Operations Agent centrally from the HPOM console.

Installing the HP Operations Agent Manually on the Node

You can install the HP Operations Agent from theHP Operations Agent and Infrastructure SPIs 12.00
media by manually logging on to themanaged node.

This process involves:

1. Preparing the node

You can prepare amanaged node for the agent installation by doing one of the following:

n Insert theHP Operations Agent and Infrastructure SPIs 12.00 physical media to the DVD
drive.

n Extract the contents of theHP Operations Agent and Infrastructure SPIs 12.00 electronic
media into a local directory.

n Mount theHP Operations Agent and Infrastructure SPIs 12.00 physical media.

n Transfer the deployment packagemanually from the HPOMmanagement server

2. Install the agent with the installer program (oainstall or oasetup) available with theHP
Operations Agent and Infrastructure SPIs 12.00media or the deployment package.
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Installing Only the Infrastructure SPIs

You can install only the Infrastructure SPIs on the HPOMmanagement server by using theHP
Operations Agent and Infrastructure SPIs 12.00.

This process involves:

1. Preparing a configuration file on the HPOMmanagement server.

2. Installing the Infrastructure SPIs with the installer program (oainstall or oasetup) available with
theHP Operations Agent and Infrastructure SPIs 12.00media.

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 18 of 197



Chapter 2: Registering the HP Operations Agent and
Infrastructure SPIs on the HPOM Management Server
(and Installing the Infrastructure SPIs)

Registering on the HPOM for Windows Management Server
Prerequisites

No deployment jobs must run at the time of registering the deployment package.

Follow the steps to view the active deployment jobs:

1. In the console tree, expand Policy Management.

2. Click Deployment Jobs. The details pane shows the list of active deployment jobs. Youmust
make sure that none of the deployment jobs are active at the time of installing the agent
deployment packages. Youmust not start any deployment jobs until the agent deployment
package registration is complete.

l If the HP Performance Agent 4.70 deployable forWindows or UNIX/Linux is available on the
management server, youmust either install the HP Performance Agent 4.72 deployable or remove
the HP Performance Agent 4.70 deployable completely before registering the deployment packages
for the HP Operations Agent 12.00. You can remove the deployable packages using theControl
Panel.

l Disk space: 1 GB

l The oainstall program installs the Infrastructure SPIs on themanagement server while registering
the deployment package. If you want to install the Infrastructure SPIs, make sure the system
meets the following additional requirements:

Hardware and Software Requirements

For a list of supported hardware, operating systems, HPOM version, and agent version, see the
Support Matrix.

Disk Space Requirements

Temporary Directorya Total Disk Space

%tmp% - 15MB 90MB
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aThe disk space for the temporary directory/drive is required only during installation. These are
approximate values.

Upgrade Requirements

You can directly upgrade the Infrastructure SPIs version 2.00 or above to the version 12.00.

Youmust install the HP Operations Agent 12.00 on themanagement server to be able to register
the deployment packages. For more information upgrading the HP Operations Agent, see "Upgrade
Notes".

Register the Deployment Package

In addition to registering the deployment package for the HP Operations Agent, the oainstall script
can install the Infrastructure SPIs on themanagement server.

However, the capability to install the Infrastructure SPIs is available only with the physical DVD or the
electronic media that contains agent packages for all node platforms. Platform-specific media does not
include the Infrastructure SPIs.

Choose one of the following tasks based on your requirement:

l "Register the HP Operations Agent deployment packages for all platforms and install the
Infrastructure SPIs." on the next page

l "Register the HP Operations Agent deployment package for a specific node platform by using a
platform-specific ISO file." on the next page

l "Register the HP Operations Agent deployment packages for all platforms, and install the
Infrastructure SPIs, but do not install the graph or report package." on page 22

l "Register the HP Operations Agent deployment packages for all platforms, but do not install the
Infrastructure SPIs." on page 23

l "Register the HP Operations Agent deployment packages for selected platforms and install the
Infrastructure SPIs" on page 24
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Task Follow these steps

Register the HP Operations Agent
deployment packages for all platforms
and install the Infrastructure SPIs.

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as administrator.

3. Go to themedia root.

4. Run the following command:

cscript oainstall.vbs -i -m

5. Verify the registration process.

Register the HP Operations Agent
deployment package for a specific node
platform by using a platform-specific
ISO file.

1. Make sure that you downloaded the .ISO file for the
node platform of your choice.

2. Log on to themanagement server as administrator.

3. Go to themedia root.

4. Run the following command:

cscript oainstall.vbs -i -m

5. Verify the registration process.

Registering the Deployment Package
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Task Follow these steps

Register the HP Operations Agent
deployment packages for all platforms,
and install the Infrastructure SPIs, but
do not install the graph or report
package.

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as administrator.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=YES

InfraSPI_With_Graphs=NO

InfraSPI_With_Reports=NO

Note: If you want to install the graph package
and report package, set the InfraSPI_With_
Graphs and InfraSPI_With_Reports properties
to YES else set it to NO.

5. Save the file.

6. Go to themedia root.

7. From themedia root, run the following command:

cscript oainstall.vbs -i -m -spiconfig <file_name>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path).

The command registers the agent deployment
packages for all platforms on themanagement server
and installs the Infrastructure SPIs, but skips the
installation of the graphs and reports packages for the
Infrastructure SPIs.

Registering the Deployment Package, continued
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Task Follow these steps

Register the HP Operations Agent
deployment packages for all platforms,
but do not install the Infrastructure
SPIs.

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as administrator.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=NO

InfraSPI_With_Graphs=NO

InfraSPI_With_Reports=NO

5. Save the file.

6. Go to themedia root.

7. From themedia root, run the following command:

cscript oainstall.vbs -i -m -spiconfig <file_name
with complete path>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path).

The command registers the agent deployment
packages for all platforms on themanagement
server, but skips the installation of the Infrastructure
SPIs.

Registering the Deployment Package, continued
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Task Follow these steps

Register the HP Operations Agent
deployment packages for selected
platforms and install the Infrastructure
SPIs

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as administrator.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=YES

InfraSPI_With_Graphs=

InfraSPI_With_Reports=

Note: Depending on whether you want to skip
the installation of the graph or report packages,
set the InfraSPI_With_Graphs and InfraSPI_
With_Reports properties to YES or NO.

5. Save the file.

6. Go to themedia root.

7. From themedia root, run the following command:

cscript oainstall.vbs -i -m -p <platform> -
spiconfig <file_name>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path);
<platform> is the node platform for which you want to
register the deployment package.

Use the following values for <platform>:

ForWindows:WIN

For HP-UX: HP-UX

For Linux: LIN

Registering the Deployment Package, continued
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Task Follow these steps

For Solaris: SOL

For AIX: AIX

The command registers the agent deployment
packages for the specific platforms on the
management server and installs the Infrastructure
SPIs.

You can specify multiple platforms in a single
command line. For example, to install deployment
packages for AIX and Solaris:

cscript oainstall.vbs -i -m -p AIX -p SOL

Registering the Deployment Package, continued

Note: After installation, see Install Report andGraph Packages on a Remote Server if you want to
install report or graph packages on a remote server.

WhenHPOM is in a High-Availability (HA) Cluster

Follow the above steps on the active node in the HPOMHigh-Availability (HA) cluster:

After completing the steps, perform the following steps:

1. Fail over to the active node.

2. Go to the %OvShareDir%server\installation directory.

3. Run the following command:

cscript oainstall_sync.vbs

After you run the installation command, the registration procedure begins. Depending on number of
selected packages, the registration process may take up to 20minutes to complete.

Verification

1. On themanagement server, go to the following location:

On HPOM forWindows Management Server version 8.xx:

%ovinstalldir%bin\OpC\agtinstall

OnHPOM forWindows Management Server version 9.xx:

%ovinstalldir%bin\win64\OpC\agtinstall
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2. Run the following command:

cscript oainstall.vbs -inv -listall

The command shows the list of available (active) deployment packages on themanagement
server.

To check that the Infrastructure SPIs are installed, run the commandwith the -includespi
option.

cscript oainstall.vbs -inv -includespi -listall

3. Locate the platform for which you installed the deployment package. If the active version is
displayed as 12.00, as in the following figure, the registration is successful.

Log File

The registration log file (oainstall.log) is available in the following directory:

%OvDataDir%shared\server\log

Placement of Packages

When you register the HP Operations Agent packages on themanagement server, the oainstall
program places all necessary deployment packages into the following directory:

%OvDataDir%shared\Packages\HTTPS

Backup of Deployment Packages

When you register the deployment packages on themanagement server, the oainstall script saves
a copy of the older deployment packages into the following local directory:

%OvShareDir%server\installation\backup\HPOpsAgt\<OS>\<OA_Version>\<ARCH>

To view the active deployment packages, run the following command:

cscript oainstall.vbs -inv

To view all deployment packages (active and backed-up) on the system, run the following command:

cscript oainstall.vbs -inv -listall

To check that the Infrastructure SPIs are installed, run the commandwith the -includespi option.

cscript oainstall.vbs -inv -includespi -listall

Alternate Backup Location

When the default backup location does not have sufficient space to accommodate the backed up
deployment packages, you can configure the system to use an alternate backup location.

Run the following command on themanagement server to use a non-default location to back up the old
deployment package:

ovconfchg -ovrg server -ns eaagt.server -set OPC_BACKUP_DIR <directory>
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In this instance, <directory> is the location on your system where you can back up the old deployment
packages.

The log file (oainstall.log) created during the installation of deployment packages, is placed inside the
backup directory.

Registering on the HPOM on UNIX/Linux Management
Server
Register the Deployment Package on the HPOM Management Server

Prerequisites

l Disk space: 1 GB

l The oainstall program installs the Infrastructure SPIs on themanagement server while registering
the deployment package. If you want to install the Infrastructure SPIs, make sure the system
meets the following additional requirements:

Hardware and Software Requirements

For a list of supported hardware, operating systems, HPOM version, and agent version, see the
Support Matrix.

Disk Space Requirements

Operating System on the HPOM Management
Server

Temporary
Directorya

Total Disk
Space

Linux /tmp - 35MB 90MB

HP-UX /tmp - 17MB 240MB

Solaris /tmp - 35MB 80MB

aThe disk space for the temporary directory/drive is required only during installation. These are
approximate values.

Upgrade Requirements

You can directly upgrade the Infrastructure SPIs version 2.00 or above to the version 12.00.

Youmust install the HP Operations Agent 12.00 on themanagement server to be able to register
the deployment packages.

Register the Deployment Package

In addition to registering the deployment package for the HP Operations Agent, the oainstall script
can install the Infrastructure SPIs on themanagement server.
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However, the capability to install the Infrastructure SPIs is available only with the physical DVD or the
electronic media that contains agent packages for all node platforms. Platform-specific media does not
include the Infrastructure SPIs.

Choose one of the following tasks based on your requirement:

l Register deployment packages for all platforms and install the Infrastructure SPIs

l Register the deployment package for a specific node platform by using a platform-specific .ISO file

l Register deployment packages for all platforms and install the Infrastructure SPIs without the graph
or report package

l Register deployment packages for all platforms, but do not install the Infrastructure SPIs

l Register the HP Operations Agent deployment packages for select platforms and install the
Infrastructure SPIs

l "Register the deployment packages and install the health view package."

Task Follow these steps

Register the HP Operations Agent
deployment packages for all platforms
and install the Infrastructure SPIs.

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as root.

3. Go to themedia root.

4. Run the following command:

./oainstall.sh -i -m

5. Verify the registration process.

Register the HP Operations Agent
deployment package for a specific node
platform by using a platform-specific
ISO file.

1. Make sure that you downloaded the .ISO file for the
node platform of your choice.

2. Log on to themanagement server as root.

3. Go to themedia root.

4. Run the following command:

./oainstall.sh -i -m

5. Verify the registration process.

Register the HP Operations Agent
deployment packages for all platforms,
and install the Infrastructure SPIs, but

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

Registering the Deployment Package
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Task Follow these steps

do not install the graph package. 2. Log on to themanagement server as root.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=Yes

InfraSPI_With_Graphs=NO

5. Save the file.

6. Go to themedia root.

7. From themedia root, run the following command:

./oainstall.sh -i -m -spiconfig <file_name>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path).

The command registers the agent deployment
packages for all platforms on themanagement
server and installs the Infrastructure SPIs, but skips
the installation of the graph package for
Infrastructure SPIs.

Register the HP Operations Agent
deployment packages for all platforms,
but do not install the Infrastructure SPIs.

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as root.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=NO

Registering the Deployment Package, continued
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Task Follow these steps

InfraSPI_With_Reports=NO

InfraSPI_With_Graphs=NO

5. Save the file.

6. Go to themedia root.

7. From themedia root, run the following command:

./oainstall.sh -i -m -spiconfig <file_name
with complete path>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path).

The command registers the agent deployment
packages for all platforms on themanagement
server, but skips the installation of the Infrastructure
SPIs.

Register the HP Operations Agent
deployment packages for select
platforms and install the Infrastructure
SPIs

1. Make sure that you downloaded the .ISO file for all
platforms or obtained the physical DVD.

2. Log on to themanagement server as root.

3. Create a new file with a text editor.

4. Add the following content:

[agent.parameter]

REGISTER_AGENT=YES

[hpinfraspi.parameter]

InfraSPI=YES

InfraSPI_With_Graphs=

Note: If you want to skip the installation of the
graph packages, set the InfraSPI_With_
Graphs property to NO else set it to YES.

5. Set the InfraSPI_With_Graphs property to YES or
NO depending on whether you want to skip the
installation of the graph packages.

Registering the Deployment Package, continued
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Task Follow these steps

6. Save the file.

7. Go to themedia root.

8. From themedia root, run the following command:

./oainstall.sh -i -m -p <platform> -
spiconfig <file_name>

In this instance, <file_name> is the name of the file
that you created in step 3 (with complete path);
<platform> is the node platform for which you want
to register the deployment package.

Use the following values for <platform>:

ForWindows:WIN

For HP-UX: HP-UX

For Linux: LIN

For Solaris: SOL

For AIX: AIX

The command registers the agent deployment
packages for specified platforms on the
management server and installs the Infrastructure
SPIs.

You can specify multiple platforms in a single
command line. For example, to install deployment
packages for AIX and Solaris:

./oainstall.sh -i -m -p AIX -p SOL

Registering the Deployment Package, continued
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Task Follow these steps

Register the HP Operations Agent
deployment packages and install the
health view package.

1. Make sure that you have downloaded the .ISO file or
obtained the physical DVD of the HP Operations
Agent12.00.

2. Log on to the server as an administrator.

3. Extract the contents of the .ISO file into a local
directory on the server or mount the .ISO file.

4. Go to themedia root and run the following command
to register the agent deployment packages and
install the health view package:

./oainstall.sh –i –m -hv|-healthview

Formore information on Health View seeHP Operations
Agent User Guide: Health View. To install HP Operations
Agent and enable health monitoring using profile file see
profile file.

Registering the Deployment Package, continued

Note: Since HP Reporter is not supported on UNIX/Linux, you cannot install report packages on
themanagement server and youmust set the InfraSPI_With_Reports property to NO.

After installation, see Install Report andGraph Packages on a Remote Server to install report or
graph packages on a remote server.

WhenHPOM is in a High-Availability (HA) Cluster

Follow the above steps on the active node in the HPOMHigh-Availability (HA) cluster:

After completing the steps, fail over to the passive node, go to the
/var/opt/OV/shared/server/installation directory on the passive node, and then run the
following command:

./oainstall_sync.sh

After you run the commandwith necessary options and arguments, the registration procedure begins.
Depending on number of selected packages, the registration process may take up to 20minutes to
complete.

Verification

1. On themanagement server, go to the following location:

/opt/OV/bin/OpC/agtinstall

2. Run the following command:
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./oainstall.sh -inv -listall

The command shows the list of available (active and backed-up) deployment packages on the
management server.

To check if the Infrastructure SPIs are installed, run the commandwith the -includespi option.

./oainstall.sh -inv -includespi -listall

3. Locate the platform for which you installed the deployment package. If the active version is
displayed as 12.00, the registration is successful.

Log File

The registration log file (oainstall.log) is available in the following directory:

/var/opt/OV/shared/server/log

Placement of Packages

When you register the HP Operations Agent packages on themanagement server, the oainstall
program places all necessary deployment packages into the following directory:

/var/opt/OV/share/databases/OpC/mgd_node/vendor

Backup of Deployment Packages

When you register the deployment packages on themanagement server, the oainstall script saves
a copy of the older deployment packages into the following local directory:

/var/opt/OV/shared/server/installation/backup/HPOpsAgt/<OS>/<OA_Version>/<ARCH>

To view the active deployment packages, run the following command:

./oainstall.sh -inv

Alternate Backup Location

When the default backup location does not have sufficient space to accommodate the backed up
deployment packages, you can configure the system to use an alternate backup location.

Run the following command on themanagement server to use a non-default location to back up the old
deployment package:

ovconfchg -ovrg server -ns eaagt.server -set OPC_BACKUP_DIR <directory>

In this instance, <directory> is the location on your system where you can back up the old deployment
packages.

The log file (oainstall.log) created during the installation of deployment packages, is placed inside the
backup directory.
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Remove the HP Operations Agent and Infrastructure SPIs
Deployment Package

1. OnWindows: Log on to themanagement server as administrator and go to the
%ovinstalldir%bin\OpC\agtinstall directory.

On UNIX/Linux: Log on to themanagement server as root and go to the
/opt/OV/bin/OpC/agtinstall directory.

2. Run the following command to note down the correct version number of the deployment package
that you want to remove.

On Windows

cscript oainstall.vbs -inv -listall

On UNIX/Linux

./oainstall.sh -inv -listall

3. Run the following command:

On Windows

cscript oainstall.vbs -r -m -v <version> -p <platform>

On UNIX/Linux

./oainstall.sh -r -m -v <version> -p <platform>

In this instance, <version> the version of the agent deployment package that you want to
remove.

The -p option specifies the platform-specific package of the HP Operations agent that you want to
remove from themanagement server. Use the following list to specify the platform information in
the form of arguments to this option:

n Linux: LIN

n Solaris: SOL

n HP-UX: HP-UX

n AIX: AIX

n Windows: WIN

n All platforms: ALL
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For example, to remove a Solaris HP Operations agent package, use the command

./oainstall.sh -r -m -v 12.00.XXX -p SOL

The options and arguments are case-sensitive.

To remove the Infrastructure SPIs along with deployment packages, run the following command:

On Windows

cscript oainstall.vbs -r -m -v <version> -p <platform> -spiconfig

On UNIX/Linux

./oainstall.sh -r -m -v <version> -p <platform> -spiconfig

When you remove the HP Operations agent 12.00 deployment packages, the installer program
reinstates the highest backed-up version of deployment packages (if available) on the
management server.
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Chapter 3: Prerequisites to Install the HP Operations
Agent on a Node

Prerequisites for Windows
User

To install the HP Operations Agent on aWindows node remotely, youmust use a user with the
administrative privileges; the user must have access to the default system share (the disk on which the
Programs Files folder is configured) with the following additional privileges:

l Membership of the Local Administrators group

l <only for remote deployment>Write access to the admin$ share

l Read and write access to the registry

l <only for remote deployment> Permission to log on as a service

l Permission to start and stop services

Necessary Software

Windows Installer 4.5 or higher: TheWindows Installer software is packaged with theMicrosoft
Windows operating system. The installer program of the HP Operations agent requires the version 4.5
of this software component to be present on the system. To check if theWindows Installer 4.5 or higher
is present, follow these steps:

1. Log on to theWindows system.

2. From theStartmenu, open theRun prompt.

3. At theRun prompt, type regedit and then press Enter. The Registry Editor window opens.

4. In the Registry Editor window, expandHKEY_LOCAL_MACHINE > SOFTWARE > Microsoft,
and then click DataAccess.

5. In the right pane, double-click FullInstallVer. TheEdit String dialog box opens.

6. In theEdit String dialog box, check if the version string is set to 4.5 or higher.

Windows Script Host: TheWindows Script Host must be enabled on the system. The installer
program of the HP Operations Agent requires theWindows Script Host to be enabled. To check if the
Windows Script Host is enabled, follow these steps:

1. Log on to theWindows system.

2. From theStartmenu, open theRun prompt.
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3. At the Run prompt, type regedit and then press Enter. The Registry Editor window opens.

4. In theRegistry Editorwindow, expandHKEY_LOCAL_MACHINE > SOFTWARE >
Microsoft, and then clickWindows Script Host.

5. In the right pane, look for the key Enabled:

6. If the key Enabled is present, double-click the key andmake sure the Value Data is set to 1. The
Windows Script Host is disabled if the Value Data for theEnabled key is set to 0.

7. If the key Enabled is not present, you can safely assume that theWindows Script Host is
enabled.

Necessary Services

Before installing the agent, make sure the following services are running:

l Event Log

l Remote Procedure Call

l Plug and Play

l Security Accounts Manager

l Net Logon

l <only for remote deployment> Remote Registry

l Server

l Workstation

To verify that the above services are running, follow these steps:

1. Log on to the system with the administrative privileges.

2. From theStartmenu, open theRun prompt.

3. At theRun prompt, type services.msc, and then press Enter. TheServiceswindow opens.

4. In the Services window, check if the status of each of the above services is Started. If the status
of one of the services is found to be anything other thanStarted, right-click the service, and then
click Start.

Disk Space

For new installation

For the installation directory: 350MB

For the data directory: 50MB

For upgrade from old agent software
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For the installation directory: 100MB

For the data directory: 50MB

Recommended Software and Services

For WMI Interceptor policies: TheWindows Management Instrumentation servicemust be available
on the system if you want to:

l deploy theWMI Interceptor policies or measurement threshold policies tomonitorWMI events and
classes

l perform automatic service discovery on the node.

For SNMP MIB monitoring: If you want to monitor objects in an SNMP Management Information
Base (MIB) on the agent system, make sure the SNMP agent (compliant with MIB-I andMIB-II) is
installed on the system.

For HPOM actions and tools: For launching HPOM actions and tools on the node, the NT LM
Security Support Provider servicemust be running.

Prerequisites for Linux
User

To install the HP Operations Agent on a Linux node, youmust be a user with root privileges.

Necessary Software

To install the HP Operations Agent, the following runtime libraries and packages are required:

l glibc-2.3.4-2.36.i686.rpm or higher

l On x64 systems:

n libgcc-3.4.6-8.i386.rpm or higher

To check for the packages, use the following command:

rpm -qa | grep -i <packagename>

In this instance, <packagename> is the name of the package to be checked.

n libstdc++33-32bit-3.3.3-7.8.1.x86_64.rpm and above

Note: Make sure that libstdc++33-32bit-3.3.3-7.8.1.x86_64.rpm is installed before you
install HP Operations agent 12.00 on SLES10 SP4 x64 system. This rpm is applicable only
for SUSE Linux Enterprise Server 10 and above.
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l C++ runtime:

n For systems with kernel version 2.6:
libstdc++.so.5

l Only required for Glance- Curses runtime library:
libncurses.so.5

Note: Make sure that the libncurses.so.5 library is present at the following path:

On Linux (64-bit systems)

/usr/lib64/libncurses.so.5 or /lib64/libncurses.so.5

On Linux (32-bit systems)

/usr/lib/libncurses.so.5 or /lib/libncurses.so.5

l Make sure that them4 utility is installed at the path /usr/bin/m4.

l Set the executable (x) bit for the libvirt library at one of the following paths as appropriate:

n /usr/lib64/libvirt.so

n /usr/lib64/libvirt.so.0

n /usr/lib/libvirt.so

n /usr/lib/libvirt.so.0

If these paths contain softlinks, make sure that the library pointed by the link has the executable
bit set.

If you want to remotely install the agent from the HPOM forWindows console, make sure OpenSSH
5.2 or higher is installed on the system.

Disk Space

For new installation

For the installation directories (/opt/OV and /opt/perf): 350MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

For upgrade

For the installation directories (/opt/OV and /opt/perf): 100MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

Note: If you do not have sufficient space in the installation or data directory, you can symbolically
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link the install or data directory to another location on the same system by using the ln -s
command.
For example, to symbolically link the /opt/OV directory to the /new directory, run the following
command:
ln -s /new /opt/OV

Recommended Software and Services

For SNMP MIB monitoring: If you want to monitor objects in an SNMP Management Information
Base (MIB) on the agent system, make sure the SNMP agent (compliant with MIB-I andMIB-II) is
installed on the system.

For xglance: To use the xglance utility, make sure the following components are available on the
system:
Openmotif toolkit 2.2.3 (On Linux platforms other than Red Hat Enterprise Linux 5.x and SUSE Linux
Enterprise Server 10.x on x86_64 and Itanium, the 32-bit version of the Openmotif toolkit and
associated libraries must be present.)

Prerequisites for HP-UX
User

To install the HP Operations Agent on an HP-UX node, youmust be user with root privileges.

Necessary Software

OnHP-UX, make sure that the following patches are installed:

l For HP-UX 11.23. PHKL_36853, PHCO_38149 (or superseding patches)

l For HP-UX 11i v1. PHNE_27063 (or superseding patch)

l For HP-UX 11i v1. PHCO_24400 s700_800 11.11 libc cumulative patch (or superseding patch)

l For HP-UX 11.11 PA-RISC. PHCO_38226 (or superseding patch)

l For HP-UX 11i v1. The following patches are required for the performance tools to function with
VERITAS VolumeManager 3.2:

n PHKL_26419 for HP-UX B.11.11 (11.11) (or superseding patch)

n PHCO_26420 for HP-UX B.11.11 (11.11) (or superseding patch)

OnHP-UX systems running on Itanium, the libunwind library must be available.

If multiple processor sets are configured on an HP-UX 11i v1 system and you are using the log
application=prm switch in the parm file to log APP_metrics by the PRMGroup, youmust install the
following patch:

PHKL_28052 (or superseding patch)
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OnHP-UX 11i v1 and higher, the performance tools work with Instant Capacity on Demand (iCOD).
The following kernel pstat patch should be installed to correctly report iCOD data (If iCOD is not
installed on your system, do not install the kernel patch.):

PHKL_22987 for HP-UX B.11.11 (11.11) (or superseding patch)

Make sure that them4 utility is installed at the path /usr/bin/m4.

HP GlancePlus, included in this version of the HP Operations Agent, works with Process Resource
Manager (PRM) version C.03.02.

HP-UX 11.11 and higher running EMC PowerPath v2.1.2 or v3.0.0must have the latest EMC patches
installed.

l For the EMC PowerPath v2.1.2 release, use the following patch:
EMCpower_patch213 HP.2.1.3_b002 (or superseding patch)

l For the EMC PowerPath v3.0.0 release, use the following patch:
EMCpower_patch301 HP.3.0.1_b002 (or superseding patch)

Disk Space

For new installation

For the installation directories (/opt/OV and /opt/perf): 800MB

For the data directories (/var/opt/OV and /var/opt/perf): 772.1MB

For upgrade

For the installation directories (/opt/OV and /opt/perf): 800MB

For the data directories (/var/opt/OV and /var/opt/perf): 772.1MB

Note: If you do not have sufficient space in the installation or data directory, you can symbolically
link the install or data directory to another location on the same system by using the ln -s
command.
For example, to symbolically link the /opt/OV directory to the /new directory, run the following
command:
ln -s /new /opt/OV

Recommended Software and Services

For SNMP MIB monitoring: If you want to monitor objects in an SNMP Management Information
Base (MIB) on the agent system, make sure the SNMP agent (compliant with MIB-I andMIB-II) is
installed on the system.

Prerequisites for Solaris
User

To install the HP Operations Agent on a Solaris node, youmust use a user with the root privileges.

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 41 of 197



Necessary Software

l For all supported Solaris versions.Make sure the following packages are available:

n SUNWlibC

n SUNWlibms

To check for packages, use the following command:

pkginfo <packagename>

In this instance, <packagename> is the name of the package.

l Make sure that them4 utility is installed at the path /usr/xpg4/bin/m4 or /usr/ccs/bin/m4.

Disk Space

For new installation

For the installation directories (/opt/OV and /opt/perf): 350MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

For upgrade

For the installation directories (/opt/OV and /opt/perf): 100MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

Note: If you do not have sufficient space in the installation or data directory, you can symbolically
link the install or data directory to another location on the same system by using the ln -s
command.
For example, to symbolically link the /opt/OV directory to the /new directory, run the following
command:
ln -s /new /opt/OV

Recommended Software and Services

For SNMP MIB monitoring: If you want to monitor objects in an SNMP Management Information
Base (MIB) on the agent system, make sure the SNMP agent (compliant with MIB-I andMIB-II) is
installed on the system.

For xglance: To use the xglance utility, make sure the following components are available on the
system:

l SUNWmfrun

l SUNWxwplt
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Prerequisites for AIX
User

To install the HP Operations Agent on an AIX node, youmust use a user with the root privileges.

To check for specific packages on the AIX node, use the following command:

lslpp –l | grep –i <packagename>

In this instance, <packagename> is the name of the package.

Necessary Software

l The libC.a library is required for the HP GlancePlus to function correctly. The library is bundled
within the xlC.rte package, which is available from your AIX Operating System optical media.

l The bos.perf.libperfstat package is required for the communication daemon.

l If you want to remotely install the agent from the HPOM forWindows console, make sure
OpenSSH 5.2 or higher is installed on the system.

l Make sure that them4 utility is installed at the path /usr/bin/m4.

Disk Space

For new installation

For the installation directory (/usr/lpp/OV and /usr/lpp/perf): 350MB

For the data directory (/var/opt/OV and /var/opt/perf): 350MB

For upgrade

For the installation directory (/usr/lpp/OV and /usr/lpp/perf): 350MB

For the data directory (/var/opt/OV and /var/opt/perf): 350MB

Note: If you do not have sufficient space in the installation or data directory, you can symbolically
link the install or data directory to another location on the same system by using the ln -s
command.
For example, to symbolically link the /usr/lpp/OV directory to the /new directory, run the
following command:
ln -s /new /usr/lpp/OV

Recommended Software and Services

For SNMP MIB monitoring: If you want to monitor objects in an SNMP Management Information
Base (MIB) on the agent system, make sure the SNMP agent (compliant with MIB-I andMIB-II) is
installed on the system.
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For xglance: To use the xglance utility, make sure the following components are available on the
system:

l OpenMotif 2.1 or higher

l X11Revision 6 (X11R6)

To collect and log cross-partitionmetrics, the xmservd or xmtopas daemonmust be available. xmtopas
is a part of perfagent.tools file set and xmservd is bundled with the Performance Toolbox for AIX
component (a licensed software program).

Prerequisites for Debian and Ubuntu
User

To install the HP Operations Agent on a Linux node, youmust log on with the root privileges.

Necessary Software

To install the HP Operations agent, the following runtime libraries and packages are required. You can
run the following command to list the RPM packages:

dpkg –l | grep -i <package_name>

l C++ runtime:

n For systems with kernel version 2.6:
/lib/libstdc++.so.5

n For systems with kernel version 2.6 on Itanium :
/lib/libstdc++.so.6

l Only required for Glance- Curses runtime library:
/lib/libncurses.so.5

l Make sure that them4 utility is installed at the path /usr/bin/m4.

l On x64 systems:

n libgcc-3.4.6-8.i386.rpm and above

n glibc-2.3.4-2.36.i686.rpm and above

n libstdc++-3.4.6-8.i386.rpm and above

n compat-libstdc++-33.i386.rpm and above

n libstdc++33-32bit-3.3.3-7.8.1.x86_64.rpm and above
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Note: Make sure that libstdc++33-32bit-3.3.3-7.8.1.x86_64.rpm is installed before you
install HP Operations agent 11.11 on SLES10 SP4 x64 system.

Disk Space

For new installation

For the installation directories (/opt/OV and /opt/perf): 350MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

For upgrade

For the installation directories (/opt/OV and /opt/perf): 100MB

For the data directories (/var/opt/OV and /var/opt/perf): 350MB

Note: If you do not have sufficient space in the installation or data directory, you can symbolically
link the install or data directory to another location on the same system by using the ln -s
command.
For example, to symbolically link the /opt/OV directory to the /new directory, run the following
command:
ln -s /new /opt/OV

To remotely install the HP Operations Agent from the HPOM forWindows console, make sure that the
OpenSSH 5.2 or higher is installed on the system.

Upgrade Notes
You can upgrade an older version of the HP Operations Agent, HP Performance Agent, or HP
GlancePlus to the HP Operations Agent 12.00. The following version can be directly upgraded to the
HP Operations Agent 12.00:

l HP Operations Agent 11.xx

l HP Performance Agent 11.xx

l HP GlancePlus 11.xx

The installation of the HP Operations Agent 12.00 fails if any agent software older than 11.xx is
installed. Before installing the HP Operations Agent 12.00 on nodes with the HP Operations Agent
older than 11.xx, the HP Performance Agent older than 11.xx or HP GlancePlus older than 11.xx, do
one of the following:

l Upgrade the agent software to the version 11.xx and then upgrade to the HP Operations Agent
12.00.
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This is the preferredmethod of upgrade. This method ensures necessary packages and policies are
retained on the node.

l Remove the agent software completely and then install the HP Operations Agent 12.00.

This may result in removal of policies and instrumentation files from the node. After upgrading to the
HP Operations Agent 12.00, make sure necessary policies and instrumentation files are deployed
on the node again.

Check the Version of the Existing Agent

On Windows

1. Log on to the node with the administrative privileges.

2. Open a command prompt.

3. Run the following command:

opcagt -version

If the command output shows that the version of the existing HP Operations Agent is lower than
11.xx, youmust do one of the following:

n Upgrade the HP Operations Agent to the version 11.xx and then upgrade to the HP Operations
Agent 12.00.

n Remove the installed version of the HP Operations Agent completely and then install the HP
Operations Agent 12.00.

4. Check the version of the HP Performance Agent:

a. Open a command prompt.

b. Run the following command:

perfstat -v

The command output shows the versions of different components of the HP Performance
Agent. If the version of the component ovpa.exe is lower than 11.xx, youmust upgrade to the
version 11.xx or completely remove the installed version of the HP Performance Agent and
then upgrade to the HP Operations Agent 12.00.

On UNIX/Linux

1. Log on to the node with the root privileges.

2. Open a command prompt.

3. Run the following command:
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opcagt -version

If the command output shows that the version of the existing HP Operations Agent is lower than
11.xx, youmust do one of the following:

n Upgrade the HP Operations Agent to the version 11.xx and then upgrade to the HP Operations
Agent 12.00.

n Remove the installed version of the HP Operations Agent completely and then install the HP
Operations Agent 12.00.

4. Check the version of the HP Performance Agent:

a. Open a command prompt.

b. Run the following command:

perfstat -v

The command output shows the versions of different components of the HP Performance
Agent. If the version of the component ovpa is lower than 11.xx, youmust upgrade to the
version 11.xx or completely remove the installed version of the HP Performance Agent and
then upgrade to the HP Operations Agent 12.00.

5. Check the version of HP GlancePlus:

a. Open a command prompt.

b. Run the following command:

perfstat -v

The command output shows the versions of different components of the HP Performance
Agent and HP GlancePlus. If the version of the component glance is lower than 11.xx, you
must upgrade to the version 11.xx or completely remove the installed version of HP
GlancePlus and then upgrade to the HP Operations Agent 12.00.

Data Collection and Storage with the HP Operations Agent 12.00

With the HP Operations Agent version 12.00, the CODA and scope processes (Scopeux on UNIX and
Linux nodes and Scopent onWindows nodes) are consolidated into a single process called oacore.
The oacore process provides both read and write interface for system performance and custom data.

The data collector –oacore–captures the following information:

l System-wide resource utilization information

l Process data

l Performance data for different devices
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l Transaction data

l Logical systems data

The Collection Parameters file or the parm file contains instructions for the data collector to collect
specific types of data and defines the data collection interval. This is an ASCII file that you can use to
customize the default data collectionmechanism. For more information, see theHP Operations Agent
User Guide.

The data collector gathers a large set of system performancemetrics, which presents a wide view of
the health and performance of the system. The collected information is stored in theMetric Data
Store.

Metric Data Store

With the HP Operations Agent version 12.00, Metric Data Store replaces the log file based data store.
Multiple data stores such as CODA, SCOPE, and DSI log files have been consolidated into a single
Relational DatabaseManagement System (RDBMS) based data store. The RDBMS used is SQLite.
Data stored in theMetric Data Store is available on the system for analysis and use with tools like HP
PerformanceManager and HP Reporter.

Old data stored in the CODA database files, SCOPE log files and the DSI log files are retained in read-
only mode. You can access the old data through utilities such as ovcodautil, extract, or through
reporting tools such as HP PerformanceManager and HP Reporter.

Despite the change in data collection and data storingmechanism, threshold comparison process
through policies remains the same.

Upgrading on a Solaris SPARC Management Server with Solaris SPARC Managed Nodes

If you are using a Solaris SPARC HPOMmanagement server with HP Operations Agent 8.60; follow
the steps to ensure the SPARC nodes communicate with SPARC management server:

1. Log on to themanagement server with the root privileges.

2. Run the following command to check the version of the HP Software Security Core (OvSecCo)
component:

strings /opt/OV/lib/libOvSecCore.so | grep FileV

n If the version of the HP Software Security Core (OvSecCo) component is 06.20.077 (or higher),
then upgrade the HP Operations Agent to the version 12.00 on the Solaris SPARC HPOM
management server.

n If the version of the HP Software Security Core (OvSecCo) component is 06.20.050 then
follow the steps:

i. On the Solaris SPARC node, upgrade to the HP Operations Agent version 12.00.

ii. Apply the hotfix QCCR1A97520 on themanagement server (contact HP Support to
obtain this hotfix).
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Note: Run the following command on themanagement server to verify if the version
of the HPOvSecCo component is upgraded to 06.20.077

strings /opt/OV/lib/libOvSecCore.so | grep FileV

iii. On the Solaris SPARC HPOMmanagement server, upgrade the HP Operations Agent to
version 12.00.

This hotfix ensures that the SPARC nodes with the HP Operations Agent 12.00 can
communicate with the SPARC management server that includes the HPOvSecCo component,
version 06.20.050. If you do not install this hotfix on the SPARC management server, the
SPARC nodes with the HP Operations agent 12.00 cannot communicate with the SPARC
management server.

Preinstallation Task: To Install the HP Operations Agent
and Infrastructure SPIs on HPOM in Cluster
If installed in a high-availability (HA) cluster environment, the HP Operations Agent does not fail over
when the active system in the cluster fails over to another system. However, the HP Operations Agent
can help youmonitor cluster-aware applications running in a cluster.

Youmust install the HP Operations Agent on every node that belongs to the cluster. Installing the agent
in a cluster does not involve any additional steps or any special configuration. However, to install the
agent on an HPOMmanagement server that runs in a cluster requires additional configuration steps.

For HPOM for Windows

1. Make sure the HPOM database is up and running.

2. Log on to the activemanagement server with the administrative privileges.

3. Set the active node to themaintenance outagemode by running the following command:

ovownodeutil -outage_node -unplanned -node_name <FQDN_of_node> -on

4. Install the agent on the active server by following instructions in "Installing from the HPOM
Console" or "Installing the HP Operations Agent and Infrastructure SPIs Manually on the Node".

5. Perform step 3 and 4 on each node in the cluster.

In this instance:

<FQDN_of_node> is the fully-qualified domain name of the active node.

For HPOM on UNIX/Linux
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1. Log on to the activemanagement server with the root privileges.

2. Disable monitoring of the HA resource group on the active node by setting themaintenancemode
for the node:

Run the following command on the active node:

/opt/OV/lbin/ovharg -monitor <HA_resource_group_name> disable

In this instance:

<HA_resource_group_name> is the HA resource group for HPOM on themanagement server.

3. Install the agent on the active server by following instructions in "Installing from the HPOM
Console" or "Installing the HP Operations Agent and Infrastructure SPIs Manually on the Node".

Make sure the shared disk is mounted at the time of installation.

4. Perform step 3 on each node in the cluster.

5. Once installation is completed, server resource groupmonitoring should be enabled again.
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Chapter 4: Installing from HPOM or HP OMi Console

Note: If the node hosts another HP Software product, make sure to stop all the processes of the
product prior to the agent installation. You can start the processes after the agent installation is
complete.

From HPOM for Windows

To install the HP Operations Agent onmanaged nodes from the HPOM console, follow theRemote
agent installation topic in theHPOM forWindows Online Help.

For information on installing agent from themanagement server to a remote node, see "Configure the
Agent Remotely from anHPOM forWindows Management Server" on page 125.

From HPOM on UNIX/Linux

To install the HP Operations Agent onmanaged nodes from the HPOM onUNIX/Linux console, follow
theHPOM for UNIX: New Agent Installation  topic in theHPOM onUNIX/Linux Online Help.

Note:When you are installing HP Operations Agent for the first time, remotely from the HPOM
UNIX/Linux console on the Linux (Debian) Operating system, do not select the force option. This
installs the HP Operations Agent twice.

Note: You can install the HP Operations Agent 12.00 only on HP-UX IA64 systems with the patch
level qpkbase package September 2013 or superseding patches. Remote installation of HP
Operations agent 12.00 from the HPOMmanagement server to a HP-UX IPF32 node will fail as
the desired agent binary format for HP Operations Agent 12.00 is HP-UX IPF64.

From HP OMi

HP Operations Manager i (OMi) is the event management foundation for a complete Business Service
Management (BSM)monitoring solution. You can integrate HP Operations Agent with OMi. After the
installation of the HP Operations Agent on a node, youmust connect the HP Operations Agent to OMi
and then grant the agent's certificate request in OMi.

For more information about integrating HP Operations Agent with OMi, see the topic Connecting HP
Operations Agents to OMi in the chapterMonitored Nodes in theOMi Administration Guide.
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Chapter 5: Installing HP Operations Agent in a Single
Step
The HP Operations Agent 12.00 single step installer enables you to install the base version of HP
Operations Agent along with patches and hotfixes. The installer first installs the base version of the HP
Operations Agent on the system, and then installs any updates if available with the patches, followed
by any available hotfix.

You can use the oainstall script to install HP Operations Agent locally on a managed node, or you
can use the ovdeploy command to remotely install the HP Operations Agent on amanaged node from
themanagement server.

If you use the single step installer to install the HP Operations Agent, the time taken for installation is
reduced on all platforms. The following table lists all the changes in the installation process for HP
Operations Agent 12.00:

Previous versions of HP Operations agent HP Operations agent 12.00

The pre-requisite check occurs thrice during the
installation process of HP Operations agent. Each
before installation of the base version of agent, patch,
and hotfix.

INFO: Validating pre-requisites for installation on
<system_name>

............

STATUS: All checked prerequisites are OK.

INFO: <system_name> meets all pre-requisites

The pre-requisites check occurs only once
before the installation of the HP
Operations Agent 12.00 along with the
patch and hotfix in a single step.

INFO: HP Operations-agent install
options are: -install

INFO: Validating pre-requisites for
installation on <system_name>

Requirements:

INFO: HP Operations agent installation started

=============================

INFO: Validating pre-requisites for installation on
<system_name>

............

STATUS: All checked prerequisites are OK.

INFO: <system_name> meets all pre-requisites

INFO: HP Operations agent Patch: OAHPUX_
00031 installation started

==============================

[ PASS ] Is user root

............

[ PASS ] Check if m4 is installed

STATUS: All checked prerequisites
are OK.

INFO: <system_name> meets all pre-
requisites

=======================

INFO: HP Operations agent
installation started

Comparing previous versions of HP Operations Agent with version 12.00
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INFO: Validating pre-requisites for installation on
<system_name>

............

STATUS: All checked prerequisites are OK.

INFO: <system_name> meets all pre-requisites

INFO: HP Operations agent Hotfix: HFHPUX_
13018 installation started

===============================

=======================

Configuration of the HP Operations Agent occurs
multiple times during the installation process.

Configuration of the HP Operations Agent
occurs only once during the installation
process of HP Operations Agent 12.00,
patch, and hotfix in a single step.

The activation of the HP Operations Agent occurs
thrice during the installation process. Each after the
installation of the base version of agent, patch, and
hotfix.

The activation of the HP Operations Agent
occurs only once at the end of the
installation of HP Operations Agent 12.00,
patch, and hotfix.

The installer pauses the installation process of the HP
Operations Agent if the certificate is not auto granted.

The installer does not pause the
installation of the HP Operations Agent
12.00 in case the certificate is not auto
granted.

Comparing previous versions of HP Operations Agent with version 12.00, continued

Install the HP Operations Agent using Single Step installer
Follow the steps:

1. Log on to the node as root or administrator.

2. Download and extract themedia, patches, and hotfix packages to the same directory.

3. Go to the directory where you extracted the bits.

4. Run the following command:

On Windows

cscript oainstall.vbs –i -a

On UNIX

./oainstall.sh –i –a
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Deploying Patches and Hotfixes using Single Step Installer
From HPOM for Windows Management Server

If the HP Operations Agent 12.00 is already installed on a node, follow the steps to install patches and
hotfixes:

Note: Before installing patches and hotfixes, youmust apply the hotfix QCCR1A174773. Contact
HP Support to obtain the hotfix.

1. In the console tree, right-click the node (where you want to install the patches and hotfixes), and
then click All Tasks > Reinstall/Update. TheReinstall/Update Node dialog box appears.

2. Select Update, select Packages in theScope section, uncheck theDeploy only if version is
newer check box, and then click OK.

3. After the installation is complete, go to the console tree on the HPOM console, right-click the
node, and then click All Tasks > Synchronize inventory> Packages.

All available patches and hotfixes are installed on the node.

Note: On a node with HP Operations Agent 12.00, if you upgrade a patch or hotfix, only those
patches and hotfixes that are not available on the node are transferred and installed. Thus the
installation time is reduced.

For more information, see Installing from the HPOMConsole.

From HPOM for Linux Management Server

Follow the steps to install patches and hotfixes:

1. On the console, select the option (De) Install Agent from theDeployment drop-down.

2. From the Install Type drop-down, select Installation.

3. Select a node and then click thePreinstall Check button. The Install Agent window appears.

4. In the Install Agentwindow, ensure that the node is selected. Depending on the original state of
the node, perform one of the following:

n If the node does not have any version of the HP Operations Agent installed, select the Force
check box in the Install Agentwindow and then click the Install On Selected Nodes button.
HPOM installs the HP Operations Agent versions 12.00, patch and hotfix.

n If the HP Operations Agent12.00 is already installed on the node, select the Force check box in
the Install Agentwindow and then click the Install On Selected Nodes button. All available
patches and hotfixes are installed on the node.
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Note: If the node has older version of HP Operations Agent that cannot be upgraded to the
version 12.00 then the installation fails.

If the node has a version of HP Operations Agent that can be upgraded to the version 12.00,
the existing HP Operations Agent is upgraded to the version 12.00, and then the patches and
hotfixes are installed (this two-step upgrade takes place automatically and no additional steps
are involved).

For more information, see Installing from the HPOMConsole.

Verify the Installation
Run the following command:

ovdeploy –inv –includeupdates. 

The command lists the version of the base, patch, and hotfix components.
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Chapter 6: Installing HP Operations Agent using
Profile File
You can use a profile file during the installation (manual installation) to program the agent to run with
non-default configuration settings (such as the communication port, event interceptor port, or the
license type).

Note:With HP Operations agent version 12.00, all install time configurable values must be added
in the profile file under the new namespace nonXPL.config. The configurable values added under
the namespace nonXPL.configwill not be uploaded on the xpl.config settings.

You canmodify the default profile file available on the HP Operations Manager or manually create a
profile file on the HP Operations Agent node.

Modifying the Default Profile file on the HPOM for Windows Console

Follow the steps:

1. Log on to themanagement server as administrator.

2. Go to the directory %ovdatadir%share\conf\PMAD.

3. Rename the agent_install_defaults.cfg. sample file to agent_install_defaults.cfg.

Tip: Take a backup of the agent_install_defaults.cfg.sample file.

4. Open the agent_install_defaults.cfg file with a text editor and use the following syntax to
configure non-default values for agent variables:

[<namespace>]

<variable>=<value>

In this instance:

<namespace> is the configuration variable namespace

<variable> is the variable that you want to configure

<value> is the value you want to assign to the variable

5. Save the file and then follow the steps to install the HP Operations Agent using a Profile File.

Modifying the Default Profile file on the HPOM for UNIX Console

Follow the steps:
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1. Log on to themanagement server with the root privileges.

2. Go to the directory /etc/opt/OV/share/conf/OpC/mgmt_sv.

3. Rename the file bbc_inst_defaults.sample to bbc_inst_defaults.

4. Open the file bbc_inst_defaultswith a text editor and use the following syntax to configure non-
default values for agent variables:

[<namespace>]

<variable>=<value>

In this instance:

<namespace> is the configuration variable namespace

<variable> is the variable that you want to configure

<value> is the value you want to assign to the variable

5. Save the file and then follow the steps to install the HP Operations Agent using a Profile File.

Creating the Profile File Manually on the Node:

Follow the steps :

1. On the system where you want to install the agent, create a new file and open the file with a text
editor.

2. Type the following syntax to configure agent variables to use a non-default value:

set<namespace>:<variable>=<value>

In this instance:

<namespace> is the configuration variable namespace

<variable> is the variable that you want to configure

<value> is the value you want to assign to the variable

3. Save the file into a local directory.
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

MODE:At the time of
installation, you can
configure the user
that the agent runs
under. The MODE
variable enables to
choose a non-default
user that can be used
by the agent while
running on the
system.

To configure the agent to run
under a non-root/non-privileged
user, add the following content:

[eaagt]

MODE=NPU

To configure the agent to run
only the Operations Monitoring
Component under a non-
root/non-privileged user, add the
following content (the rest of the
agent runs with root/Local
System):

[eaagt]

MODE=MIXED

To configure the agent to run under a non-
root/non-privileged user, add the following
content:

set eaagt:MODE=NPU

To configure the agent to run only the
Operations Monitoring Component under
a non-root/non-privileged user, add the
following content (the rest of the agent
runs with root/Local System):

set eaagt:MODE=MIXED

In addition, youmust configure a set of
variables in the similar fashion to enable
the agent to run under a non-default user.
See theConfigure the Agent User During
Installation section in theHP Operations
Agent User Guide for detailed
information.

CREATE_
DEFAULT_USER:
At the time of
installation, the opc_
op user is created as
a default behavior.
You can disable the
option by using
CREATE_
DEFAULT_USER
variable.

Add the following content in the
profile file to disable the creation
of opc_op user:

[nonXPL.config]

CREATE_DEFAULT_
USER=FALSE

Add the following content in the profile file
to disable the creation of opc_op user:

set nonXPL.config:CREATE_
DEFAULT_USER=FALSE

DISBALE_
REALTIME:At the
time of installation,
use the DISBALE_
REALTIME variable
to disable the real-
timemonitoring
component .

Add the following content in the
profile file to disable the real-
timemonitoring component:

[nonXPL.config]

DISABLE_REALTIME=TRUE

Add the following content in the profile file
to disable the real-timemonitoring
component:

set install.config:DISABLE_
REALTIME=TRUE

Key features that you can configure during installation
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

ENABLE_DNSCHK
and ENABLE_
PORTCHK:Only for
UNIX machines: At
the time of
installation, you can
enable or disable the
pre-requisite check
for DNS validation
and availability of port
383 of the
management and
certificate server by
using ENABLE_
DNSCHK variable
and ENABLE_
PORTCHK variable
respectively.

Add the following content in the
profile file to enable the pre-
requisite check for DNS
validation:

[nonXPL.config]

ENABLE_DNSCHK=TRUE

Add the following content in the
profile file to enable the pre-
requisite check for port
validation:

[nonXPL.config]

ENABLE_PORTCHK=TRUE

These prerequisite checks are
only enabled if the values are
set as TRUE in the profile file.

Add the following content in the profile file
to enable the pre-requisite check for DNS
validation:

set nonXPL.config:ENABLE_
DNSCHK=TRUE

Add the following content in the profile file
to enable the pre-requisite check for port
validation:

set nonXPL.config:ENABLE_
PORTCHK=TRUE

These prerequisite checks are only
enabled if the values are set as TRUE in
the profile file.

INSTALL_
REMOVESIGN You
can disable the
signature checks to
reduce the
installation time in
Windows. You can
disable the option by
using INSTALL_
REMOVESIGN
variable.

Add the following content in the
profile file to disable the
signature checks at the
installation time:

[nonXPL.config]

INSTALL_
REMOVESIGN=True

Add the following content in the profile file
to disable the signature checks at the
installation time:

set nonXPL.config:INSTALL_
REMOVESIGN=True

Key features that you can configure during installation, continued
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

Licensing: If you
install the agent
manually on a node
(that is, without using
the HPOM console),
no evaluation
licenses are enabled
automatically after
installation. You can
configure license-
specific variable in
the profile file to apply
a license-to-use
(LTU) of your choice
at the time of
installation.

For detailed
information on
applying licenses at
the time of
installation with a
profile file, see the
HP Operations Agent
LicenseGuide.

For example, if you want to
apply the HP Operations OS
Inst Adv SW LTU permanently,
add the following content:

[eaagt.license]

HP_Operations_OS_Inst_
Adv_SW_LTU=PERMANENT

For example, if you want to apply the HP
Operations OS Inst Adv SW LTU
permanently, add the following content:

set eaagt.license:HP_Operations_OS_
Inst_Adv_SW_LTU=PERMANENT

Perfd and ttd
variablesAt the time
of installation, you
can set the options
for perfd and ttd
component.

Add the following content in the
profile file for perfd component:

[nonXPL.config.perfd]

interval=value

Set the interval to any value.

[nonXPL.config.perfd]

ipv4=TRUE

Set the IPv4 connection.

[nonXPL.config.perfd]

add="gbl,fs,dsk" -

Add the data formats and file
extensions.

Add the following content in the
profile file for ttd component:

Add the following content in the profile file
for perfd component:

set
nonXPL.config.perfd:interval=value-
set the interval to any value.

set nonXPL.config.perfd:ipv4=TRUE -
set the IPv4 connection.

set
nonXPL.config.perfd:add="gbl,fs,dsk"
- add the data formats and file
extensions.

Add the following content in the profile file
for ttd component:

set nonXPL.config.ttd:SEM_KEY_
PATH=/var/opt/perf/datafiles

set nonXPL.config.ttd:tran=*

Key features that you can configure during installation, continued
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

[nonXPL.config.ttd]

SEM_KEY_
PATH=/var/opt/perf/datafiles

tran=*
range=1,2,3,5,10,30,120,300
slo=15.0

app=[HP Perf Tools]
tran=Scope_Get_Global_
Metrics
range=0.5,1.0,1.5,2,3,5,8,10,15
slo=5

app=[<user_defined name>
Perf Tools] tran=Navin_Get_
Process_Metrics
range=0.5,1.0,1.5,2,3,5,8,10,15
slo=10

app=[HP Perf Tools1]
tran=Scope_Get_Process_
Metrics
range=0.5,1.0,1.5,2,3,5,8,10,15
slo=25

app=[HP Perf Tools]
tran=Navin_Get_Process_
Metrics
range=0.5,1.0,1.5,2,3,5,8,10,15
slo=10

range=1,2,3,5,10,30,120,300 slo=15.0

set nonXPL.config.ttd:app=[HP Perf
Tools] tran=Scope_Get_Global_
Metrics range=0.5,1.0,1.5,2,3,5,8,10,15
slo=5

set nonXPL.config.ttd:app=[<user_
defined name> Perf Tools]
tran=Navin_Get_Process_Metrics
range=0.5,1.0,1.5,2,3,5,8,10,15 slo=10

set nonXPL.config.ttd:app=[HP Perf
Tools1] tran=Scope_Get_Process_
Metrics range=0.5,1.0,1.5,2,3,5,8,10,15
slo=25

set nonXPL.config.ttd:app=[HP Perf
Tools] tran=Navin_Get_Process_
Metrics range=0.5,1.0,1.5,2,3,5,8,10,15
slo=10

IGNORE_LOCALE:
At the time of
installation, all
localization packages
(Japanese, Korean,
Spanish, and
Chinese) are installed
along with English.
You can set the user
interface to English
using IGNORE_
LOCALE variable.

Add the following content in the
profile file to set the user
interface to English:

[xpl.locale]

IGNORE_LOCALE=True

Once the configuration variable
is set to True, the user interface
appears in English but the node
communicates with the OM
server with the set system
locale language.

Add the following content in the profile file
to set the user interface to English:

set xpl.locale:IGNORE_LOCALE=True

Once the configuration variable is set to
True, the user interface appears in
English but the node communicates with
the OM server with the set system locale
language.

Key features that you can configure during installation, continued
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

ENABLE_
PERFALARM:On
fresh installation of
HP Operations agent
12.00, the alarm
generator server
(perfalarm) is
disabled by default.
To enable
perfalarm, set the
variable ENABLE_
PERFALARM to
True in the profile file.

You can also enable
perfalarm after
installing HP
Operations Agent.
For more information
see the section
Enabling perfalarm in
the chapter
Performance Alarms
in theHP Operations
Agent User Guide.

Add the following content in the
profile file to enable perfalarm:

[nonXPL.config]

ENABLE_
PERFALARM=TRUE

Add the following content in the profile file
to enable perfalarm:

set nonXPL.config:ENABLE_
PERFALARM=TRUE

MINPRECHECK: To
install the HP
Operations agent
12.00 remotely from
the HPOM for
Windows or UNIX
console on platforms
supported with
limitation, youmust
set the variable
MINPRECHECK to
True in the profile file.

Add the following content in the
profile file:

[nonXPL.config]

MINPRECHECK=true

Add the following content in the profile
file:

set
nonXPL.config:MINPRECHECK=true

Key features that you can configure during installation, continued
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Feature
Modifying Profile File on
HPOM Creating Profile File Manually

ENABLE_
HPSENSOR:On a
system with only
Glance license,
hpsensor is not
started automatically.
You can use the
ENABLE_
HPSENSOR option
to start hpsensor on
a system where only
Glance license is
installed.

This variable is not
applicable on
Windows systems as
there is noGlance on
Windows systems.

Add the following content in the
profile file:

[nonXPL.config] ENABLE_
HPSENSOR=True

Add the following content in the profile
file:

set nonXPL.config:ENABLE_
HPSENSOR=True

Key features that you can configure during installation, continued

Installing HP Operations Agent using a Profile File
After creating the profile file, run the following command to install the HP Operations Agent with a
profile file:

On Windows

cscript oainstall.vbs -i -a -agent_profile <path>\<profile_file> -s <management_
server> [-cs <certificate_server>] [-install_dir <install_directory> -data_dir
<data_directory>]

On UNIX/Linux

./oainstall.sh -i -a -agent_profile <path>/<profile_file> -s <management_server> [-
cs <certificate_server>]

In this instance:

<path> is the path to the profile file.

<profile_file> is the name of the profile file.

<management_server>: FQDN of themanagement server

<certificate_server>: FQDN of the certificate server

<install_directory>: Path to place all packages and binary files on the node.

<data_directory>: Path to place all data and configuration files on the node.
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Installing HP Operations Agent and Enabling Health
Monitoring using Profile File
HP Operations Agent Health View is a health monitoring tool that provides a quick overview of the
health of the HP Operations Agent. Follow the steps to update default configuration settings for the HP
Operations Agent health monitoring on the node using the profile file during installation:

1. Log on to the node as an administrator where you want to install the HP Operations Agent 12.00

2. Open the profile file with a text editor.

3. You can edit the following variables:

set agent.health:OPC_SELFMON_ENABLE=<TRUE/FALSE>

set agent.health:OPC_SELFMON_SERVER=<health view server IP address>

set agent.health:OPC_SELFMON_INTERVAL=<time_interval>

set agent.health:OPC_SELFMON_HBP=<TRUE/FALSE>

In this instance,

<health view server IP address> is the IP address or the host name of the Health View
Server. By default, the HPOMManagement Server is configured as the Health View Server.

<time_interval> defines the frequency at which the system health information is collected. The
default value is 300 seconds and theminimum value recommended is 60 seconds.

4. Install HP Operations Agent12.00 and include the agent profile file. Run the following command to
install HP Operations Agent12.00 with a profile file:

On Windows

cscript oainstall.vbs -i -a -agent_profile <path>\<profile_file> -s <health
view server IP address>

On UNIX/Linux

./oainstall.sh -i -a -agent_profile <path>/<profile_file> -s <health view
server IP address>

In this instance,

<health view server IP address> is the IP address or the host name of the Health View
Server. By default, the HPOMManagement Server is configured as the Health View Server.
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Chapter 7: Reducing the Installation Time
In previous versions of HP Operations Agent, the installer program takes significant time to validate the
signatures when installing on nodes without internet due to Certificate Revocation List (CRL) checks.
As a result, installing HP Operations agent media onWindows node takes significant time.

With HP Operations Agent 12.00, you can reduce the installation time onWindows node by removing
the signatures from the packages andMSI scripts. Use one of the followingmethods to remove the
signatures:

l Using the removesign option with the zip media

l Using the Profile File

Using the removesign option with the zip media
To create a zip of the product media without the digital signatures frommsi packages and vbscripts,
follow the steps:

1. Log on to the node as an administrator.

2. Go to themedia root.

3. Run the following command:

On Windows

cscript oainstall.vbs -createzip -p WIN -removesign

On Linux

./oainstall.sh -createzip -p LIN -removesign

Note: createzip option is available on Linux andWindows platforms only.

After the command is executed, a zip file containing the updatedmedia (without signatures) is available
at the location -%TEMP%/OA_ZIP_MEDIA folder.

Copy the zip media to another folder. To use the zip media, unzip themedia at the location where the
agent must be installed and then start installing the HP Operations Agent.

Installation time is significantly reduced to less than 4minutes when using the removesign option.
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Using the Profile file
You can use the profile file option to remove the digital signatures from vbscripts while installing HP
Operations Agent.

Follow the steps:

1. On the system where you want to install the agent, create a new file and open the file with a text
editor.

2. Add the following content in the profile file to disable the signature checks at the installation
time:set eaagt:INSTALL_REMOVESIGN=True

3. Save the file into a local directory.

4. Run the following command to install the HP Operations Agent with a profile file:

On Windows

cscript oainstall.vbs -i -a -agent_profile <path>\<profile_file> -s
<management_server> [-cs <certificate_server>] [-install_dir <install_
directory> -data_dir <data_directory>]

On UNIX/Linux

./oainstall.sh -i -a -agent_profile <path>/<profile_file> -s <management_
server> [-cs <certificate_server>]

In this instance:

<path> is the path to the profile file.

<profile_file> is the name of the profile file.

<management_server>: FQDN of themanagement server

<certificate_server>: FQDN of the certificate server

<install_directory>: Path to place all packages and binary files on the node.

<data_directory>: Path to place all data and configuration files on the node.

For more information, see Installing HP Operations Agent using Profile File.

Installation time is significantly reduced to less than 8minutes when using the profile file option to
install the HP Operations Agent.
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Chapter 8: Installing HP Operations Agent using Agent
Installation Repository
In a typical environment, there aremultiple versions of HP Operations Agent deployed in a combination
of different operating systems. You can install Agent Installation Repository on Linux operating
system and deploy different versions of HP Operations Agent available in the repository onWindows
and Linux operating systems.

Agent Installation Repository can be hosted in your environment by using any one of the following:

l Standalone Agent Installation Repository

l Agent Installation Repository as a Virtual Appliance

Standalone Agent Installation Repository
Agent installation repository can be installed on a Linux machine using the standalone tar file provided
to set up standalone repository on any Linux host. The same repository can act as aYum repository
for HP Operations Agent and LCore packages. For more information about Yum repository, see Data
Flow in Yum Repository.

Note:Standalone Agent Installation Repository is supported only on Linux x64 and x86
architecture.

Prerequisites

1. createrepo utility should be available and running on the system.

Note: createrepo ia a OS utility. If not installed, install it using the following command:

yum install createrepo

2. Make sure that a web server is running on the system.

Example: For RHELmachine, you can deploy on Apache web server.

n To start the web service, run the following command:

service httpd start
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Installing the Standalone Agent Installation Repository on a Linux server or on the HP
Operations Manager for Linux 9.X

Follow the steps:

1. Log on to the server where you want to install the repository.

2. Obtain the Standalone Agent Installation Repository (HPOvOpsAgt-12.00.xxx-AIR.tar) media
and extract the contents of theHPOvOpsAgt-12.00.xxx-AIR.tar file.

TheHPOvOpsAgt-12.00.xxx-AIR.tar file contains RPMs and a wrapper script (oainstall_air.sh)
to install the RPMs.

3. You can install Standalone Agent Installation Repository on a Linux server or on the HP
Operations Manager for Linux 9.x.

a. Run the following command to install the Standalone Agent Installation Repository on a Linux
server:

./oainstall_air.sh -i -wu <webURL> -wr <web root path>

For Example: ./oainstall_air.sh -i -wu https://hostname:portnumber -wr
/var/www/html

In this instance,

<wu> specifies the webURL of the web server

<https://hostname:portnumber> specifies the URL of the web server where
portnumber is the port on which this instance of the
web server is running.

<wr> specifies the web root path on the system. For
Example: /var/www/html in RHEL for Apache web
server.

b. Run the following command to install the Standalone Agent Installation Repository on the HP
Operations Manager for Linux 9.x:

oainstall_air.sh -i

This command installs the Standalone Agent Installation Repository on the OVtomcat web
server. The console displays the home page URL for the Agent Installation Repository after
installation.
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Note: On the HP Operations Manager for Linux, oainstall_air.sh runs without
parameters (webURL and web root path). Themedia on the HP Operations Manager for
Linux is available in the following location for Agent Installation Repository:

/opt/OV/nonOV/tomcat/b/www/webapps/AIRVA/media

Verification

Follow the steps:

1. Restart the web server using the following command:

service httpd restart

2. Go to the browser and type https://hostname:portnumber/oarepo/ to open the Agent
Installation Repository home page.
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3. Check the log file: /var/tmp/oainstall_air.log

4. Run the following command to check the list of RPMs installed or removed: rpm –qa | grep –i
hpoa*

In this instance,

* displays the list of RPMs starting with hpoa.

Removing the Standalone Agent Installation Repository

To remove the standalone repository, follow the steps:

1. Log on to the node.

2. Run the following command:

./oainstall_air.sh –r

Agent Installation Repository as a Virtual Appliance
Agent Installation repository is available as a Virtual Appliance and can be deployed in VMware
environment.

Prerequisite

Agent Installation Repository Virtual Appliance for VMware vSphere 4.x and 5.x.
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Deploying Agent Installation Repository Virtual Appliance

To deploy the virtual appliance with the HP Operations Agent from the vSphere console:

1. Login to vCenter using vSphere client.

2. Click File > Deploy OVF Template. TheDeploy OVF Templatewindow opens.

3. Provide the source location to download and install theOVF Package and then click Next.

4. Verify theOVF Template details and click Next.

5. Accept the end user license agreement and click Next.

6. Specify a name and location for the deployed template and click Next.

7. Select a destination storage for the virtual machine files click Next.

8. Provide the network properties details such as Default Gateway, DNS, Interface IP Address,
and theNetmask and then click Next.

9. Click Finish to start the deployment.

Verification

1. Get the repository home page URL using the IP or FQDN of the VA instance deployed:

https://<system_name or ip>:5480/oarepo/

Note: Default login credentials are:

User name: root

Password: password

2. Go to the browser and use the repository home page URL to open the Agent Installation
Repository.

Deploying HP Operations Agent Using the Agent
Installation Repository
HP Operations Agent can be installed using the Agent Installation Repository using any of the following
options:

l Using the oarepo scripts

l Using the Yum repository
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l Using the Puppet modules

Installing the HP Operations Agent using the oarepo scripts

To install the HP Operations Agent using the oarepo scripts, follow the steps:

1. Log on to the node where you want to install HP Operations Agent.

2. Download the oarepo.sh or oarepo.ps1 script for Linux orWindows respectively on the systems
where you need the HP Operations Agent to be installed using the Agent Installation Repository
landing page.

Note: Ensure you enable Powershell onWindows. The Powershell version 2.0 and above are
supported.

3. Install HP Operations agent on the server. Run the following command:

oarepo -i|-install -s|-server <server url> [-v|-version <version no.>] [-om|-
om_server <OM server name>] [-pe|-profile_enable] <[-unsec|-unsecure]|[-sec|-
secure]>

For Example:

On Windows

./oarepo.ps1 -i -s<https://hostname:portnumber> -v <version> -om <omservername>
-sec
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On Linux

./oarepo.sh -i -s<https://hostname:portnumber> -v <version> -om <omservername>
-unsec

In this instance,

-i is used to install and download the HP Operations
Agent packages.

-s specifies the server URL along with the port number
where the agent installation repository is hosted.

-v specifies the version number of HP Operations Agent.
You can get the version number from the Agent
Installation Repository landing page.

-om specifies the OM server name to which the
HP Operations Agent has to be activated.

-pe is used to install using profile file. Profile file based
installation is enabled by default.

-sec is used if SSL certificate is imported and installed on
the client.

-unsec is used if SSL certificate is not imported.

Note:
If the version is not mentioned in the command, the commandwill download the latest version
of HP Operations Agent by default.

-d can be used only to download the HP Operations Agent packages.

For information about importing and configuring SSL certificate, see Configuring SSL
Certificates for the Agent Install Repository Virtual Appliance.

Verification

To check the version of HP Operations Agent installed, run the following command:

On Windows: %ovinstalldir%/bin/opcagt -version

On Linux: /opt/OV/bin/opcagt –version

Installing the HP Operations Agent using the Yum Repository

Yum is a utility which checks for the repository details mentioned in the configuration file and installs
the HP Operations agent packages on those nodes. Yum repository for HP Operations Agent is
provided along with the Agent Installation Repository.

You can access the Yum repository on the Virtual Appliance using the following URL:
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https://hostname:portnumber/oa/yum_oa_all.repo

In this instance,

hostname is the IP address of the VM.

portnumber is the default port of the VM or it can be any other port if set.

To install the HP Operations agent using Yum repository, follow the steps:

Note: For information on prerequisites to install the HP Operations Agent, see the chapter
Prerequisites to Install the HP Operations Agent on a Node.

1. Log on to the target node.

2. Download and copy the yum_oa_all.repo file from https://hostname:portnumber/oa/yum_
oa_all.repo to /etc/yum.repos.d/.

In this instance,

hostname is the IP address of the VM.

portnumber is the default port of the VM or it can be any other port if set.
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3. Download and copy the HP public key from
https://hostname:portnumber/oarepo/hpPublicKey2048.pub to /etc/pki/rpm-
gpg/hpPublicKey2048.

4. Run the following command to install specific versions of HP Operations agent:

To install latest version:

yum install HPOvOpsAgt

To install previous versions 11.11 and 11.14 together:

yum --disablerepo=oa_12.00 install HPOvOpsAgt

In this instance,

disablerepo is used to disable the HP Operations Agent version you do not want to install.

5. Configure themanagement server by performing the following steps:

a. Go to the following directory on the Linux node: /opt/OV/bin/OpC/install

b. Run the following command: opcactivate -srv <management_server> -cert_srv
<management_server> -f

In this instance,

<management_server> is the FQDN of the HPOMmanagement server.
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Verification

l To verify if HP Operations Agent packages are installed, run the following command:

rpm -qa | grep <packagename>

In this instance,

<packagename> is the name of the HP Operations Agent package.

For Example: rpm -qa | grep <HPOvBbc>

l To check the version of HP Operations Agent on the node, run the following command:

On Linux: /opt/OV/bin/opcagt –version

l To check the inventory, run the following command:

On Linux: /opt/OV/bin/ovdeploy –inv –includeupdates

To remove the packages from the Target Node, see "Remove the Packages from the Target Node " on
page 103.
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Chapter 9: Installing HP Operations Agent using the
Puppet Environment
You can install HP Operations Agent usingPuppet in an environment wherePuppet Master and
Puppet Clients are configured.

HP Operations Agent packages are stored in the Agent Installation Repository. The puppet module
available on the puppet master fetches the HP Operations Agent packages or zip file from Agent
Installation Repository and deploys the HP Operations Agent packages on the puppet client (Linux
nodes).

You can use puppet open source or puppet enterprise to deploy HP Operations Agent on the node. For
the puppet open source, you can use the oamodules and install HP Operations Agent by using the
following options:

On Linux

l Using Yum

Or

l Using oarepo.sh

On Windows

l Using oarepo.ps1

You can also configure the XPL parameters by using the puppet module.

Note: Puppet modules support Puppet 3.8 and higher versions.

Prerequisites

l Enable Powershell onWindows

Note: The Powershell version 2.0 and above are supported.

l Puppet environment: puppet master and puppet clients must be configured

Data flow in a puppet environment
The following illustration shows the data flow in a puppet environment for HP Operations Agent
deployment.
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Installing and configuring HP Operations Agent on Linux
using YUM
To deploy HP Operations Agent, follow the steps:

Note: For information on prerequisites to install the HP Operations Agent, see the chapter
Prerequisites to Install the HP Operations Agent on a Node.

1. Log on to the puppet master.

2. The puppet_modules.tar is available on the Agent Installation Repository landing page
https://hostname:portnumber/oarepo/puppet_modules.tar. Download, copy and untar the
puppet_modules.tar file in the puppet modules directory.
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For Example: You can download the puppet_modules.tar file at /etc/puppet/modules/ on
puppet master.

3. For configuring HP Operations Agent deployment using YUM, open the init.pp class file from
hpoa_install_config/manifests/init.pp on puppet module and define themodules to be
deployed on the puppet client:

class { 'hpoa_install_config::pkginstall':

reposerver => "$repo_server",

version => "$version_yum",

}

class { 'hpoa_install_config::activate':

om_server => "$om_server",

profile_enable => $profile_enable,

require => Class['hpoa_install_config::pkginstall']

}

service { 'OVCtrl':

ensure => running,

enable => true,
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require => Class['hpoa_install_config::activate']

}

4. Open the site.pp class file from /<puppet modules directory>/manifests/site.pp on
puppet master and define themodules to be deployed on the puppet client:

Example: For Linux nodes:

class { 'hpoa_install_config':

om_server => "om_server",

profile_enable => "yes",

repo_server => "repo_server",

secured => "-unsec",

version => "version",

}

In this instance,

version specifies the HP Operations Agent version. For example, version can be 11.14.014.

repo_
server

specifies the system namewhere Agent Installation Repository (VA or Standalone) is
available.

om_
server

specifies the server name to which the HP Operations Agent has to be activated.

secured Use -sec if SSL certificate is imported and installed on the client. If SSL certificate is
not imported, use -unsec.

For information about importing and configuring SSL certificate, see Configuring SSL
Certificates for the Agent Install Repository Virtual Appliance.

Note: Profile file based installation is enabled by default. To disable profile file based
installation, set profile_enable => "no". To enable profile file based installation, set
profile_enable => "yes" or "". Make sure that profile file configuration settings are
updated as mentioned in "Enabling HP Operations Agent Installation using Profile File with
Puppet" on page 85.

5. To test the deployment, log on to the puppet client and run the following command:

puppet agent --test

Note: You can verify the HP Operations Agent version installed by using the command:
/opt/OV/bin/opcagt –version
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Installing and configuring HP Operations Agent on Linux
using oarepo.sh
To deploy HP Operations Agent, follow the steps:

1. Log on to the puppet master.

2. The puppet_modules.tar is available on the Agent Installation Repository landing page
https://hostname:portnumber/oarepo/puppet_modules.tar. Download, copy and untar the
puppet_modules.tar file in the puppet modules directory.

For Example: You can download the puppet_modules.tar file at /etc/puppet/modules/ on
puppet master.

3. Open the init.pp class file from hpoa_install_config/manifests/init.pp on puppet
module. The hpoa_install_config puppet module uses the oarepo.sh script to download, install
or configure the HP Operations Agent from the Agent Installation Repository server. Check the
version, repo_server, and the om_server details.

class {'hpoa_install_config':air_linux'

repo_server => $repo_server,

version => $oarepo_version,
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om_server => $om_server

profile_enable => $profile_enable

}

4. Open the site.pp class file from /<puppet modules directory>/manifests/site.pp on
puppet master and define themodules to be deployed on the puppet client:

class { 'hpoa_install_config' :

repo_server => $repo_server,

version => $oarepo_version,

om_server => $om_server

profile_file => "yes"

secured => "-sec"

}

In this instance,

version specifies the HP Operations Agent version. For example, version can be 11.14.014.

repo_
server

specifies the system namewhere Agent Installation Repository (VA or Standalone) is
available.

om_
server

specifies the server name to which the HP Operations Agent has to be activated.

secured use -sec if SSL certificate is imported and installed on the client. If SSL certificate is
not imported, use -unsec.

For information about importing and configuring SSL certificate, see Configuring SSL
Certificates for the Agent Install Repository Virtual Appliance.

Note: Profile file based installation is enabled by default. To disable profile file based
installation, set profile_enable => "no". To enable profile file based installation, set
profile_enable => "yes" or "". Make sure that profile file configuration settings are
updated as mentioned in "Enabling HP Operations Agent Installation using Profile File with
Puppet" on page 85.

5. To test the deployment, log on to the puppet client and run the following command:

puppet agent --test

Note: You can verify the HP Operations Agent version installed by using the command:
/opt/OV/bin/opcagt –version
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Installing and configuring HP Operations Agent on
Windows using oarepo.ps1
Prerequisite

Enable PowerShell script execution by setting the remote signed policy.

Note: The Powershell version 2.0 and above are supported.

To check the policy, run the following command in PowerShell:

PS C:\> Get-ExecutionPolicy

If the policy is not specified as RemoteSigned, set it to RemoteSigned by running the following
command in PowerShell:

PS C:\> Set-ExecutionPolicy RemoteSigned

In this instance,

RemoteSigned specifies that; downloaded scripts must be signed by a trusted publisher before they
can be run.

Note: RemoteSigned is the threshold level of permission required, you can also set policy as
AllSigned or Unrestricted.

In this instance,

AllSigned specifies that; scripts signed by a trusted publisher only can be run.

Unrestrictedmeans; all Windows PowerShell scripts can be run.

Installation

To install HP Operations Agent onWindows using oarepo.ps1, follow the steps:

1. Log on to the puppet master.

2. The puppet_modules.tar is available on the Agent Installation Repository landing page
https://hostname:portnumber/oarepo/puppet_modules.tar. Download, copy and untar the
puppet_modules.tar file in the puppet modules directory.
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For Example: You can download the puppet_modules.tar file at /etc/puppet/modules/ on
puppet master.

3. Open the init.pp class file from hpoa_install_config/manifests/init.pp on puppet module.
The hpoa_install_config puppet module uses the oarepo.ps1 script to download, install or
configure the HP Operations Agent from the Agent Installation Repository server. Check the
version, repo_server, and the om_server details.

class { 'hpoa_install_config::air_windows':

repo_server => $repo_server,

version => $oarepo_version,

om_server => $om_server,

profile_enable => $profile_enable

}

4. Open the site.pp class file from /<puppet modules directory>/manifests/site.pp on puppet
master and define themodules to be deployed on the puppet client:

class { 'hpoa_install_config' :

repo_server => $repo_server,

version => $oarepo_version,

om_server => $om_server
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profile_file => "yes"

secured => "-sec"

}

In this instance,

version specifies the HP Operations Agent version. For example, version can be 11.14.014.

repo_
server

specifies the system namewhere Agent Installation Repository (VA or Standalone) is
available.

om_
server

specifies the server name to which the HP Operations Agent has to be activated.

secured use -sec if SSL certificate is imported and installed on the client. If SSL certificate is
not imported, use -unsec. For information about importing and configuring SSL
certificate, see Configuring SSLCertificates for the Agent Install Repository Virtual
Appliance.

Note: Profile file based installation is enabled by default. To disable profile file based
installation, set profile_enable => "no". To enable profile file based installation, set
profile_enable => "yes" or "". Make sure that profile file configuration settings are
updated as mentioned in "Enabling HP Operations Agent Installation using Profile File with
Puppet" below.

5. To test the deployment, log on to the puppet client and run the following command:

puppet agent --test

Note: You can verify the HP Operations Agent version installed by using the command:
<OvInstallDir>/opcagt –version

Enabling HP Operations Agent Installation using Profile File
with Puppet
You can use the profile file option during installation to enable HP Operations Agent to run with non-
default configuration settings. For example, you can update the configuration settings such as the
communication port, event interceptor port, or the license type using the profile file.

In puppet environment, profile file is available as a template profile_file_default.erbwith the
default configuration settings for MANAGER, CERTIFICATE_SERVER and INSTALL_OPCAUTH.

The template is available in the puppet_modules.tar on the Agent Installation Repository landing
page. You can download the puppet_modules.tar from
https://hostname:portnumber/oarepo/puppet_modules.tar
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The profile file is available under hpoa_install_config/templates.

You can configure the profile file in the following ways:

l Define the required configuration settings in the template profile_file_default.erb.

For Example:

To set custom Health View Server using profile file during installation:

Add the following in the template profile_file_default.erb:

set agent.health:OPC_SELFMON_SERVER=hostname

In this instance,

agent.health is the configuration variable namespace

OPC_SELFMON_SERVER is the configuration variable

hostname is the value for the configuration variable. This value will be fetched during run-time
from the puppet module.

l Set the configuration variable in the template profile_file_default.erb and define the value in
the profile.pp class file which is available under /hpoa_install_
config/manifests/profile.pp in the puppet modules directory.

For Example:
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To set custom Health View Server using profile file during installation:

Configure the profile file, follow the steps:

a. Set the configuration variable in the template profile_file_default.erb as:

set agent.health:OPC_SELFMON_SERVER=<%=@selfmonserver%>

b. Define the value in profile.pp class file as:

$selfmonserver = "hostname"

In this instance,

agent.health is the configuration variable namespace

OPC_SELFMON_SERVER is the configuration variable

<%=@selfmonserver%> is the representation for the value

hostname is the value for the configuration variable. This value is fetched during run-time from
the puppet module.

Profile file configuration for YUM and oarepo is provided in their respective sections.

Configuring HP Operations agent using puppet module to
set the XPL parameters for the nodes
The puppet module uses the oa_config custom resource to set the xpl parameters.

Follow these steps:

1. Log on to the puppet master.

2. The puppet_modules.tar is available on the Agent Installation Repository landing page
https://hostname:portnumber/oarepo/puppet_modules.tar. Download, copy and untar the
puppet_modules.tar file in the puppet modules directory.
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For Example: You can download the puppet_modules.tar file at /etc/puppet/modules/ on
puppet master.

3. The puppet module uses the oa_config custom resource to complete the configuration. Edit the
init.pp class file for XPL parameters:

oa_config

{

ensure => present,

notify => Service['OVCtrl'],

}

oa_config { 'coda.comm/SERVER_BIND_ADDR': value => 'localhost6', }

oa_config { 'eaagt/Dummy12': value => '12', }

oa_config { 'new_namespace/Dummy2': value => '12', }

In this instance,

coda.comm is the namespace.

SERVER_BIND_ADDR is the configuration variable.

value specifies the configuration variable value you want to update.
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Note: ensure is a parameter used to set or clear the variable. By default present is used to
set and clear is used to clear the configuration variable

Verification

Run the following command to verify the configuration changes made through puppet provider:

On Linux: /opt/OV/ovconfget <namespace>

On Windows: %ovinstalldir%bin\ovconfget <namespace>
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Chapter 10: Installing HP Operations Agent Using
HP Server Automation
HP Server Automation (SA) helps in automated application deployment. You can use the HP Server
Automation to deploy the HP Operations Agent. For more information on the prerequisites for installing
the HP Operations Agent, see Prerequisites for Installing the HP Operations Agent. The target where
you are installing the HP Operations Agent must always have SA agent installed on it.

To obtain the platform-specific media zip from the HP Operations agent media, run the following
command. The command creates zip media that can be imported into HP Server Automation.

cscript oainstall.vbs -createzip

or

./oainstall.sh -createzip

This creates a .zip file for each platform package in themedia. To obtain a platform-specific .zip file
from a specific location, run the following command:

cscript oainstall.vbs -createzip -out_dir c:\temp -p <OS name>

In this instance:

<OS name> is the name of the operating system

Use the following values for <OS name>:

ForWindows: WIN

For Linux: LIN

For example:

To obtain a .zip file forWindows operating system from a specific location, run the following
command:

cscript oainstall.vbs -createzip -out_dir c:\temp -p win

To install HP Operations agent using the SA console, perform the following tasks:

l "Import the HP Operations Agent Software" on the next page

l "Create a Software Policy " on page 92

l "Attach the Software Policy to a Device or Server" on page 93

Before starting the tasks to install HP Operations agent using the SA console, make sure that SA agent
is installed on the node. For more information, see Installing Server Agent section in the
HP Server Automation User Guide.
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Import the HP Operations Agent Software
To import the HP Operations agent software, follow these steps:

1. Obtain the HP Operations Agent media.

The HP Operations Agent media is in the .tar file format. To extract the contents of the .tar file
containing the HP Operations Agent media, use the command tar -xvf <filename>.tar on the
UNIX/Linux systems.

2. After the you untar the HP Operations Agent media, run the following command to create the zip
media:

cscript oainstall.vbs -createzip -p <OS name>

3. Log on to the HP Server Automation Client console.

4. In the navigation pane, select Library.

5. Select theBy Folder tab, and the required folder.

6. Click Actions > Import Software. The Import Software dialog box opens.

7. Browse and select the zip file that you created and select ZIP Archive (.zip) as the package type.

8. Browse and select the appropriate folder and platform.

9. Click Import.

10. Click Closewhen the import is successful. Double click the uploaded package to change the
following properties:

On Windows:

n Default install path:

%temp%\oa_media_Windows_X64

n Install Scripts - Post-install script:

%temp%\oa_media_Windows_X64\oainstall.bat

n Uninstall Scripts - Pre-uninstall script:

%temp%\oa_media_Windows_X64\oaremove.bat

On Linux:
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n Default install path:

/usr/local/oa_media_Linux2.6_X64

n Install Scripts - Post-install script:

cd /usr/local/oa_media_Linux2.6_X64

find . -print | xargs chmod +x

/usr/local/oa_media_Linux2.6_X64/oainstall.sh -i -a

n Uninstall Scripts - Pre-uninstall script:

/usr/local/oa_media_Linux2.6_X64/oainstall.sh -r –a

The package appears in the contents pane.

You can also install the imported software without creating and attaching a software policy by
performing the following tasks:

1. In the navigation pane, select Library, expandPackages, and select the platform on which you
imported the software zip file. The contents pane displays the imported software package.

2. Select Actions > Install Software.... The Install Software window opens.

3. Click and select the required device or server from the list and click Select.

4. Click Start Job. Click Closewhen the processes are successfully completed. To verify if the
package is successfully installed, see "Verifying the Installation" on page 94.

Create a Software Policy
To create a software policy, follow these steps:

1. In the navigation pane, select Library.

2. In theBy Type tab, expandSoftware Policies and select the required platform from the list. The
contents pane displays the existing software policies for the selected platform.

3. Click Actions > New.... The Software Policy window opens.

4. Type a name for the policy in theName field.

5. Click Select and select the appropriate folder.

6. Click Policy Items in theViews pane.
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7. Click in thePolicy Items pane. The Select Library Item window opens.

8. Select Package from theBrowse Types tab. The right pane displays all the available packages.

Alternatively, you can also select Browse Folders, and select the folder where you imported the
package and select it from the right pane.

9. Select the required package to attach the software policy.

10. Click Select. The package details appear in the Software Policy window.

11. In the left pane, click Contents to view the contents of the package.

12. Click File > Save. Close the window. The policy details appear on the contents pane.

Attach the Software Policy to a Device or Server
To attach a Software Policy, do one of the following:

l "Attach from Software Policy list" below

l "Attach from Devices list" below

Attach from Software Policy list

1. In the navigation pane, select Library.

2. In theBy Type tab, expandSoftware Policies and select the required platform from the list. The
contents pane displays the existing software policies for the selected platform.

3. Select the required software policy. Click Actions > Attach. The Attach Server window opens.

4. Select the required device from the Devices list and click Attach. The Remediate window opens.

5. Click Start Job. Wait till the installation process is complete.

6. Click Close after all requests are successfully completed.

Attach from Devices list

1. In the navigation pane, select Devices.

2. Select the required device or server from the Devices list. The contents pane displays the
associated devices or servers.

3. Select the required device or server. Click Actions > Attach > Software Policy. The Attach
Software Policy window opens.
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4. Select the software policy and click Attach. The Remediate window opens.

5. Click Start Job. Wait till the installation process is complete.

6. Click Close after all requests are successfully completed.

Note: To verify that the policy is attached to the device or server successfully, select the device or
server from the devices list and select Software Policies from theView drop down list. The
policies attached to the device or server are listed at the bottom of the contents pane.

Verifying the Installation
To verify that HP Operations Agent is successfully installed, follow these steps:

1. In the navigation pane, select Devices.

2. Select the required device or server from the Devices list. The contents pane displays the
associated devices or servers.

3. Select the required device or server.

4. Select Installed Packages from theViews drop down list in the contents pane. The list of
packages installed on the selected server or devices appears at the bottom of the pane.

5. Check that the HP Operations agent package is available.

Note: You can also check the contents of the oainstall.log file on the target system and verify that
HP Operations agent is installed.

Uninstalling HP Operations Agent using SA console

To uninstall HP Operations Agent using the SA console, follow these steps:

1. In the navigation pane, select Devices.

2. Select the required device or server from the Devices list. The contents pane displays the
associated devices or servers.

3. Select the required device or server. Click Actions > Uninstall > Software. The Uninstall
Software window opens and the contents pane displays the selected device or server.

4. Click Software from the list on the left pane.

5. Click to specify the software policy. The Select Library Item window opens.
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6. Select the required software policy attached to the HP Operations Agent package to be
uninstalled.

7. Click Select and thenStart Job. The Job Status appears and uninstalls the HP Operations Agent
package.

8. Click Close after the job is completed.

Note: To verify that package is uninstalled from the device or server successfully, select the
device or server from the devices list and select Software Policies from theView drop down
list. The policies attached to the device or server are listed at the bottom of the contents pane.
The list does not contain the HP Operations agent package after successful uninstallation.
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Chapter 11: Installing HP Operations Agent using
Microsoft System Center 2012 Configuration Manager
Microsoft System Center 2012 ConfigurationManager is a systems management software product.
You can useMicrosoft System Center 2012 ConfigurationManager to install HP Operations Agent on
the requiredWindows nodes and servers. For more information on the prerequisites for installing
HP Operations Agent, see "Prerequisites to Install the HP Operations Agent on a Node" on page 36.

Youmust add the node or server, where HP Operations Agent must be installed, to the System Center
2012 ConfigurationManager. For more information, see theMicrosoft System Center documentation.
After adding the node or server, navigate toAssets and Compliance > Overview > Devices and
check if the details appear in the devices list.

To install theMicrosoft System Center 2012 ConfigurationManager client on the required node, select

the node from the devices list and click Install Client ( ).

To install HP Operations Agent using theMicrosoft System Center 2012 ConfigurationManager
console, perform the following tasks:

l "Create the HP Operations Agent Package" below

l "Deploy the HP Operations Agent Package" on page 98

Create the HP Operations Agent Package
To create an HP Operations Agent deployment package, follow these steps:

1. Obtain the HP Operations Agent media.

2. Browse to the packages folder and select the required Operating System.

For example, to obtain theWindows 64-bit packages, browse to packages > WIN > Windows_
X64.

3. Extract the contents of themedia.

4. Log on to theMicrosoft System Center 2012 ConfigurationManager console.

5. In the left Navigation Pane, select Software Library.

6. ExpandOverview > Application Management and select Packages.

7. Click Create Package (
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) to create the HP Operations Agent deployment package.

The Create Package and ProgramWizard window opens.

8. Type a name for the package in theName field.

9. Type a description in theDescription field.

10. Select the This package contains source files checkbox and click Browse.

The Set Source Folder dialog box opens.

11. Select Network path (UNC name).

12. Click Browse and navigate to the location where the HP Operations Agent package is available.

13. Click OK and then click Next.

14. Select the program type you want to create and click Next.

15. Type a name for the program in theName field.

16. Click Browse corresponding to theCommand line field and navigate to the folder where the
oasetup.exe is available.

To start the installation on the node automatically with oasetup.exe, type

oasetup.exe -install in the field.

For example, you can also type cscript.exe oainstall.vbs –i –a -agent_profile
<absolute path of profile text file>, if you want to specify an agent profile. Make sure
that the .txt file is placed at the same location as where the oainstall.vbs file is present.

For example, you can also use the command cscript.exe oainstall.vbs -i -a -srv
<management_server_hostname> -cert_srv <management_server_hostname> -f

You canmention any agent installation command to perform an appropriate action during
deployment.

17. Select and provide values in the following fields, as required.

18. Click Next until the completion status window appears.

19. Click Close to close the dialog box.

The created package appears in the right pane of the console.
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Deploy the HP Operations Agent Package
To deploy the HP Operations Agent package on the node or server, follow the steps:

1. Select the HP Operations Agent package.

2. Click Deploy ( ).

The Deploy SoftwareWizard window opens.

3. Verify that theSoftware field contains the created package name.

If you need to select a different package, click the correspondingBrowse button and select the
required package.

4. Click Browse corresponding to theCollection field.

The Select Collection window opens.

5. Select the required node or server on which you want to deploy the HP Operations agent. Click
OK.

6. Click Next.

7. Click Add. Select Distribution Point orDistribution Point Group.

A window opens displaying the distribution points or the distribution point groups.

8. Select the required value and click OK.

9. Click Next. Specify the required Deployment Settings in the following screens.

10. In the Summary screen, click Next. The window shows the progress of the deployment.

11. Click Close in the Completion screen after the wizard displays themessage that the software is
successfully deployed.

Verifying the Installation
To verify if the HP Operations Agent is successfully installed, follow the steps:

1. In the left Navigation Pane, selectMonitoring.

2. Navigate toOverview > Deployments. The right pane displays all the deployments with the
name of the package created.
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3. Select the appropriate deployment and click View Status ( ).

Alternatively, you can also double-click the deployment to view the status.

The right pane displays the deployment status. You can check the different tabs to view the status
of the deployment.
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Chapter 12: Installing HP Operations Agent Using Red
Hat Network Satellite Server
You can use RedHat Network Satellite server to deploy the HP Operations agent on all the Linux
nodes. For more information on the prerequisites for installing HP Operations agent, see "Prerequisites
to Install the HP Operations Agent on a Node" on page 36. The target node where you are installing
HP Operations agent must always be added to communicate with Red Hat Network Satellite (RHNS)
server.

Note:When you upgrade from the HP Operations Agent 8.60 to 12.00, ensure that you uninstall
HP Operations Agent 8.60 using the opc_inst.sh –r command and then install the HP
Operations Agent 12.00 using the Red Hat Network Satellite server.

To obtain platform specific packages from the HP Operations agent media, browse themedia to the
specific package location. The following table lists the platform-specific packages to be obtained from
themedia.

Operating System Architecture Packages

Linux Linux2.6 x64 packages/LIN/Linux2.6_X64

Linux2.6 x86 packages/LIN/Linux2.6_X86

Linux2.6 PPC64 packages/LIN/Linux2.6_PPC64

To install HP Operations agent using RHNS server, perform the following tasks:

1. "Collect and Store the HP Operations agent depot files (RPMs) in Software Delivery Repository "
below

2. "Create the Setup on the Target Node " on the next page

3. "Deploy the Packages on the Target Node" on page 102

To remove the packages from the target node, see "Remove the Packages from the Target Node " on
page 103

Collect and Store the HP Operations agent depot files
(RPMs) in Software Delivery Repository
To download the HP Operations agent software, follow these steps:
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1. Obtain the HP Operations agent media andmount it to your desired location.

2. To obtain the Linux packages, browse to the packages folder and select Lin.

3. Select and unzip all the gzip files from themedia using the – N option.

4. Upload the HP Operations agent RPMs to Software Delivery Repository location of the RHNS
server.

Create the Setup on the Target Node
To create the setup on the target node, follow these steps:

1. Add the node to RHNS server. The node is known as the target node.

2. On the target node, create a file and provide the location on the system where HP Operations
agent packagemust create theDefault Agent File (oa.repo).

For example, create a file /etc/yum.repos.d/<oa.repo>.

Note: The agent depot files must be available in the repos.d location.

3. Update the contents of the file and specify the location (baseurl) where HP Operations agent depot
files are available.

Note: The content of the file:

[oa]

Name=Operations Agent

baseurl=System_name/SDR/downloads/Extras/RedHat/6Server/x86_
64/current/operation-agent/<Agent RPMs location>

gpgcheck=0

In this instance:

<Name> is the product name.

<baseurl> is the location where HP Operations agent package is available.

gpgcheck is the additional check to verify the RPMs. To disable this additional check, set the
value as 0.

OR
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Use the content to verify the RPMs with the public key.

[oa]

Name=Operations Agent

baseurl=System_name/SDR/downloads/Extras/RedHat/6Server/x86_
64/current/operation-agent/<Agent RPMs location>

gpgcheck=1

gpgkey=file://<path of hpPublicKey.pub>

In this instance:

<Name> is the product name.

<baseurl> is the location where agent package is available.

gpgcheck is the additional check to verify the RPMs. To enable this additional check, set the
value as 1.

gpgkey is the path to get the HP public key. This is key is only required if you need additional
security.

Deploy the Packages on the Target Node
Follow these steps:

1. Run the command to install the required RPMs:

# yum install <HPOvOpsAgt>

Note: All the dependent HP Operations agent RPMs will be installed.
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2. Run the command to verify if HP Operations agent packages are installed:
rpm -qa | grep <packagename>

In this instance, <packagename> is name of the agent package.

For example, rpm -qa | grep <HPOvBbc>

After performing all the steps, HP Operations agent RPMs are available on the node. Configure the
management server by performing the following steps:

1. Go to the following directory on the Linux node:

/opt/OV/bin/OpC/install

2. Run the following command:

opcactivate -srv <management_server> -cert_srv <management_server> -f

In this instance:

<management_server> is the FQDN of the HPOMmanagement server.

Remove the Packages from the Target Node
You can remove the packages by using either theYUM command or oainstall.sh program.

Using YUM Commands to remove the packages
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l Run the following command to remove the package or only the specific RPMs:

yum remove <package name>

Note:Make sure that you install yum-plugin-remove-with-leaves to remove all the Operations
agent packages by using a single command.

l Run the following command to remove HP Operations agent completely:

yum remove --remove-leavesHPOvOpsAgt HPOvSecCo

Using oainstall.sh program to remove the packages

To remove the packages, run the following command:

/opt/OV/bin/OpC/install/oainstall.sh -r -a
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Chapter 13: Installing the HP Operations Agent on
Platforms Supported with Limitation
See the HP Operation Agent Support Matrix document for more details on platforms supported with
limitation.

The installer may fail to install the HP Operations Agent on platforms supported with limitation. You
may see the following error when you try to install the agent on such platforms:

The product bundle selected may not yet be supported on this node

To install the HP Operations Agent on such nodes, youmust run the installer with the -minprecheck
option along with the -i and -a options.

Examples

To install the HP Operations Agent 12.00 on aWindows system, run the following command:

cscript oainstall.vbs -i -a -minprecheck

To install the HP Operations Agent 12.00 on a UNIX/Linux system, run the following command:

./oainstall.sh -i -a -minprecheck

Install the HP Operations Agent on Platforms Supported
with Limitation Remotely from the HPOM for Windows
Console
To install the HP Operations Agent 12.00 remotely from the HPOM forWindows console on platforms
supported with limitation, youmust perform the following pre-installation tasks on themanagement
server:

1. Log on to themanagement server as an administrator.

2. Go to the directory %ovdatadir%share\conf\PMAD.

3. Rename the agent_install_defaults.cfg.sample file to agent_install_defaults.cfg.

Tip: Take a backup of the agent_install_defaults.cfg.sample file.

4. Open the agent_install_defaults.cfg file with a text editor and add the following line:

[nonXPL.config]
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MINPRECHECK=True

5. Save the file.

You can now follow the steps in "From HPOM forWindows" on page 51 to install the HP Operations
Agent 12.00 remotely from the HPOM console.

Install the HP Operations Agent on Platforms Supported
with Limitation Remotely from the HPOM for UNIX Console
To install the HP Operations Agent 12.00 remotely from the HPOM for UNIX console on platforms
supported with limitation, youmust perform the following pre-installation tasks on themanagement
server:

1. Log on to themanagement server with the root privileges.

2. Go to the directory /etc/opt/OV/share/conf/OpC/mgmt_sv.

3. Rename the file bbc_inst_defaults.sample to bbc_inst_defaults.

4. Open the file bbc_inst_defaultswith a text editor and add the following line:

[nonXPL.config]

MINPRECHECK=true

5. Save the file.

Follow the steps in ""From HPOM onUNIX/Linux" on page 51" to install the HP Operations Agent
12.00 remotely from the HPOM console.

Note: After installing the HP Operations Agent 12.00 usingMINPRECHECK, the changes done in
the profile file must be reverted. When you install usingMINPRECHECK, the version check for
the Operating System and Architecture will be skipped.

Install the HP Operations Agent on Platforms Supported
with Limitation Remotely Using Command Line
To install the HP Operations Agent 12.00 remotely on platforms supported with limitation:

1. Log on to themanagement server with root or administrator privileges.

2. Go to the following directory on themanagement server:
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On Windows:

%ovinstalldir%bin

On UNIX/Linux:

/opt/OV/bin

3. Add the following line in a text file:

[nonXPL.config]

MINPRECHECK=true

4. Run the following command:

ovdeploy –install –bundle <path_to_OVO-Agent.xml> –node <node name> –af <path_
of_profile _file>\<profile_file_name> –1 –configure <profile_file_name>

The command installs the HP Operations Agent 12.00 on the node.
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Chapter 14: Installing the HP Operations Agent
Manually on the Node
Task 1: Prepare for Installation

Before installing the HP Operations Agent, youmust extract or mount theHP Operations Agent and
Infrastructure SPIs 12.00media on the node.

Alternatively, you canmanually transfer the agent deployment package from the HPOMmanagement
server.

To transfer the deployment package from a Windows management server:

1. Make sure the node is added as amanaged node in the HPOM console.

2. Create a directory on themanagement server, and then go to the directory.

3. Run the following command:

ovpmutil dnl pkg Operations-agent /pnn <node_FQDN>

In this instance, <node_FQDN> is the fully-qualified domain name of the node.

The deployment package for the node is downloaded into the current directory.

4. Transfer the directory from themanagement server into a temporary directory on the node.

To transfer the deployment package from a UNIX/Linux management server:

1. Log on to themanagement server, and then go to the following directory:

/var/opt/OV/share/databases/OpC/mgd_
node/vendor/<vendor>/<arch>/<ostype>/A.12.00.000

In this instance:

<vendor>: Name of the operating system vendor.

<arch>: Architecture of the node.

<ostype>: Operating system of the node.

The following table provides a list of <vendor>/<arch>/<ostype> combinations that you can use:
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Operating System Architecture Select this combination..

Windows x86_64 ms/x64/win2k3

Windows x86 ms/x86/winnt

Linux x86_64 linux/x64/linux26

Linux x86 linux/x86/linux26

Linux PowerPC (64-bit) linux/powerpc/linux26

Linux (Debian) x64 linux_deb/x64/linux26

HP-UX Itanium hp/ipf32/hpux1122

HP-UX PA-RISC hp/pa-risc/hpux1100

Solaris SPARC sun/sparc/solaris7

Solaris x86 sun/x86/solaris10

AIX PowerPC (64-bit) ibm/rs6k64/aix5

2. Transfer the contents of the RPC_BBC directory (available inside the A.12.00.000 directory) into a
temporary directory on the node.

Optional. Installing HP Operations Agent using Profile File

Task 2: Install the HP Operations Agent and Infrastructure SPIs

In the following section:

<management_server>: FQDN of themanagement server

<certificate_server>: FQDN of the certificate server

<install_directory>: Path to place all packages and binary files on the node.

<data_directory>: Path to place all data and configuration files on the node.

<path> is the path to the profile file.

<profile_file> is the name of the profile file.

1. Log on to the node as root or administrator.

2. If you want to install from theHP Operations Agent and Infrastructure SPIs 12.00media, follow
these steps:
a. Go to themedia root.

b. Run the following command to install without a profile file:
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On Windows:

cscript oainstall.vbs -i -a -s <management_server> [-cs <certificate_
server>][-install_dir <install_directory> -data_dir <data_directory>]

On UNIX/Linux:

./oainstall.sh -i -a -s <management_server> [-cs <certificate_server>]

c. Run the following command to install with a profile file:

On Windows:

cscript oainstall.vbs -i -a -agent_profile <path>\<profile_file> -s
<management_server> [-cs <certificate_server>] [-install_dir <install_
directory> -data_dir <data_directory>]

On UNIX/Linux:

./oainstall.sh -i -a -agent_profile <path>/<profile_file> -s <management_
server> [-cs <certificate_server>]

Tip: OnWindows, you can use the oasetup program instead of the oainstall.vbs script.

To install the agent with the oasetup program:

i. Make sure that theMicrosoft Visual C++ Redistributable Package is installed on the
system.

If it is not installed on the system, follow these steps:

- Go to the packages\WIN directory from themedia root.

- Go to the appropriate directory based on the architecture of the node (Windows_X64
for x64 platforms andWindows_X86 for x86 platforms).

- Run the following executable files:

On Windows x86: vcredist_x86.exe and vcredist2k5_x86.exe

On Windows x64: vcredist_x64.exe and vcredist2k5_x64.exe

ii. Run the following command to install the agent:

oasetup -install -management_server <management_server> [-certificate_
server <certificate_server>] [-install_dir <install_directory> -data_dir
<data_directory>]
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or
oasetup -install -management_server <management_server> [-certificate_
server <certificate_server>] -agent_profile <path>\<profile_file> [-
install_dir <install_directory> -data_dir <data_directory>]

3. If youmanually transferred the agent deployment package from the HPOMmanagement server,
follow these steps:
a. Go to the directory on the node where you stored the deployment package.

b. Run the following command:

On Windows:

oasetup -install -management_server <management_server> [-certificate_server
<certificate_server>][-install_dir <install_directory> -data_dir <data_
directory>]

On UNIX/Linux:

i. chmod u+x oasetup.sh

ii. ./oasetup.sh -install -management_server <management_server> [-certificate_
server <certificate_server>]

To install with a profile file, add -agent_profile <path>\<profile_file> after -install.

Tip: TheOperations agent provides you with an option to trace the agent processes. You can run
the tracing option with the oainstall program, which generates trace files by using the following
command:

-enabletrace <application name>

Run the following command to get the list of applications: ovtrccfg -vc

For example:

-enabletrace ovconfget

To trace all the agent processes, run the commandwith the following additional option:

-enabletrace ALL

For example:

./oainstall.sh -i -a -agent_profile /root/profile/profile_file -s test_
system1.domain.com -enabletrace ALL

The trace file (with the extension .trc) is available in the following location:

On Windows
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%ovdatadir%Temp

On UNIX/Linux

/var/opt/OV/tmp

If you install the agent on an HPOMmanagement server, youmust restart all HPOM processes after
installation.

Placement of Packages

When you install the HP Operations agent on the standalone server, the installer program places all
necessary packages and files into the following locations:

l On Windows:
n %ovinstalldir%

n %ovdatadir%

The preceding files are placed at the location C:\Program Files\HP\HP BTO Software, by
default. You can change the location as required.

l On HP-UX, Linux, and Solaris:
n /opt/OV

n /opt/perf

n /var/opt/OV

n /var/opt/perf

l On AIX
n /usr/lpp/OV

n /usr/lpp/perf

n /var/opt/OV

n /var/opt/perf

Installation Log Files

The installer places the installation log file (oainstall.log) into the following directory:

l On Windows: %ovdatadir%\log

l On UNIX/Linux: /var/opt/OV/log

Verifying the Installation
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After installing the HP Operations agent, review the contents of the installation log file (oainstall.log).
If the installation is successful, the file must be error-free andmust display the followingmessage near
the end of the file:

HP Operations Agent installation completed successfully

Post-Installation Task in a NAT Environment
If you install the agent on nodes in the Network Address Translation (NAT) environment, youmust
configure the agent on the node to use the IP address that was used with HPOMwhile adding the node.

To configure the agent to use the IP address set with HPOM, follow these steps:

1. Log on to the node with the root or administrative privileges.

2. Go to the following directory:

On Windows

%ovinstalldir%bin

On HP-UX, Linux, or Solaris

/opt/OV/bin

On AIX

/usr/lpp/OV/bin

3. Run the following command:

ovconfchg -ns eaagt -set OPC_IP_ADDRESS <IP_Address>

In this instance, <IP_Address> is the IP address of the node that was configured with HPOM
while adding the node to the list of managed nodes.

4. Restart the agent by running the following commands:

a. ovc -kill

b. ovc -start

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 113 of 197



Chapter 15: Install Only the Infrastructure SPIs on the
HPOM Management Server
Prerequisites for Installing the Infrastructure SPIs

Hardware and Software Requirements

For a list of supported hardware, operating systems, HPOM version, and agent version, see the
Support Matrix.

Disk Space Requirements

Operating System on the HPOM Management
Server

Temporary
Directorya

Total Disk
Space

Windows %tmp% - 15MB 90MB

Linux /tmp - 35MB 90MB

HP-UX /tmp - 17MB 240MB

Solaris /tmp - 35MB 80MB

aThe disk space for the temporary directory/drive is required only during installation. These are
approximate values.

Upgrade Requirements

Installation of Infrastructure SPI version 12.00 is supported only on the following HPOMManagement
servers:

l HPOM forWindows Management server version 8.x and 9.x

l HPOM for Linux Management server version 9.1 and 9.2

l HPOM for HP-UX Management server and

l HPOM for Solaris Management server

Note: Before upgrading from the Infrastructure SPIs version 11.1x to 12.00, ensure that the Auto
Deployment option is disabled on all the nodes.

Follow the steps to ensure that the Auto Deployment option is disabled:

1. On the HPOM console, select a node, right click and select Properties.

2. In thePropertieswindow, select theNetwork tab.

3. Ensure that theEnable Auto Deployment option is unchecked.
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You can upgrade from the Infrastructure SPIs version 11.1x to 12.00. After you upgrade from
Infrastructure SPI version 11.1x to 12.00, Infrastructure SPI 11.1x policies are available in the v11.1x
folder and Infrastructure SPI 12.00 policies are available in the v12.0 folder.

On the HPOM console, select Policy management→Policy groups → Infrastructure Management
→ v11.1x and v12.0

You can either deploy Infrastructure SPI 11.1x or 12.00 policies on a node.

Note: Deployment of both Infrastructure SPI 11.1x and 12.00 policies on the same node is not
supported.

Upgrading from Infrastructure SPIs 2.xx or earlier versions to Infrastructure SPI version 12.00

Youmust upgrade Infrastructure SPIs 2.xx or earlier versions to Infrastructure SPIs 11.1x and then
upgrade to Infrastructure SPI 12.00.

Install the Infrastructure SPIs

1. Log on to themanagement server.

2. Perform one of the following tasks:

n If you want to install the Infrastructure SPIs from the physical media, insert theHP Operations
Agent and Infrastructure SPIs 12.00DVD into the DVD-ROM drive.

n Download the installationmedia (.iso file) from one of HP’s web sites.

Use the physical DVD or the .iso file that includes deployment packages for all platforms.
Platform-specific .iso files do not contain the Infrastructure SPIs.

3. The oainstall program installs the Infrastructure SPIs on themanagement server while registering
the deployment package. This installation includes necessary report (for use with HP Reporter)
 and graph (for use with HP PerformanceManager) packages for the Infrastructure SPIs. To skip
the registration of the HP Operations Agent packages, follow these steps:

a. Open the default_config file. You will find the following default selection:

[agent.parameter]

REGISTER_AGENT=NO

[hpinfraspi.parameter]

InfraSPI= NO

InfraSPI_With_Graphs= YES

InfraSPI_With_Reports= YES

b. Under the [hpinfraspi.parameter] section, you can set the following:
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o Do not make any changes to the file (that is, do not set any values for the properties under
the [hpinfraspi.parameter] section) if you want to install the Infrastructure SPIs with
reports (forWindows only) and graphs.

o Set InfraSPI toYES and the rest of the properties to NO if you want to install only the
Infrastructure SPIs without reports (forWindows only) and graphs.

o Set InfraSPI_With_Graphs toYES and the rest of the properties to NO if you want to
install only the Infrastructure SPIs and graphs.

Note: Do not install the graph packages if HP PerformanceManager is not installed
on themanagement server. If HP PerformanceManager is installed on a remote
server, youmust install graph packages separately on that server.

If you use HPOM onUNIX/Linux and want to see graphs with HP Performance
Manager, youmust integrate HP PerformanceManager with HPOM onUNIX/Linux
(see Integrate HP PerformanceManager with HPOM onUNIX/Linux).

o Set InfraSPI_With_Reports toYES and the rest of the properties to NO if you want to
install only the Infrastructure SPIs and reports (and no graphs).

Note: Since HP Reporter is not supported on UNIX/Linux, HP Reporter needs to be
available on a remote server. To install report packages for the Infrastructure SPIs on
the remote HP Reporter server, see Install Report andGraph Packages on a Remote
Server.

c. Save the file.

4. Run the following command:

On Windows

cscript oainstall.vbs -i -m -spiconfig <config_file>

OnUNIX/Linux

./oainstall.sh -i -m -spiconfig <config_file>

In this instance, <config_file> is the name of the configuration file (with the complete path to the
file).

Note: If HPOM is in an HA cluster, follow the above steps on the active node in the cluster,
and then perform step 1 through step 4 on all nodes in the HA cluster.

Example
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i. Create a configuration file with the following content:

[agent.parameter]

REGISTER_AGENT=NO

[hpinfraspi.parameter]

InfraSPI=YES

InfraSPI_With_Graphs=NO

InfraSPI_With_Reports=NO

ii. Save the file as config_file in the following directory:

C:\temp

iii. Run the following command to install the Infrastructure SPIs.

cscript oainstall.vbs -i -m -spiconfig C:\temp\config_file

The command uses the config_file to install the Infrastructure SPIs without installing the agent,
report package, and graph package.

Install Report and Graph Packages on a Remote Server

When the HP Reporter and the HP PerformanceManager are installed on a server other than the
HPOMmanagement server, youmust follow this procedure to install report and graph packages for the
Infrastructure SPIs.

To install report packages:

1. Log on to the HP Reporter server as administrator.

2. Place or mount theHP Operations Agent and Infrastructure SPIs 12.00media on the system.

3. Go to the following directory:

For aWindows x64 system

<media_root>\integration\infraspi\WIN\Windows_X64

For aWindows x86 system

<media_root>\integration\infraspi\WIN\Windows_X86

4. Double click to install HPSpiInfR.msi.

To install graph packages:
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1. Log on to the HP PerformanceManager server as administrator or root.

2. Place or mount theHP Operations Agent and Infrastructure SPIs 12.00media on the system.

3. Go to the following directory:

For a Linux system

<media_root>\integration\infraspi\LIN\Linux2.6_X64

For an HP-UX system

<media_root>\integration\infraspi\HP-UX\HP-UX_IA32

For a Solaris system

<media_root>\integration\infraspi\SOL\Solaris_SPARC32

For aWindows x64 system

<media_root>\integration\infraspi\WIN\Windows_X64

For aWindows x86 system

<media_root>\integration\infraspi\WIN\Windows_X86

4. On Linux

Extract the contents of theHPSpiInfG.rpm.gz file, and then install theHPSpiInfG.rpm file.

On HP-UX

Extract the contents of theHPSpiInfG.depot.gz file, and then install theHPSpiInfG.depot file.

On Solaris

Extract the contents of theHPSpiInfG.sparc.gz file, and then install theHPSpiInfG.sparc file.

On Windows

Double click to install theHPSpiInfG.msi file.

5. Integrate HP PerformanceManager with HPOM onUNIX/Linux (see Integrate HP Performance
Manager with HPOM onUNIX/Linux)

Log File

The registration log file (oainstall.log) is available in the following directory:

On Windows

/var/opt/OV/shared/server/log
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On UNIX/Linux

%OvDataDir%shared\server\log

Verifying the Installation

After installing the Infrastructure SPIs, review the contents of the installation log file (oainstall.log).
If the installation is successful, the file must be error-free andmust display the followingmessage near
the end of the file:

HPSpiSysI installation completed successfully

HPSpiVmI installation completed successfully

HPSpiClI installation completed successfully

In this instance:

l HPSpiSysI denotes HP Operations Smart Plug-in for System Infrastructure

l HPSpiVmI denotes HP Operations Smart Plug-in for Virtualization Infrastructure

l HPSpiClI denotes HP Operations Smart Plug-in for Cluster Infrastructure.

Integrate HP Performance Manager with HPOM on UNIX/Linux

1. On the HPOMmanagement server, go to the directory /opt/OV/contrib/OpC/OVPM.

2. Run the following command:

./install.sh <hostname>:<port>

In this instance, <hostname>is the FQDN of the HP PerformanceManager server and <port>is
the port used by HP PerformanceManager. Use the same commandwith the same options even
if HP PerformanceManager is installed on the HPOMmanagement server.

Components of the Infrastructure SPIs on HPOM for
Windows
The following Infrastructure SPIs components are available on the HPOM forWindows console.

Services

When you add a node to the HPOM forWindows node group, the SI SPI service discovery policy is
automatically deployed.

This service discovery policy discovers the systems infrastructure and services on the node, and adds
this information to the HPOM Services area.

To view the SI SPI servicemap, select Services > Systems Infrastructure. The SI SPI servicemap
graphically represents the discovered systems and instances.
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Note: The SI SPI discovery policy andQuickStart policies are autodeployed on the new nodes (if
auto-deployment is enabled) added to the HPOM forWindows server. On the existing nodes, you
must manually deploy the SI SPI discovery policy. For more information on automatic deployment
of policies on the nodes, see theHP Operations Smart Plug-in for System Infrastructure User
Guide.

Discovery of Virtual Infrastructure

After the SI SPI discovery policy identifies a node as a virtualization node, the VI SPI discovery is auto-
deployed. The virtual machines running on those nodes are added under the respective Virtualization
Infrastructure node group and the vendor specific QuickStart policies are auto-deployed on those
nodes.

The VI SPI discovery policy adds the discovered elements to the HPOM servicemap. To view the VI
SPI servicemap, select Services > Virtualization Infrastructure. The VI SPI servicemap graphically
represents the discovered virtual systems.

Discovery of Cluster Infrastructure

OnHPOM forWindows, if the SI SPI discovery policy identifies the node as a cluster node, it initiates
CISPI discovery policy on the node. The CI SPI discovery discovers the clusters, cluster nodes, and
resource groups. To view the Cluster Infrastructure SPI servicemap, select Services > Cluster
Infrastructure.

Service Type Models

The service typemodels display the service type categories that the nodes from node bank are
logically assigned to. You can view the service typemodel in HPOM forWindows.

Node Groups

After installing Systems Infrastructure SPI 11.xx, the node groups get added under the console tree
Nodes folder.

Note: The node group names appear in English even in non-English locales.

Policy Management

Under the InfrastructureManagement group, the policies are grouped according to language. For
example, English policies are grouped under en, Japanese polices are grouped under ja, and Simplified
Chinese policies are grouped under zh. The language groups appear according to the language
selected at installation time.

Note: The ConfigFile policies SI-ConfigureDiscovery and VI-VMwareEventTypes do not have a
localized name. The policy names are same as the English name even in non-English locales.

There is also a vendor based policy group. Under this group, the policies are re-grouped based on
different operating systems or vendors. The policies grouped by vendor includeQuickStart policies and
Advanced policies. TheQuickStart policies are automatically deployed on the supportedmanaged
nodes once they are added to the node respective node groups. You can choose to turn off automatic
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deployment of policies when services are discovered. In addition, you canmodify and save
preconfigured policies with new names to create custom policies for your own specialized purposes.

To view and access the Systems Infrastructure SPI policies, select Policy management→ Policy
groups→ Infrastructure Management→ v12.0 or v11.1x→ <language>→ Systems
Infrastructure.

To view and access the Virtualization Infrastructure SPI policies, select Policy management→Policy
groups → Infrastructure Management> → v12.0 or v11.1x→ <language>→Virtualization
Infrastructure.

To view and access the Cluster Infrastructure SPI policies, select Policy management→ Policy
groups→ Infrastructure Management→ v12.0 or v11.1x→ <language>→ Cluster Infrastructure.

Tools

Tools are provided for the Systems Infrastructure SPI and Virtualization Infrastructure SPI. You can
access the Systems Infrastructure SPI tool group by selecting Tools> Systems Infrastructure, and
the VI SPI tools group by selecting Tools> Virtualization Infrastructure.

Reports

If HP Reporter is installed on the HPOM forWindows management server, you can view the Reports
group from the HPOM forWindows console.

Graphs

A set of preconfigured graphs is provided with the SI SPI and the VI SPI. To access the graphs from
the HPOM console, youmust install HP PerformanceManager on the HPOMmanagement server prior
to the installation of the Infrastructure SPI graphs package.

You can access the SI SPI graphs by selectingGraphs> Infrastructure Performance, and the VI SPI
graphs by selectingGraphs> Infrastructure Performance > Virtualization.

Alternatively, if HP PerformanceManager is installed on a separate (stand-alone) system connected to
the HPOMmanagement server, you can view the graphs on the HP PerformanceManager stand-alone
system.

Components of the Infrastructure SPIs on HPOM for UNIX
The following Infrastructure SPIs components are available on the HPOM for UNIX (HP-UX, Linux,
and Solaris) Admin UI.

Services

The SI-service discovery policy discovers the systems infrastructure and services on the node and
adds this information to the HPOM Services area. Use JavaGUI to view the servicemap and the
Operator's console. Youmust install JavaGUI on a separate system.

Discovery of Virtual Infrastructure

After the Systems discovery has identified a node as a virtualization node, the VI SPI discovery is
auto-deployed. The virtual machines running on those nodes are added under the respective

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 121 of 197



Virtualization Infrastructure node group and the vendor specific QuickStart policies are auto-assigned
on those nodes.

The VI SPI discovery policy discovers the virtual machines (guest machines) hosted on themanaged
nodes (host machines), and adds this information to the HPOM Services area. Select Services>
Virtualization Infrastructure > Show Graph to view the VI SPI servicemap. The servicemap
graphically represents the discovered virtual systems.

Discovery of Cluster Infrastructure

For the cluster nodes that are added to the HPOM for HP-UX, Linux, or Solaris node bank, manually
deploy the CI SPI service discovery. The CI SPI discovery discovers the clusters, cluster nodes, and
resource groups. Select Services> Cluster Infrastructure > Show Graph, to view the CI SPI service
map.

Policy Management

Under the InfrastructureManagement group, the policies are grouped according to the language. For
example, English policies are grouped under en, Japanese polices and grouped under ja, and Simplified
Chinese policies are grouped under zh. The language groups appear according to the language
selected at installation time.

There is also a vendor based policy group. Under this group, the policies are re-grouped based on
different operating systems or vendors. The policies grouped by vendor includeQuickStart policies and
Advanced policies. TheQuickStart policies are automatically assigned to themanaged nodes after
they are added to the respective node groups. You canmanually deploy these policies on the nodes.

You can alsomodify and save preconfigured policies with new names to create custom policies for
your own specialized purposes.

To view and access the SI SPI policies, select Policy Bank→ Infrastructure Management→v12.0
or v11.1x →<language>→ Systems Infrastructure.

To view and access the VI SPI policies, select Policy Bank→ Infrastructure Management→v12.0
or v11.1x →<language>→ Virtualization Infrastructure.

To view and access the CI SPI policies, select Policy Bank→ Infrastructure Management→v12.0
or v11.1x → <language>→Cluster Infrastructure.

Tools

The Infrastructure SPIs provides tools for the SI SPI and the VISPI. You can access the SI SPI tool
group by selecting the Tool Bank > Systems Infrastructure, and the VI SPI tools group by selecting
Tool Bank > Virtualization Infrastructure.

Reports

If you use HPOM for HP-UX, Linux, and Solaris operating systems, HP Reporter is installed on a
separate (stand-alone) system connected to themanagement server. You can view the reports on the
HP Reporter stand-alone system.

For more information about the integration of HP Reporter with HPOM, see theHP Reporter Installation
and Special Configuration Guide.

Graphs
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The Infrastructure SPIs provide graphs for the SI SPI and the VI SPI. To generate and view graphs
from data collected, youmust use HP PerformanceManager in conjunction with HPOM.

To access the graphs, select the activemessage, open theMessage Properties window, and click
Actions. Under the Operator initiated action section, click Perform. Alternatively you can, right-click
activemessage, select Perform/Stop Action and click Perform Operator-Initiated Action.

If HP PerformanceManager is installed on themanagement server, you can launch and view graphs on
themanagement server. If HP PerformanceManager is installed on a separate (stand-alone) system
connected to the HPOMmanagement server, you can view the graphs on the HP Performance
Manager stand-alone system.
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Chapter 16: Installing the HP Operations Agent in the
Inactive Mode
About the Inactive Mode

While installing locally on themanaged node, you can choose to program the agent installer to only
place the necessary files and packages on the node without configuring any components. As a result,
the agent does not start running automatically and remains inactive. At a later time, youmust use the
installer program again to configure and start the agent.

The advantage of using this mechanism is the ability to clone the image of a system where the HP
Operations Agent is installed in the inactivemode. Cloning a system with preinstalled HP Operations
Agent eliminates the requirement to install the agent on the system after adding the system to the list of
managed nodes.

Installing the HP Operations Agent in the Inactive Mode

The inactivemode of installation ensures that the agent does not start its operation after installation.

To install the HP Operations Agent:

1. Log on to the node as root or administrator.

2. If you want to install from theHP Operations Agent and Infrastructure SPIs 12.00media, follow
these steps:
a. Go to themedia root.

b. Run the following command:

On Windows:

cscript oainstall.vbs -i -a -defer_configure [-install_dir <install_
directory> -data_dir <data_directory>]

On UNIX/Linux:

./oainstall.sh -i -a-defer_configure

In this instance:

<install_directory>: Path to place all packages and binary files on the node.

<data_directory>: Path to place all data and configuration files on the node.

Configure the Agent at a Later Time

Youmust configure the HP Operations Agent with configuration details (including the information about
the HPOMmanagement server and certificate server) to set the agent in the activemode. The -
configuration option of the oainstall program enables you to perform this task.

When you want to start the operation of the agent, follow these steps:
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1. Go to the following directory:

On Windows 64-bit nodes:

%ovinstalldir%bin\win64\OpC\install

On other Windows nodes:

%ovinstalldir%bin\OpC\install

OnHP-UX, Linux, or Solaris nodes:

/opt/OV/bin/OpC/install

On AIX nodes:

/usr/lpp/OV/bin/OpC/install

2. Run the following command:

On Windows

cscript oainstall.vbs -a -configure -s <management_server> [-cs <certificate_
server>]

Or

oasetup -configure -management_server <management_server> [-certificate_server
<certificate_server>]

On UNIX/Linux

./oainstall.sh -a -configure -s <management_server> [-cs <certificate_server>]

Configure the Agent Remotely from an HPOM for Windows Management Server

If you install the HP Operations Agent with the -defer_configure option, youmust configure the agent
to work with the HPOMmanagement server—at a later time. You can either configure the agent locally
on the node or remotely from the HPOM forWindows management server.

To configure the agent remotely:

Skip steps 1 and 2 if you are configuring agent forWindows.

1. Configure an SSH Client.

Note: HPOM forWindows provides you with the third-party SSH client software PuTTY. This
procedure guides you to set up the PuTTY SSH client. PuTTY is not HP software. It is
provided as is for your convenience. You assume the entire risk relating to the use or
performance of PuTTY.
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2. On themanagement server, from the %ovinstalldir%contrib\OVOW\PuTTY directory on the
management server, copy the files PLINK.EXE, PSCP.EXE, and runplink.cmd to any directory
that is included in your PATH environment variable. For example, if you installed themanagement
server into C:\Program Files\HP\HP BTO Software, copy the files into the following directory:
C:\Program Files\HP\HP BTO Software\bin.

3. Create a user. To remotely install agents, HPOM requires the credentials of a user who has
administrative access to the node. The following list shows the specific permissions required,
according to the node's operating system:
n On Windows:

o Write access to the admin$ share (the user must be part of the local administrators group)

o Read access to the registry

o Permission to log on as a service (this is only required if you select User/Password in the
Set Credentials list)

n On UNIX/Linux:
o Permission to log in to SSH on the node for file transfers and to execute installation

commands.

4. Configure the agent using the following commands:

For Windows 64-bit nodes

ovdeploy -cmd “%ovinstalldir%bin\win64\OpC\install\oasetup -configure -
management_server <management_server> -certificate_server <certificate_server>”
-node <node_name> -fem winservice -ostype Windows -user <node_user> -pw <node_
passwd>

Or

ovdeploy -cmd “%ovinstalldir%bin\win64\OpC\install\oasetup -configure -
management_server <management_server> -certificate_server <certificate_server>”
-node <node_name> -fem winservice -ostype Windows -user <node_user> -pw_prompt

For other Windows nodes

ovdeploy -cmd “%ovinstalldir%bin\OpC\install\oasetup -configure -management_
server <management_server> -certificate_server <certificate_server>” -node
<node_name> -fem winservice -ostype Windows -user <node_user> -pw <node_passwd>

Or

ovdeploy -cmd “%ovinstalldir%bin\OpC\install\oasetup -configure -management_
server <management_server> -certificate_server <certificate_server>” -node
<node_name> -fem winservice -ostype Windows -user <node_user> -pw_prompt

For an HP-UX, Linux, or Solaris node
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ovdeploy -cmd “/opt/OV/bin/OpC/install/oainstall.sh -a -configure -srv
<management_server> -cs <certificate_server>” -node <node_name> -fem ssh -
ostype UNIX -user <node_user> -pw <node_passwd>

Or

ovdeploy -cmd “/opt/OV/bin/OpC/install/oainstall.sh -a -configure -srv
<management_server> -cs <certificate_server>” -node <node_name> -fem ssh -
ostype UNIX -user <node_user> -pw_prompt

For an AIX node

ovdeploy -cmd “/usr/lpp/OV/bin/OpC/install/oainstall.sh -a -configure -srv
<management_server> -cs <certificate_server>” -node <node_name> -fem ssh -
ostype UNIX -user <node_user> -pw <node_passwd>

Or

ovdeploy -cmd “/usr/lpp/OV/bin/OpC/install/oainstall.sh -a -configure -srv
<management_server> -cs <certificate_server>” -node <node_name> -fem ssh -
ostype UNIX -user <node_user> -pw_prompt

In this instance:

<management_server>: Fully-qualified domain name of themanagement server.

<certificate_server>: Fully-qualified domain name of the certificate server. This parameter is
optional. If you do not specify the -cs option, themanagement server becomes the certificate
server for the node.

<node_name>: Fully-qualified domain name of the node.

<node_user>: User with which you can configure the agent on the node; the user that was
created.

<node_passwd>: Password of the above user.

Note: Use the option -pw_prompt to prompt for a password. This password is not saved in
history.
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Chapter 17: HP Operations Agent in High Availability
Clusters
You can use the HP Operations Agent to monitor nodes in a High Availability (HA) cluster. To be able to
monitor cluster-aware applications in an HA cluster, youmust deploy the agent with the following
guidelines:

All the nodes in a cluster must be present in the list of managed nodes in the HPOM console.

Youmust install the Operations Agent on every node in the HA cluster.

It is necessary that you set theMAX_RETRIES_FOR_CLUSTERUP variable (under the conf.cluster
namespace) on the node to an integer value. The profile file-based installation ensures that the variable
is set to an appropriate value on every node at the time of installation. An appropriate value depends on
the system restart sequence and the time it takes for the cluster to be initialized during restart.

Virtual Nodes, if you are using the node with the HPOM 9.x, you can take advantage of the concept of
virtual nodes. A virtual node is a group of physical nodes linked by a common resource group. Based on
the changes in the resource group, the agent can automatically enable or disable policies on the
physical nodes.

Tomonitor nodes in a HA Cluster:

l Deploy themonitoring policies on virtual nodes if you want the policies tomonitor a cluster aware
application.

Note: If you deploy policies on virtual nodes, you will not receive alerts from these nodes if the
resource group fails.

l Deploy themonitoring policies on physical nodes if you want the policies tomonitor the cluster
regardless of the state of the cluster.

Following are the guidelines for creating virtual nodes in the HPOM console:

l A virtual nodemust not itself be a physical node.

l Virtual nodes do not support DHCP, auto-deployment, and certificates.

l Youmust not install an agent on a virtual node.

Monitoring Nodes in HA Clusters

If you want themessages to be coming from a virtual node, then you can configure the HP Operations
Agent to monitor cluster-aware applications that run on the nodes in an HA cluster. This procedure is
mandatory if you have not created a virtual node.
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If you are using HPOM forWindows 8.1x (lower than patch OMW_00090), deploy the policies that you
identified for monitoring the cluster-aware application (in "HP Operations Agent in High Availability
Clusters" on the previous page) on all physical nodes in the HA cluster.

For all other types of management servers, deploy the policies that you identified for monitoring the
cluster-aware application (in "HP Operations Agent in High Availability Clusters" on the previous page)
on the virtual node created for the cluster.

Tomonitor cluster-aware applications on the nodes in an HA cluster, follow these steps:

1. Microsoft Cluster Server clusters only.Make sure that the resource group, which contains the
resource beingmonitored, contains both a network name and an IP address resource.

2. Identify the policies that you will require to monitor the cluster-aware application.

3. Create an XML file that describes the cluster-aware application, and name it apminfo.xml.

4. This file is used to define the resource groups that will bemonitored and tomap the resource
groups to application instances.

5. The apminfo.xml file has the following format:

Note: New lines are not allowed between package tags in the apminfo.xml file.

<?xml version="1.0" ?>

<APMClusterConfiguration>

<Application>

<Name>Name of the cluster-aware application.</Name>

<Instance>

<Name>Application's name for the first instance. The instance name is
used for start and stop commands and corresponds to the name used to
designate this instance in messages.</Name>

<Package>Resource group in which the application's first instance
runs.</Package>

</Instance>

<Instance>

<Name>Application's name for the second instance.</Name>

<Package>Resource group in which the application's second instance
runs.</Package>
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</Instance>

</Application>

</APMClusterConfiguration>

DTD for apminfo.xml

The following Document Type Definition (DTD) specifies the structure of apminfo.xml:

<!ELEMENT APMClusterConfiguration (Application+)>

<!ELEMENT Application (Name, Instance+)>

<!ELEMENT Name (#PCDATA)>

<!ELEMENT Instance (Name, Package)>

<!ELEMENT Package (#PCDATA)>

EXAMPLE

In the example below, the name of the resource group is SQL-Server, and the network (or
instance) name is CLUSTER04:

<?xml version="1.0" ?>

<APMClusterConfiguration>

<Application>

<Name>dbspi_mssqlserver</Name>

<Instance>

<Name>CLUSTER04</Name>

<Package>SQL-Server</Package>

</Instance>

</Application>

</APMClusterConfiguration>

6. Save the completed apminfo.xml file on each node in the cluster in the following directory:

On Windows:

%OvDataDir%conf\conf\
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On UNIX/Linux:

/var/opt/OV/conf/conf/

7. Create an XML file that describes the policies to be cluster-aware. The file namemust have the
format <appl_name>.apm.xml. <appl_name>must be identical to the content of the
<Application><Name> tag in the apminfo.xml file. The <appl_name>.apm.xml file includes the
names of the policies that you identified in "HP Operations Agent in High Availability Clusters" on
page 128.

8. Use the following format while creating the <appl_name>.apm.xml file:

<?xml version="1.0" ?>

<APMApplicationConfiguration>

<Application>

<Name>Name of the cluster-aware application (must match the content of <Application><Name>
in the apminfo.xml file).</Name>

<Template>First policy that should be cluster-aware.</Template>

<Template>Second policy that should be cluster-aware.</Template>

<startCommand>An optional command that the agent runs whenever an instance of the
application starts.</startCommand>

<stopCommand>An optional command that the agent runs whenever an instance of the
application stops.</stopCommand>

</Application>

</APMApplicationConfiguration>

Note:Within the startCommand and stopCommand tags, if you want to invoke a program
that was not provided by the operating system, youmust specify the file extension of the
program.

For example:

<startCommand>test_command.sh</startCommand>

<startCommand>dbspicol.exe ON $instanceName</startCommand>

The stop and start commands can use the following variables:
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Variable Description

$instanceName Name (as listed in <Instance><Name>) of the instance that is starting
or stopping.

$instancePackage Name (as listed in <Instance><Package>) of the resource group that is
starting or stopping.

$remainingInstances Number of the remaining instances of this application.

$openViewDirectory The commands directory on the agents.

Example

The following example file called dbspi_mssqlserver.apm.xml shows how the Smart Plug-in for
Databases configures the policies for theMicrosoft SQL Server.

<?xml version="1.0"?>

<APMApplicationConfiguration>

<Application>

<Name>dbspi_mssqlserver</Name>

<Template>DBSPI-MSS-05min-Reporter</Template>

<Template>DBSPI-MSS-1d-Reporter</Template>

<Template>DBSPI-MSS-05min</Template>

<Template>DBSPI-MSS-15min</Template>

<Template>DBSPI-MSS-1h</Template>

<Template>DBSPI-MSS6-05min</Template>

<Template>DBSPI-MSS6-15min</Template>

<Template>DBSPI-MSS6-1h</Template>

<Template>DBSPI Microsoft SQL Server</Template>

<StartCommand>dbspicol.exe ON $instanceName</StartCommand>

<StopCommand>dbspicol.exe OFF $instanceName</StopCommand>

</Application>

</APMApplicationConfiguration>
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9. Save the complete <appl_name>.apm.xml file on each node in the cluster in the following
directory:

On Windows :

%OvDataDir%bin\instrumentation\conf

On UNIX/Linux:

/var/opt/OV/bin/instrumentation/conf

10. Ensure that the physical nodes where the resource groups reside are all managed nodes.

11. Check the syntax of the XML files on all physical nodes by running the following command:

On Windows:

%OvInstallDir%\bin\ovappinstance -vc

On HP-UX, Linux, or Solaris:

/opt/OV/bin/ovappinstance -vc

On AIX:

/usr/lpp/OV/bin/ovappinstance -vc

Setting Cluster Local Node Name

For some physical nodes, for example for multihomed hosts, the standard hostnamemay be different
from the name of the node in the cluster configuration. If this is the case, the agent cannot correctly
determine the current state of the resource group. Follow the steps to configure the agent to use the
hostname as it is known in the cluster configuration:

1. Run the hostname command to obtain the name of the physical node as it is known in the cluster
configuration

Note: Run the following command to obtain the cluster details:

ovclusterinfo -a

2. Configure the agent to use the name of the node as it is known in the cluster configuration:

ovconfchg -ns conf.cluster -set CLUSTER_LOCAL_NODENAME <name>

In this instance, <name> is the name of the node as reported in the output of hostname command
and is case-sensitive.

3. Restart the agent on every physical node by running the following commands:
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ovc -kill

ovc -start

Agent User

By default, the HP Operations agent regularly checks the status of the resource group. OnUNIX and
Linux nodes, the agents use cluster application-specific commands, which can typically only be run by
root users. OnWindows nodes, the agents use APIs instead of running commands.

If you change the user of an agent, the agent may no longer have the permissions required to
successfully run cluster commands. In this case, youmust configure the agent to use a security
program (for example, sudo or .do) when running cluster commands.

To configure the agent running with a non-root account to run cluster commands, follow these steps:

1. Log on to the node with the root privileges.

2. Go to the following directory:

On HP-UX/ Linux/Solaris:

/opt/OV/bin

On AIX:

/usr/lpp/OV/bin

3. Run the following command to stop the agent:

ovc -kill

4. To configure the agent to use a security program, type the following command:

ovconfchg -ns ctrl.sudo -set OV_SUDO <security_program>

In this instance, <security_program> is the name of the program you want the agent to use, for
example /usr/local/bin/.do.

5. Run the following command to start the agent:

ovc -start
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Chapter 18: Configuring the HP Operations Agent in a
Secure Environment
The HP Operations Agent and the HPOMmanagement server communicate with each other over the
network using the HTTPS protocol. Themanagement server opens connections to the agent node to
perform tasks, such as deploying policies and launching actions.
The HP Operations Agent node opens connections to themanagement server to sendmessages and
responses.

By default, the operating systems of the agent node andmanagement server assign local
communication ports. However, both the agent andmanagement server use the communication
broker component for inbound communication. The communication broker component, by default,
uses the port 383 to receive data. Therefore, in effect, the node andmanagement server use two sets
of ports:

l Port assigned by the operating system for outbound communication

l Port used by the communication broker for inbound communication

In a highly-secure, firewall-based network, the communication between themanagement server and
agent nodemay fail due to restrictions in the firewall settings. In these scenarios, you can perform
additional configuration tasks to configure a two-way communication between themanagement server
andmanaged node.

Planning for Configuration

l If your network allows HTTPS connections through the firewall in both directions, but with certain
restrictions, the following configuration options are possible in HPOM to accommodate these
restrictions:

l If your network allows outbound connections from only certain local ports, you can configure HPOM
to use specific local ports.

l If your network allows inbound connections to only certain destination ports, but not to port 383, you
can configure alternate communication broker ports.

l If your network allows only certain proxy systems to open connections through the firewall, you can
redirect HPOM communication through these proxies.

l If your network allows only outbound HTTPS connections from themanagement server across the
firewall, and blocks inbound connections from nodes, you can configure a reverse channel proxy
(RCP).

Note: In an environment with multiple management servers, you can also configure the
management servers to communicate with one another through firewalls. The configuration is the
same as for communication betweenmanagement servers and nodes.
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Before You Begin

Skip this section if you are using the HP Operations Agent only onWindows nodes.

Most of the configuration tasks are performed through the ovconfchg utility, which resides in the
following directory:

On HP-UX, Linux, and Solaris

/opt/OV/bin

On AIX

/usr/lpp/OV/bin

To run the ovconfchg command (and any other agent-specific command) from anywhere on the
system, youmust add the bin directory to the PATH variable of the system. OnWindows systems, the
bin directory is automatically added to the PATH variable. To add the bin directory to the PATH
variable on UNIX/Linux systems, follow these steps:

Do one of the following:

On HP-UX, Solaris, or Linux nodes, run the following command:

export PATH=/opt/OV/bin:$PATH

OnAIX nodes, run the following command:

export PATH=/usr/lpp/OV/bin:$PATH

The PATH variable of the system is now set to the specified location. You can now run agent-specific
commands from any location on the system.

Configuring Proxies
You can redirect connections frommanagement servers and nodes that are on different networks
through an HTTP proxy.

Themanagement server opens connections to the proxy server, for example to deploy policies and
instrumentation, for heartbeat polling, or to launch actions. The proxy server opens connections to the
node on behalf of themanagement server, and forwards communication between them.

The node opens connections to the proxy server, for example to sendmessages, and action
responses. The proxy server opens connections to themanagement server on behalf of the node.

You can also redirect communication through proxies in more complex environments as follows:

l Eachmanagement server and node can use a different proxy server to communicate with each
other.

l You can configuremanagement servers and nodes to select the correct proxy according to the host
they need to connect to.

The figure below shows connections between amanagement server and nodes throughmultiple
proxies as follows:
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Themanagement server (1) opens connections to a proxy (2). The proxy opens connections to the node
(3) on behalf of themanagement server.

The node (3) opens connections to a different proxy (4). The proxy opens connections to the
management server (1) on behalf of the node.

The network allows management server (1) to make outbound HTTP connections directly through the
firewall (5) to another node (6). (The nodes (3, 6) are on different networks.)

The firewall (5) does not allow inbound HTTP connections. Therefore, node (6) opens connections to
themanagement server through a proxy (7).

Communication Using Proxies

PROXY Parameter Syntax

You redirect outbound HTTPS communication through proxies by setting the PROXY parameter in the
bbc.http name space on themanagement servers and nodes. You can configure this parameter in the
following ways:

l Configure the values in the HP Operations Agent installation defaults. For more information on the
profile file, see Installing HP Operations Agent using Profile File. This is recommended if you need
to configure proxies for large numbers of nodes. Youmust plan and configure the installation
defaults before you create or migrate your nodes.

l Use ovconfchg at the command prompt.

The value of the PROXY parameter can contain one or more proxy definitions. Specify each proxy in
the following format:

<proxy_hostname>:<proxy_port>+(<included hosts>)-(<excluded hosts>)
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Replace <included_hosts> with a comma-separated list of hostnames or IP addresses to which the
proxy enables communication. Replace <excluded hosts> with a comma-separated list of hostnames
or IP addresses to which the proxy cannot connect. Asterisks (*) are wild cards in hostnames and IP
addresses. Both <included_hosts> and <excluded hosts> are optional.

To specify multiple proxies, separate each proxy with a semicolon (;). The first suitable proxy in the list
takes precedence.

Example PROXY Parameter Values

To configure a node to use proxy1.example.com port 8080 for all outbound connections, you would use
the following value:

proxy1.example.com:8080

To configure amanagement server to use proxy2.example.com:8080 to connect to any host with a
hostname that matches *.example.com or *example.org except hosts with an IP address in the range
192.168.0.0 to 192.168.255.255, you would use the following value:

proxy2.example.com:8080+(*.example.com,*.example.org)-(192.168.*.*)

To extend the above example to use proxy3.example.com to connect to backup.example.com only,
you would use the following value:

proxy3.example.com:8080+(backup.example.com); proxy2.example.com:8080+
(*.example.com,*.example.org)-(192.168.*.*)

In the above example, proxy3.example.com:8080+(backup.example.com)must be first, because the
include list for proxy2.example.com contains *.example.com.

To redirect HTTPS communication through proxies:

1. Log on to themanagement server or node as an administrator or root and open a command prompt
or shell.

2. Specify the proxies that the node should use. You can specify different proxies to use depending
on the host that the agent wants to connect to. Run the following command:

ovconfchg -ns bbc.http -set PROXY <proxy>

Note:When you use the command ovconfchg on amanagement server that runs in a
cluster, add the parameter -ovrg <server>.

PROXY_CFG_FILE Parameter Syntax

Instead of specifying the details of the proxy server with thePROXY configuration variable, you can
use an external configuration file to specify the list of proxy servers and configure the HP Operations
Agent to read the proxy server data from the configuration file.

Before configuring thePROXY_CFG_FILE variable, youmust create the external configuration file.
The proxy configuration file is an XML file that enables you to specify proxy server details within XML
elements. Use a text editor to create the file; save the file under the following directory:

On Windows
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%ovdatadir%conf\bbc

On UNIX/Linux

/var/opt/OV/conf/bbc

Organization of the Proxy Configuration File
The proxy configuration XML file includes different XML elements for specifying proxy server, agent
node, andmanagement server details. You can provide the configuration data of multiple proxy servers
in the configuration file.

Structure of the Proxy Configuration XML File

<?xml version='1.0' encoding='UTF-8' standalone='yes'?>

<proxies>

<proxy>

<server>proxy_server.domain.example.com:8080</server>

<for>

<target>*.domain.example.com</target>

<target>*.domain2.example.com</target>

<target>*.domain3.example.com</target>

</for>

</proxy>

</proxies>

l proxies: The proxies element enables you to add details of proxy servers that you want to use in
your HPOM-managed environment. All the contents of this XML file are enclosed within the proxies
element.

l proxy: This element captures the details of the proxy server and systems that communicate with
the local node through the proxy server. You can configuremultiple proxy elements in this XML file.

l server: Use this element to specify the FQDN (or IP address) of the proxy server that you want to
use in your monitoring environment.

l for: Within the for element, include the FQDNs or IP addresses of all other agent nodes or
management servers that must communicate the local node only through the proxy server that you
specified within the server element. Youmust add each FQDN or IP address within the target
element.

For example:

<for>

<target>system3.domain.example.com</target>
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<target>system3.domain.example.com</target>

</for>

You can use the wildcard (*) character to configuremultiple system within a single target element. You
can also specify an IP address range.

For example:

<for>

<target>*.domain2.example.com</target>

<target>172.16.5.*</target>
<target>192.168.3.50-85</target>

</for>

l except: Use this element to create an exclusion list of systems that must not communicate with the
local node through the configured proxy server (specified in the server element). Include the FQDNs
or IP addresses of all such systems within the target element.

For example:

<except>

<target>*.domain3.example.com</target>

<target>172.16.10.*</target>
<target>192.168.9.5-25</target>

</except>

Syntax Description

<proxies>

<proxy>

<server>

server1.domain.example.com:8080

</server>

<for>

<target>*.domain2.example.com</target>

</for>

</proxy>

</proxies>

The server server1.domain.example.com
is configured as the proxy server and all
systems that belong to the domain
domain2.example.commust communicate
with the node or management server only
through server1.domain.example.com.

Examples of the Proxy Configuration File
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Syntax Description

<proxies>

<proxy>

<server>

server2.domain.example.com:8080

</server>

<for>

<target>*.domain2.example.com</target>

<target>192.168.2.*/target>

</for>

</proxy>

<proxy>

<server>

server3.domain.example.com:8080

</server>

<for>

<target>192.168.3.*</target>

</for>

<except>

<target>192.168.3.10-20</target>

</except>

</proxy>

</proxies>

The server server2.domain.example.com
is configured as the proxy server and all
systems that belong to the domain
domain2.example.com or with the IP
addresses that start with 192.168.2must
communicate with the node or management
server only through
server2.domain.example.com.

The server server3.domain.example.com
is configured as the second proxy server and
all systems with the IP addresses that start
with 192.168.3must communicate with the
node or management server only through
server3.domain.example.com. In addition,
systems within the IP address range
192.168.3.10-20 will not be able to use the
proxy server server3.domain.example.

Examples of the Proxy Configuration File, continued

Configure the PROXY_CFG_FILE Variable

1. Log on to the node as an administrator or root.

2. Create a new XML file with a text editor.

3. Add the following line in the beginning of the file:

<?xml version='1.0' encoding='UTF-8' standalone='yes'?>
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4. Add content to the file.

5. Save the file under the following directory:

On Windows

%ovdatadir%conf\bbc

On UNIX/Linux

/var/opt/OV/conf/bbc

6. Run the following command:

On Windows

%ovinstalldir%bin\ovconfchg -ns bbc.http -set PROXY_CFG_FILE <filename>.xml

On HP-UX, Linux, or Solaris

/opt/OV/bin/ovconfchg -ns bbc.http -set PROXY_CFG_FILE <filename>.xml

On AIX

/usr/lpp/OV/bin/ovconfchg -ns bbc.http -set PROXY_CFG_FILE <filename>.xml

Note: You can verify the configuration using bbcutil -gettarget <host name or IP address
of the node>.

Configuring the Communication Broker Port
By default, the HP Operations Agent nodes use the port 383 for inbound communication. The
Communication Broker component facilitates the inbound communication on every HP Operations
Agent server or node through the port 383.

You can configure a communication broker to listen on a port other than 383. If you do this, youmust
also configure the other management servers and nodes in the environment, so that their outbound
connections are destined for the correct port. For example, if you configure a node's communication
broker to listen on port 5000, youmust also configure themanagement server so that it connects to port
5000 when it communicates with this node.

PORTS Parameter Syntax

You configure communication broker ports by setting the PORTS parameter in the bbc.cb.ports
name space on all management servers and nodes that communicate with each other.

You can configure this parameter in the following ways:
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l Configure the values in the HP Operations Agent installation defaults in a profile file during
installation. This is recommended if you need to configure communication broker ports for large
numbers of nodes. Youmust plan and configure the installation defaults before you create or
migrate your nodes.

l Use ovconfchg at the command prompt.

The values must contain one or more host names or IP addresses and have the following format:

<host>:<port>[,<host>:<port>] ...

The <host> can be either a domain name or IP address. For example, if the communication broker port
is configured to run on port 5000 on amanagement server with the host name
manager1.domain.example.com, use the following command on themanagement server itself, and
also any other management servers and nodes that open connections to it:

ovconfchg -ns bbc.cb.ports -set PORTS manager1.domain.example.com:5000

If you need to configure communication broker ports onmultiple systems, you can use wildcards and
ranges, as follows:

You use a wildcard at the start of a domain name by adding an asterisk (*). For example:

*.test.example.com:5000

*.test.com:5001

*:5002

You can use wildcards at the end of an IP address by adding up to three asterisks (*). For example:

192.168.1.*:5003

192.168.*.*:5004

10.*.*.*:5005

You can replace one octet in an IP address with a range. The rangemust be before any wildcards. For
example:

192.168.1.0-127:5006

172.16-31.*.*:5007

If you specify multiple values for the PORTS parameter, separate each with a comma (,). For example:

ovconfchg -ns bbc.cb.ports -set PORTS *.test.example.com:5000,10.*.*.*:5005

When you specify multiple values using wildcards and ranges that overlap, themanagement server or
node selects the port to use in the following order:

n Fully qualified domain names

n Domain names with wildcards

n Complete IP addresses
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n IP addresses with ranges

n IP addresses with wildcards

Example

Youmust configure the HPOMmanagement environment for the following specification:

Configure all the systems within the domain *.test2.example.com to use the port 6000 for the
communication broker.

Configure all the systems with 10 as the first octet of the IP address (10.*.*.*) to use the port 6001 for
the communication broker with the following exception:

Configure all the systems where the second octet of the IP address is between 0 and 127 (10.0-127.*.*)
to use the port 6003 for the communication broker.

Configure the systemmanager1.test2.example.com to use the port 6002 for the communication broker.

To configure the HPOMmonitoring environment with the above specification, run the following
command:

ovconfchg -ns bbc.cb.ports -set PORTS
*.test2.example.com:6000,10.*.*.*:6001,manager1.test2.example.com:6002,10
.0-127.*.*:6003

The changes will take effect only if you run this command on all the agent nodes and all the HPOM
management servers in themonitoring environment.

To find out which port is currently configured, run the following command:

bbcutil -getcbport <host>

To configure the Communication Broker to use a non-default port

Note: Make sure to configure the Communication Broker on all HPOM servers and HP Operations
Agent nodes in your environment to use the same port.

1. Log on to the HP Operations Agent node.

2. Open a command prompt or shell.

3. Run the following command to set the Communication Broker port to a non-default value:

ovconfchg -ns bbc.cb.ports -set PORTS <host>:<port>[,<host>:<port>] ..

When you use the command ovconfchg on an HP Operations Agent node that runs in a cluster,
add the parameter -ovrg<server>, where <server> is the resource group.

4. Run the above command on all agent nodes and all management servers.

The communication broker is configured as follows:
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ovconfchg -ns bbc.cb.ports -set PORTS host1:483[,host2:583], where port 1 value is 483 and
port 2 is 583.

To update the port2 value from 583 to 683, run the following command:

ovconfchg -ns bbc.cb.ports -set PORTS host1:583[,host2:683]

To configure the communication broker to listen on a non-default port using the SERVER_
PORT variable

To configure the communication broker to listen on a non-default port, change the SERVER_PORT
variable value in the bbc.cb namespace.

Run the following command to set different values to the SERVER_PORT variable:

ovconfchg -ns bbc.cb -set SERVER_PORT <value>

In this instance, <value> is the value you want to assign to the SERVER_PORT variable.

Note:When you change the value of the SERVER_PORT variable, the communication broker
restarts automatically and listens on the specified new port value.

Configuring Local Communication Ports
By default, management servers and nodes use local port 0 for outbound connections, whichmeans
that the operating system allocates the local port for each connection. Typically, the operating system
will allocate local ports sequentially. For example if the operating system allocated local port 5055 to an
Internet browser, and then the HTTPS agent opens a connection, the HTTPS agent receives local port
5056.

However, if a firewall restricts the ports that you can use, you can configuremanagement servers and
nodes to use a specific range of local ports instead.

CLIENT_PORT Parameter Syntax

You configure local communication ports by setting the CLIENT_PORT parameter in the bbc.http
name space on themanagement server or node. You can configure this parameter in the following
ways:

l Configure the values in the HP Operations Agent installation defaults. For more information on the
profile file, see Installing HP Operations Agent using Profile File. This is recommended if you need
to configure local communication ports for large numbers of nodes. Youmust plan and configure the
installation defaults before you create or migrate your nodes.

l Use ovconfchg at the command prompt.

The valuemust be a range of ports in the following format:

<lower port number>-<higher port number>

There is no range defined for the port numbers. The rangemust support the number of outbound
connections at a given point of time.
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For example, if the firewall only allows outbound connections that originate from ports 5000 to 6000 you
would use the following value:

5000-6000

To configure local communication ports:

1. Log on to the HP Operations Agent node.

2. Open a command prompt or shell.

3. Specify the range of local ports that themanagement server or node can use for outbound
connections by typing the following command:

ovconfchg -ns bbc.http -set CLIENT_PORT 5000 - 6000

When you use the command ovconfchg on amanagement server that runs in a cluster, add the
parameter -ovrg <server>.

Configuring Nodes with Multiple IP Addresses
If the node has multiple IP addresses, the agent uses the following addresses for communication:

The communication broker accepts incoming connections on all IP addresses.

The agent opens connections to themanagement server using the first network interface that it finds
through theOS provided libraries.

To communicate with HP Reporter or HP PerformanceManager, the communication daemon (CODA)
accepts incoming connections on all IP addresses.

To configure the HP Operations Agent to use a specific IP address:

1. Log on to the HP Operations Agent node.

2. Open a command prompt or shell.

3. Run the following command to set the IP address for the Communication Broker:

ovconfchg -ns bbc.cb SERVER_BIND_ADDR <ip_address>

4. Run the following command to set the IP address that you want the agent to use while opening
outbound connections to themanagement server:

ovconfchg -ns bbc.http CLIENT_BIND_ADDR <ip_address>

5. Run the following command to set the IP address that you want to use for incoming connections
from HP PerformanceManager or HP Reporter:

ovconfchg -ns coda.comm SERVER_BIND_ADDR <ip_address>
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Note: See "Overview of Node Resolution" in theHP Operations Agent User Guide for more
information on node name resolution.

Configuring HTTPS Communication through Proxies
If your network allows only certain proxy systems to open connections through the firewall, you can
redirect HPOM communication through these proxies. The following list presents the workflow of the
management server and agent communication with this configuration:

1. Themanagement server opens connections to the proxy.

2. The proxy opens connections to the node on behalf of themanagement server, and forwards
communication between them.

3. The node opens connections to the proxy.

4. The proxy opens connections to themanagement server on behalf of the node.

To redirect the communication through proxies:

1. Log on to themanagement server or node with the root or administrative privileges.

2. Run the following command at the command prompt:

ovconfchg -ns bbc.http -set PROXY <proxy>: <port>

In this instance, <proxy> is the IP address or FQDN of the proxy server; <port> is the communication
port of the proxy server.

Note:When you use the command ovconfchg on amanagement server that runs in a cluster, add
the parameter -ovrg <server>.

Communication in a Highly Secure Environment
In a firewall-controlled, secure environment, systems that are present within the trusted zone can freely
communicate and exchange information with one another. However, specific firewall settings can
restrict communication with the systems that belong outside the trusted zone. The untrusted network,
also known as the demilitarized zone (DMZ), may not send data to the trusted zone due to restrictions
in firewall settings.

In many deployment scenarios, the HPOMmanagement server may reside in the trusted zone and
managed nodes may reside in the DMZ. If the firewall is configured to prevent the systems in the DMZ
from communicating with the systems in the trusted zone, server-agent communication will become
impossible.
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In the following scenario, managed nodes are located in the DMZ while themanagement server
belongs to the trusted zone. The firewall settings in this example allow outbound-only communication.
Therefore, inbound communication to themanagement server is blocked by the firewall.

Managed Nodes in the DMZ

In the following scenario, managed nodes are located in the trusted zone while themanagement server
belongs to the DMZ. The firewall settings in this example allow outbound-only communication from the
node to the HPOMmanagement server, but block the inbound communication to node.

HPOMManagement Server in the DMZ
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Introduction to the Reverse Channel Proxy
One simple solution to enable bidirectional communication is to configure the firewall settings to allow
inbound traffic to the port 383 (the Communication Broker port). However, this canmake your system
vulnerable to external attacks. To enable secure communication without allowing inbound traffic to the
Communication Broker port, youmust configure a reverse channel proxy (RCP).

Note: OnWindows, after agent installation, the firewall configuration changes whenHP Software
HTTP Communication Broker is added to the firewall inbound rules.

Systems belonging to the DMZ open connection to the RCP instead of the system inside the trusted
zone. You can configure the system in the trusted zone to open an outbound communication channel—
the reverse administration channel—to the RCP. The system in the trusted zonemaintains the
outbound channel; systems in the DMZ uses the reverse administration channel to send details to the
trusted zone by using the RCP.

When the nodes are located in the DMZ and themanagement server in the trusted zone, the HPOM
setup uses the following workflow:

1. The RCP is configured on a node in the DMZ.

2. All the nodes in the DMZ open connections to the RCP.
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3. Themanagement server opens an outbound connection to the RCP and establishes a reverse
administration channel. The reverse administration channel allows themanagement server to
accept inbound data originating from the RCP without any involvement of additional ports.

4. All nodes from the DMZ communicate to the HPOMmanagement server through the reverse
administration channel.

Secure Communication through the RCP with Nodes in the DMZ

When the nodes are located in the trusted zone and themanagement server in the DMZ, the HPOM
setup uses the following workflow:

1. The RCP is configured on themanagement server in the DMZ.

2. The nodes opens outbound connections to the RCP and establishes reverse administration
channels. The reverse administration channels allow the nodes to accept inbound data originating
from the RCP without any involvement of additional ports.

3. Themanagement server in the DMZ communicates to the nodes through the reverse
administration channel.

Secure Communication through the RCP with theManagement Server in the DMZ

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 150 of 197



Configure Secure Communication in an Outbound-Only
Environment
To configure secure communication with the help of the RCP and reverse administration channel in an
outbound-only environment, perform the following tasks:

Configure an RCP

Before you configure RCP, youmust configure the node’s certificate.

To configure an RCP:

1. Log on to the node or themanagement server (depending on their location on the network) as a
user with the administrative or root privileges.

2. Open a command prompt or shell.

3. Run the following command:

ovconfchg -ns bbc.rcp -set SERVER_PORT <port_number>

In this instance, <port_number> is the port that will be used by the RCP. Make sure the specified
port is not used by another application.

4. OnUNIX/Linux only. The Communication Broker (ovbbccb) runs with /var/opt/OV as the root
directory. The configuration files that are necessary to open Transmission Control Protocol (TCP)
connections are present in the /etc directory. This prevents ovbbccb from creating connections
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to the RCP. To resolve this problem, follow the steps:
a. Create the directory named etc under /var/opt/OV

b. Copy the relevant configuration files (for example, files such as resolv.conf, hosts,
nsswitch.conf) from /etc to /var/opt/OV/etc.

c. Alternatively, you can also disable the ovbbccb chroot feature by running the following
command. This method resolves the problem of preventing ovbbccb from creating
connections to the RCP.

ovconfchg -ns bbc.cb -set CHROOT_PATH /

5. Register the RCP component so that ovc starts, stops andmonitors it. Type the following
commands:

ovcreg -add <install_dir>/newconfig/DataDir/conf/bbc/ovbbcrcp.xml

ovc -kill

ovc -start

Configure a Reverse Administration Channel

With the help of the RCPs that you created, youmust configure a reverse administration channel to
facilitate the inbound communication in an outbound-only firewall environment. To configure a reverse
administration channel when HPOM is in HA cluster, follow these steps:

1. Log on to the node or themanagement server (depending on their location on the network) as a
user with the administrative or root privileges.

2. Open a command prompt or shell.

3. Run the following command to create the reverse administration channel:

ovconfchg [-ovrg<server>] -ns bbc.cb -set ENABLE_REVERSE_ADMIN_CHANNELS true

4. Run the following commands to specify the RCP details:

ovconfchg [-ovrg<server>] -ns bbc.cb -set RC_CHANNELS <rcp>:<port>[,<OvCoreId>]
[;<rcp2>...]

ovconfchg [-ovrg<server>] -ns bbc.cb -set PROXY <rcp>:<port>[,<OvCoreId>]
[;<rcp2>...]

In this instance,

<rcp>: FQDN or IP address of the system where the RCP is configured.

<port>: The port number configured for the RCP (the port specified for the SERVER_PORT
variable)
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<OvCoreID>: The core ID of the system where you configured the RCP.

Alternatively, you can provide the RCP details by using a configuration file.

5. Optional. Configure the server to automatically restore failed reverse administration channel
connections. By default, the server does not restore failed connections. To change the default, run
the following command:

ovconfchg [-ovrg<server>] -ns bbc.cb -set RETRY_RC_FAILED_CONNECTION TRUE

6. Optional. Set themaximum number of attempts that the server shouldmake to connect to an
RCP. By default, this is set to -1 (infinite). To change the default, run the following command:

ovconfchg [-ovrg<server>] -ns bbc.cb -set MAX_RECONNECT_TRIES<number of tries>

7. Optional. Configure themanagement server to generate a warningmessage when a reverse
administration channel connection fails. By default, themanagement server does not generate the
failuremessage. To change the default, run the following command:

ovconfchg [-ovrg <server>] -ns bbc.cb -set RC_ENABLE_FAILED_OVEVENT TRUE

If you set RETRY_RC_FAILED_CONNECTION to TRUE, themanagement server does not
generate themessage.

8. Optional. To check that the reverse administration channel is open, run the following command:

ovbbccb -status

The output lists all open reverse administration channels.

9. Optional. To restore a failed reverse administration channel, run the following command:

ovbbccb -retryfailedrcp [-ovrg<server>]

Performance Considerations for the Reverse Administration Channel

The performance of a reverse administration channel may depend on the number of nodes connected to
the channel. The RC_MAX_WORKER_THREADS variable helps you tune the performance of a
reverse administration channel.

To use the RC_MAX_WORKER_THREADS variable:

1. Log on to the node that establishes the reverse administration channel.

2. Note down the time taken by the agent to establish the channel. You can determine this by running
the ovbbccb -status command. The ovbbccb -status command output shows the status of
reverse administration channels originating from the system. By running the ovbbccb -status
command repeatedly, you can determine the approximate time taken by the agent to establish the
channel.
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3. Calculate the ratio of the desired time to establish the channel and the approximate actual time
taken by the agent to establish the channel.

4. Set theRC_MAX_WORKER_THREADS variable to the next higher integer to the ratio. Use the
following command to set this variable:

ovconfchg -ns bbc.cb -set RC_MAX_WORKER_THREADS <Maximum_Threads>

Example

Themanagement server or agent node establishes a reverse administration channel to 20 RCP
nodes. When the ovbbccb -status command is run, the approximate time is derived as 10
seconds (without any RC_MAX_WORKER_THREADS value set). If the required time is 5
seconds, then set RC_MAX_WORKER_THREADS to actual_time/desired_time.

In this scenario:

Actual Time/Desired Time = 10/5 = 2

Set the value for the command:

ovconfchg -ns bbc.cb -set RC_MAX_WORKER_THREADS 2

If the RC_MAX_WORKER_THREADS value exceeds the number of RCP nodes, then theremay
not be any performance improvement.

Specify the RCP Details with a Configuration File
With the help of a configuration file, you can specify the details of the RCPs. To use the configuration
file, follow these steps:

1. Create a text file.

2. Specify the details of each RCP in a new line in the following format:

<rcp>:<port>[,<OvCoreId>]

In this instance,

<rcp>: FQDN or IP address of the system where the RCP is configured.

<port>: The port number configured for the RCP (the port specified for the SERVER_PORT
variable.

<OvCoreID>: The core ID of the system where you configured the RCP.

3. Save the file in the following location:

<data_dir>/conf/bbc

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 154 of 197



If you are performing this step on amanagement server in a high-availability cluster or in a server
pooling setup, save the file in the following location:

<data_dir>/shared/<server>/conf/bbc

4. Run the following command:

ovconfchg [-ovrg<server>] -ns bbc.cb -set RC_CHANNELS_CFG_FILES <file_name>

In this instance,

<file_name>: Name of the file created.

<server>: Name of the resource group of the cluster or server pooling setup.

Configure an RCP for Multiple Systems
You can configure only one RCP in the DMZ, and then configure other systems in the DMZ to use the
RCP. To achieve this, youmust set the PROXY variable of all the systems in the DMZ to the IP
address (or FQDN) and port of the system that hosts the RCP. To configuremultiple systems to use a
single RCP, follow these steps:

1. Log on to the node with the root or administrative privileges.

2. Open a command prompt (shell).

3. Run the following command:

ovconfchg -ns bbc.http -set PROXY “<rcp>:<port>+<included_hosts>-<excluded_hosts>”

In this instance,

<rcp>: FQDN or IP address of the system where the RCP is configured.

<port>: The port number configured for the RCP (the port specified for the SERVER_PORT
variable

<included_hosts>: Specify the FQDN or IP address of the system that opens a reverse
administration channel to the RCP. In this scenario, youmust specify the FQDN or IP address of
themanagement server that belongs to the trusted zone. If you want to usemultiple management
servers, you can specify multiple FQDNs separated by commas.

<excluded_hosts>: Specify the FQDN or IP address of the systems that need not be contacted
through the RCP. You can specify multiple FQDNs separated by commas. Youmust, however,
specify the local system’s FQDN and hostname (separated by commas). For example,
ovconfchg -ns bbc.http -set PROXY “<rcp>:<port>-
<localhost>,<localhost>.domain.com”

4. If the system is an HP Operations Agent node, run the following command to restart themessage
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agent:

ovc -restart opcmsga

Repeat step 3 and 4 on all the systems in the DMZ.

Performance Considerations for the RCP

If you configure an RCP for only one system, meeting theminimum requirements for an agent system
is sufficient.

If you configure an RCP that will be used by multiple agent nodes, youmust make sure that the RCP
system will be able to service all incoming requests without significant time delay.

Verify the Communication through the RCPs
After configuring the RCPs and establishing a reverse administration channel, you can perform the
following tasks to verify if the server-node communications is established successfully:

Verify the Communication to the RCP

To verify that the system in the DMZ can communicate with the RCP, follow these steps:

1. Log on to the system in the DMZ with the root or administrative privileges.

2. Open a command prompt (shell).

3. Run the following command:

bbcutil -gettarget <FQDN>

In this instance, <FQDN> is the FQDN of the system that establishes the reverse administration
channel to the RCP. If themanagement server is located in the trusted zone, specify the FQDN of the
management server.

If the RCP was successfully created, the output should display the followingmessage:

HTTP Proxy: <rcp>:<port>

In this instance,

<rcp>: FQDN or IP address of the system where the RCP is configured.

<port>: The port number configured for the RCP (the port specified for the SERVER_PORT variable

Check the Reverse Administration Channel

To verify that the reverse administration channel is correctly established, follow these steps:

1. Log on to the system in the trusted zone with the root or administrative privileges.

2. Open a command prompt (shell).

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 156 of 197



3. Run the following command:

ovbbccb –status

If the channels are established correctly, the output should display the followingmessage:

HTTP Communication Reverse Channel Connections

Opened:

system1.mydomain.com:1025 BBC 11.00.000; ovbbcrcp 11.00.000

system2.mydomain.com:1025 BBC 11.00.000; ovbbcrcp 11.00.000

system3.mydomain.com:1025 BBC 11.00.000; ovbbcrcp 11.00.000

system4.mydomain.com:1025 BBC 11.00.000; ovbbcrcp 11.00.000

In this example, the system has established reverse administration channels to the following RCP
systems: system1, system2, system3, and system4.

If the reverse administration channel to an RCP fails, the ovbbccb –status command displays the
status in the following format:

Pending:

system5.mydomain.com:1025 Connection To Host Failed

Communication through Two Firewalls
In certain cases, themanagement environment is set up with two different firewalls; themanagement
server resides behind one firewall and the node group resides behind another firewall.

Secure Communication with Two Firewalls
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In this scenario, youmust install the agent on a system in the intermediate zone (zone 2) and configure
the RCP on the system. After you configure the nodes in the zone 3 and themanagement server in the
zone 1 to establish reverse administration channels to the RCP, server-node bidirectional
communication takes place through the RCP.

To configure secure bidirectional communication in this scenario, follow these steps:

1. Install the agent on a node in the zone 2.

2. Configure an RCP on the node in the zone 2.

3. Configure the reverse administration channel from themanagement server to the RCP.

4. Configure reverse administration channels from the nodes in the zone 3 to the RCP.
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Chapter 19: Configuring the Performance Collection
Component Remotely
You can perform certain configuration tasks on themanaged node remotely from themanagement
server. Instead of performing the configuration tasks for the Performance Collection Component locally
on every node, you can use a special set of policies and tools from the HPOM console to configure and
work with the Performance Collection Component multiple nodes.

This feature is available only if you install the HP Operations Agent deployment package on the HPOM
forWindows or HPOM onUNIX/Linux management servers.

Before You Begin
Before you begin configuring and controlling the Performance Collection Component remotely from the
HPOM console, youmust deploy the instrumentation files in the HP Operations Agent instrumentation
group on the nodes where the agent is running.

To deploy the instrumentation from the HPOM forWindows console, follow these steps:

Note: If youmonitor cluster nodes, make sure you deploy the instrumentation on all the nodes that
constitute the cluster and not on the virtual node

1. In the console tree, right-click the node or the node group (where the agent is running), and then
click All Tasks > Deploy Instrumentation. The Deploy Instrumentation dialog box opens.

2. In the Deploy Instrumentation dialog box, click HP Operations Agent, and then click OK. The
deployment of the necessary instrumentation files begins on the nodes.

To deploy the instrumentation from HPOM onUNIX/Linux Console, follow these steps:

Note: If youmonitor cluster nodes, make sure you deploy the instrumentation on all the nodes that
constitute the cluster and not on the virtual node

1. Log on to the Administration UI.

2. Click Deployment > Deploy Configuration.

3. In the Distribution Parameters section, select Instrumentation, and then click Please Select.
TheSelector pop-up box opens.

4. In theSelector pop-up box, select the nodes where the agent program is running.

5. Select the Force Update option to overwrite the old instrumentation files.
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Select this option on a node that was upgraded from an older version of the agent.

6. Click Distribute.

Deploy the OA-PerfCollComp-opcmsg Policy
TheOA-PerfCollComp-opcmsg policy sends the alert messages to the HPOMmessage browser when
the Performance Collection Component generates alarms. The policy is located in theHP Operations
Agent > Performance Collection Component > Message Interceptor policy group. Before
deploying other policies for the Performance Collection Component, deploy this policy on the nodes.

Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node.

Configuring the Performance Collection Component
The behavior of the Performance Collection Component of the HP Operations Agent depends on the
configuration settings specified in the following files:

l Collection parameter file (parm)

l Alarm definition file (alarmdef)

See thePerformance Collection Component section in theHP Operations Agent Concepts Guide for
more information on the collection parameter and alarm definition files.

Configure the parm File
The parm file defines the data collectionmechanism of the oacore collector. The HP Operations Agent
deploys a parm file on every node, which is available in the following path:

On HP-UX, Solaris, AIX, and Linux: /var/opt/perf

OnWindows:%ovdatadir%

You canmodify the settings specified in the parm file to customize the data collectionmechanism.
However, if youmanage a large number of nodes with the HP Operations Agent, it becomes difficult to
modify every single copy of the parm file on every node.

With the help of the HPOM console, you can deploy themodified parm file onmultiple node centrally
from themanagement server.
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From HPOM for Windows
The HPOM forWindows console provides you with ConfigFile policies which help you deploy any
changes to the parm file across multiple nodes from the central management server. Different
ConfigFile policies are available for different node operating systems.

Tomodify the collectionmechanism by editing the parm file, follow these steps:

1. Identify the nodes where you want themodified collectionmechanism to take effect.

2. In the console tree, click Policy management > Policy groups > HP Operations Agent >
Performance Collection Component > Collection configuration. ConfigFile policies for
configuring the parm file appear in the details pane.

3. Double-click the ConfigFile policy for the platform on which you want themodified collection
mechanism to take effect (for example: parm file for HP-UX). The parm file for <platform> dialog
box opens.

4. In the Data tab, modify the settings. See the parm File Parameters section in theHP Operations
Agent User Guide for more details on configuration parameters in the parm file.

5. Click Save and Close. In the details pane, the version of the policy gets increased by.1.

6. Deploy the updated policy on the nodes of your choice.

Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node

From HPOM on UNIX/Linux 9.10
The HPOM onUNIX/Linux 9.10 console provides you with ConfigFile policies which help you deploy
any changes to the parm file across multiple nodes from the central management server. Different
ConfigFile policies are available for different node operating systems.

Tomodify the collectionmechanism by editing the parm file from the HPOM for UNIX 9.10 console,
follow these steps:

1. Identify the nodes where you want themodified collectionmechanism to take effect.

2. In the console, click Browse > All Policy Groups. The list of all available policy groups appears
on the page.

3. Click H. The HP Operations Agent policy group appears.
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4. Click HP Operations Agent, click Performance Collection Component, and then click
Collection Configuration. The list of available ConfigFile policies for the parm file appears.

5. Click the ConfigFile policy for the platform on which you want themodified collectionmechanism
to take effect. The Policy “OA_<platform>ParmPolicy” page appears.

6. Click , and then click Edit (Raw Mode). The Edit Config File policy... page appears.

7. In the Content tab, modify the settings

See the parm File Parameters section in theHP Operations Agent User Guide for more details on
configuration parameters in the parm file.

8. Click Save.

9. Deploy the updated policy on the nodes of your choice.

Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node

Configure the alarmdef File
The alarm definition file (alarmdef) provides the performance subagent with the default specification for
the alarm generation process. The HP Operations Agent deploys an alarmdef file on every node, which
is available in the following path:

On HP-UX, Solaris, AIX, and Linux: /var/opt/perf/

On Windows: %ovdatadir%

You canmodify the default settings in the alarmdef file to customize the alarm generationmechanism.
You can use the HPOM console to centrally distribute themodified alarmdef file onmultiple nodes.

From HPOM for Windows
The HPOM forWindows console provides you with ConfigFile policies which help you deploy any
changes to the alarmdef file across multiple nodes from the central management server. Different
ConfigFile policies are available for different node operating systems.

Tomodify the collectionmechanism by editing the alarmdef file, follow these steps:

Identify the nodes where you want themodified collectionmechanism to take effect.

1. In the console tree, click Policy management > Policy groups > HP Operations Agent >
Performance Collection Component > Alarm definition. ConfigFile policies for configuring
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the alarmdef file appear in the details pane.

2. Double-click the ConfigFile policy for the platform on which you want themodified collection
mechanism to take effect (for example: Alarmdef file for HP-UX). The Alarmdef file for <platform>
dialog box opens.

3. In the Data tab, modify the settings. See the alarmdef File Parameters section in theHP
Operations Agent User Guide for more details on configuration parameters in the alarmdef file.

4. Click Save and Close. In the details pane, the version of the policy gets increased by.1.

5. Deploy the updated policy on the nodes of your choice.

Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node

From HPOM on UNIX/Linux 9.10
The HPOM onUNIX/Linux 9.10 console provides you with ConfigFile policies which help you deploy
any changes to the alarmdef file across multiple nodes from the central management server. Different
ConfigFile policies are available for different node operating systems.

Tomodify the collectionmechanism by editing the alarmdef file from the HPOM for UNIX 9.10
console, follow these steps:

1. Identify the nodes where you want themodified alert mechanism to take effect.

2. In the console, click Browse > All Policy Groups. The list of all available policy groups appears
on the page.

3. Click H. The HP Operations Agent policy group appears.

4. Click HP Operations Agent, click Performance Collection Component, and then click Alarm
Definition. The list of available ConfigFile policies for the alarmdef file appears.

5. Click the ConfigFile policy for the platform on which you want themodified collectionmechanism
to take effect. The Policy “OA_<platform>AlarmdefPolicy” page appears.

6. Click , and then click Edit (Raw Mode). The Edit Config File policy... page appears.

7. In the Content tab, modify the settings. See the alarmdef File Parameters section in theHP
Operations Agent User Guide for more details on configuration parameters in the alarmdef file.

8. Click Save.

9. Deploy the updated policy on the nodes of your choice.
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Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node

Remotely Working with the HP Operations Agent
You can use the HPOM console to start, stop, monitor, and view the details of the HP Operations
Agent. From the HPOM console, you can use different tools to manage the operation of the HP
Operations Agent. Youmust launch these tools on the nodes where the agent is deployed. The result of
running a tool is displayed in the following section:

HPOM forWindows

Tool Output section in the Tool Status window

HPOM onUNIX/Linux

In the Application Output window in the JavaGUI (HPOM for UNIX Operational UI)

You can use the following tools from the HPOM console:

Tool Description

Start Agent Enables you to start the HP Operations Agent on themanaged node.

Stop Agent Enables you to stop the HP Operations Agent on themanaged node.

Restart Agent Enables you to restart the HP Operations Agent on themanaged node.

View Status Enables you to view the status of the HP Operations Agent process,
services, and daemons on themanaged node.

View Version
Information

Enables you to view the version of the HP Operations Agent on the
managed node.

Refresh Alarm
Service

Refreshes the Alarm service of the Performance Collection Component.

Scan Performance
Component’s Log
Files

Scans the log files used by the scope collector on the node.

Check Performance
Component’s
Parameter File
Syntax

Helps you check the syntax of the parameter file in themanaged node.

Check Performance
Component’s
Alarmdef File Syntax

Helps you check the syntax of the alarmdef file in themanaged node.
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View status of post
policy deploy action

Helps you check the status of deployment of the parm or alarmdef policies
on nodes. While launching this tool, make sure to specify either parm or
alarmdef (as appropriate) as the tool parameter.

You can set the tool parameter in the Parameter box in the Edit Parameters
window when you use HPOM forWindows.

When you use HPOM onUNIX/Linux, open the Edit Tool Status page for
the tool, go to the OVOTool tab, and then specify the tool parameter in the
Parameters box

Set Realtime
Permanent License

Sets the permanent license for the HP Ops OS Inst to Realtime Inst LTU.

Set Glance
Permanent License

Sets the permanent license for the Glance Software LTU.

Get License Status Shows the status of LTUs on the node.
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Chapter 20: Monitoring the HP Operations Agent
The HP Operations Agent deployment package provides you with a set of policies tomonitor the health
of the HP Operations Agent. With the help of these policies, you canmake sure that necessary agent
processes are not stopped.

When you install the HP Operations Agent deployment package on the HPOMmanagement server, the
Self Monitoring policy group is created. TheSelf Monitoring policy group includes the policies that
you need to ensure a smooth functioning of the HP Operations Agent.

Note: TheSelf Monitoring policy group and the policies tomonitor the health of HP Operations
Agent processes are available only if you install the HP Operations Agent deployment package on
the HPOM forWindows or HPOM onUNIX/Linux management servers.

Before You Begin
Before you beginmonitoring the HP Operations Agent with theSelf Monitoring policies, youmust
deploy the instrumentation files in the HP Operations Agent instrumentation group on the nodes where
the agent is running.

To deploy the instrumentation from the HPOM forWindows console, follow these steps:

Note: If youmonitor cluster nodes, make sure you deploy the instrumentation on all the nodes that
constitute the cluster and not on the virtual node.

1. In the console tree, right-click the node or the node group (where the agent is running), and then
click All Tasks > Deploy Instrumentation. TheDeploy Instrumentation dialog box opens.

2. In theDeploy Instrumentation dialog box, click HP Operations Agent, and then click OK. The
deployment of the necessary instrumentation files begins on the nodes.

To deploy the instrumentation on HPOM for UNIX/Linux:

Note: If youmonitor cluster nodes, make sure you deploy the instrumentation on all the nodes that
constitute the cluster and not on the virtual node.

1. Log on to the Administration UI.

2. Click Deployment > Deploy Configuration.

3. In theDistribution Parameters section, select Instrumentation, and then click Please Select.
TheSelector pop-up box opens.

4. In theSelector pop-up box, select the nodes where the agent program is running.
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5. Select the Force Update option to overwrite the old instrumentation files (Select this option on a
node that was upgraded from an older version of the agent.).

6. Click Distribute.

Self Monitoring Policies
You canmonitor the health of the following components of the HP Operations Agent by using the Self
Monitoring policies:

l opcmona (monitor agent)

l opcmsga (message agent)

l opcmsgi (message interceptor)

l opcacta (action agent)

l oacore (data collector)

l opcle (logfile encapsulator)

l opctrapi (trap interceptor)

l coda (communication daemon)

l perfd

The Self Monitoring policy group includes the following policies:

l OA-SelfMonTstMonaExt: Tests themonitor agent.

l OA-SelfMonVerifyMon:Verifies flag files by themonitor agent

l OA-SelfMonTstLe: Tests the logfile encapsulator

l OA-SelfMonVerifyLe: Verifies flag files by the logfile encapsulator

l OA-SelfMonTstTrapi: Tests the SNMP trap interceptor

l OA-SelfMonTstMsgi: Tests themessage interceptor

l OA-SelfMonTstActa: Tests the action agent

l OA-SelfMonTstAll: Tests all the processes other than opcle, opcmona, opcmsgi, and opctrapi.

Tomonitor the health and availability of the opctrapi component, the SNMP Trap daemon/service
must be running on the node.
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The scripts and programs deployed with the HP Operations Agent instrumentation group send test
values (once every minute) to different components of the HP Operations Agent. Also, the flag files
are created for every monitored component. When amonitored component successfully receives the
test value originating from the HP Operations Agent instrumentation scripts, the corresponding flag file
is updated with the time stamp.

The verify script of the HP Operations Agent instrumentation constantly (once in three minutes)
monitors the states of the flag files. When the script finds that the time stamp in the flag file is older
than the current time, whichmeans themonitored component failed to receive the test value, an alert
message is sent to the HPOMmessage browser.

Workflow of the Self Monitoring Scripts

Deploying the Self Monitoring Policies
You cannot selectively deploy the policies available in the Self Monitoring policy group. These policies
are dependent on one another, and therefore, all the policies must be deployed at the same time on the
node.

To deploy the Self Monitoring policies from the HPOM forWindows console, follow these steps:
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1. In the console tree of the HPOM console, expandPolicy management > Policy groups > HP
Operations Agent.

2. Right-click Self Monitoring, and then click All Tasks > Deploy on. The Deploy Policies on
dialog box opens.

3. In the Deploy Policies on dialog box, select the nodes, and then click OK. HPOM starts deploying
the Self Monitoring policies on the selected nodes.

Note: If youmonitor cluster nodes, make sure you deploy the policies on all the nodes that
constitute the cluster and not on the virtual node.

To deploy the Self Monitoring policies from the HPOM onUNIX/Linux console, follow these steps:

1. Log on to the Administration UI.

2. Click OMU, and then click Browse > All Policy Groups. TheAll Policy Groups page opens.

3. On theAll Policy Groups page, select HP Operations Agent policy group, select Assign to

Node/ Group from theChoose an Action drop-down list, and then click . TheSelector pop-
up box opens.

4. In theSelector pop-up box, select the nodes where the agent program is running, and then click
OK.

Note: If youmonitor cluster nodes, make sure you deploy the policy on all the nodes that
constitute the cluster and not on the virtual node

Viewing the Status of the Components
The Self Monitoring policies trigger the agent to send appropriate alert messages to the HPOM
message browser when they detect failure in one of the components. Themessages that originate from
the Self Monitoring policies always have the prefix Self Monitor. You can open themessages with the
Self Monitor prefix to view the details of failures.

Alternatively, you can check the flag files on the node to check if the agent components are operative.
The flag files are available in the following locations:

On Windows

%ovdatadir%tmp\OpC\selfmon

On UNIX/Linux

/var/opt/OV/tmp/selfmon
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You can open the flag files with a text editor program and check the last time stamp. If the last time
stamp is older than threeminutes, you can conclude that themonitored component is not functioning.
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Chapter 21: Configuring Certificates for the HP
Operations Agent and Infrastructure SPIs
Certificates must be installed on all managed nodes to facilitate network communication using the
Secure Socket Layer (SSL) protocol with encryption. Certificates enable the nodes to communicate
securely with themanagement server and other nodes.

Themanagement server issues certificates to nodes and acts as the certificate authority. Each
managed node needs the following certificates from themanagement server:

A unique node certificate. The node can identify itself to its management server and other nodes by
sending them its node certificate.

A copy of the management server's trusted certificate. A node only allows communication from a
management server if it has the trusted certificate for that management server.

In an environment with multiple management servers, a copy of the trusted certificates for all other
management servers must be present on the node.

To enable the nodes to communicate securely in the HPOM-managed environment by using
certificates, youmust install certificates after you install the agent on the nodes.

Request Certificates Automatically
When you deploy the agent to a node from the HPOM console, the node requests certificates
automatically from themanagement server. The node encrypts the certificate request with a key.

Themanagement server then grants the certificate request. You can configure this to take place
automatically. After granting the request, themanagement server sends the certificates to the node. If
themanagement server denies the certificate request, you can send another request by running the
following command on themanaged node:

ovcert -certreq

After themanagement server grants the certificate request, run the following command on agent nodes
that reside in high availability clusters:

ovc -restart ovconfd

In a highly secure environment, you can disable automatic certificate requests by setting the certificate
deployment type tomanual. You thenmust request the certificates with installation key or deploy the
certificates manually.

Request Certificates with an Installation Key
To encrypt certificate requests, you can use installation keys. You can generate an installation key on
themanagement server, and then transfer it to the node.
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Before you request certificates with an installation key, make sure that the Operations Agent is running
on the node. The agent sends a certificate request at the time of start. If you then request a certificate
with an installation key, the new certificate request overwrites the original certificate request on the
management server. You can suppress the first certificate request by setting the parameter
CERTIFICATE_DEPLOYMENT_TYPE tomanual in the sec.cm.client namespace by using the agent
installation defaults in the profile file or by using the ovconfchg utility. For more information on the
profile file, see Installing HP Operations Agent using Profile File.

To request certificates with an installation key:

1. Log on to themanagement server with an account that belongs to the HPOM administrators group.

2. Open a command prompt (shell).

3. Run the following command:

From HPOM for Windows

ovowcsacm -genInstKey [-file <file_name>] [-pass <password>]

From HPOM for UNIX/Linux

opccsacm -genInstKey [-file <file_name>] [-pass <password>]

In this instance:

<file_name>: The name of the installation key file.

<password>: You need this password when you later request the certificates from the node. You
can omit this option.

The command generates an installation key.

Note: Specify the complete path with <file_name>; otherwise, the certificate is stored in the
current working directory. If you do not specify the -file option, the certificate is stored in
<data_dir>\shared\server\certificates.

4. Securely transfer the generated file to the node. The installation key is valid for any node.

5. Log on to the node with the account used to install the node.

6. Open a command prompt (shell).

7. On UNIX/Linux nodes, make sure that the PATH variable contains the path to the <install_
dir>/bin directory.

8. Run the following command:

ovcert -certreq -instkey <file_name>
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Themanagement server must grant the request. You can configure this to take place automatically or
manually. After that, themanagement server sends the certificates to the node.

On agent nodes that reside in high availability clusters, run the following command:

ovc -restart ovconfd

Deploy Certificates Manually
The node can automatically send certificate requests to themanagement server. If you want to install
the certificates on the nodemanually, you can set the CERTIFICATE_DEPLOYMENT_TYPE variable
(in the sec.cm.client namespace) on the node toMANUAL.

To deploy certificates manually:

1. Log on to themanagement server with an account that belongs to the HPOM administrators group.

2. Open a command prompt (shell).

3. Make sure the node is added to the list of managed nodes in the HPOM console.

4. Run the following command:

On HPOM for Windows

ovowcsacm -issue -name <node_name> [-file <file_name>] [-coreid <OvCoreId>] [-
pass <password>]

On HPOM for UNIX

opccsacm -issue -file <file_name> [-pass <password>] -name <node_name> [-coreid
<OvCoreId>]

Note: Specify the complete path with <file_name>; otherwise, the certificate is stored in the
current working directory. If you do not specify the -file option, the certificate is stored in
<data_dir>\shared\server\certificates.

In this instance,

<node_name>: FQDN or IP address of the node.

<OvCoreId>: The core ID of the node. To retrieve the core ID of the node where the agent is
already installed, perform the following step on themanagement server:

On HPOM for UNIX/Linux

Run the following command:

opcnode -list_id node_list=<node_name>

On HPOM for Windows
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In the console tree, right-click the node, and then click Properties. The node properties dialog box
opens. In the node properties dialog box, go to the General tab, click Advanced Configuration.
The Advanced Configuration dialog box opens, which shows the core ID for the node.

<file_name>: The name of the certificate file generated by the command. If you do not specify this
option, the command creates a file into the following directory with the default name <node_name>-
<OvCoreId>.p12:

On HPOM for UNIX/Linux

/var/opt/OV/temp/OpC/certificates

On HPOM for Windows

%OvShareDir%server\certificates

5. Securely transfer the generated file to the node. The installation key is valid for any node.

6. Install the agent on the node if not already installed. Use a profile file-based installation and set the
CERTIFICATE_DEPLOYMENT_TYPE variable to manual. For more information on the profile
file, see Installing HP Operations Agent using Profile File. Also, use the sameOvCoreID that was
generated on themanagement server (set the CERTIFICATE_SERVER_ID in the sec.cm.client
namespace to the ID generated on themanagement server). For more information about preparing
a profile file, see Installing HP Operations Agent using Profile File.

7. Open a command prompt (shell) on the node.

8. If the agent is running on the node, run the following command:

ovc -stop

9. To import the certificates from the generated file, run the following command:

ovcert -importcert -file <file_name>

10. Run the following command on the node:

ovc -start

After importing certificates, run the following command on agent nodes that reside in high availability
clusters:

ovc -restart ovconfd

Restore Certificates
If you lose the certificates on a node, you will have to create them again. If you back up the existing
certificates into a file, you can restore them in the event of certificate failure. To back up certificates,
follow these steps:
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1. Log on to the node with the root or administrative privileges.

2. Open a command prompt (shell).

3. Run the following command:

ovcm -exportcacert -file <file_name> [-pass <password>]

The command backs up themanagement server certificate in the file specified with the -file option.

4. Run the following command:

ovcert -exporttrusted [-ovrg <server>] -file <file_name>

In this instance, <server> is the HA resource group name if themanagement server is installed in
an HA cluster.

The command backs up themanagement server’s trusted certificate in the file specified with the -
file option.

5. Determine the alias of the node certificate by running the following command:

ovcert -list [-ovrg <server>]

The alias of the node certificate is the long sequence of characters, which appears under the
Certificates section of the output. For example:

+---------------------------------------------------------+

| Keystore Content | +---------------------------------------------------
------+

| Certificates: | cdc7b5a2-9dd6-751a-1450-eb556a844b55 (*) | +-----------
----------------------------------------------+

| Trusted Certificates: |

| CA_cdc7b5a2-9dd6-751a-1450-eb556a844b55 | +----------------------------
-----------------------------+

6. Run the following command:

ovcert -exportcert -file <file_name> -alias <alias> [-pass <password>]

The command backs up the node certificate in the file specified with the -file option.

To restore the certificates on the node, follow these steps:

1. Log on to the node with the root or administrative privileges.

2. Open a command prompt (shell).
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3. To restore themanagement server certificate, run the following command:

ovcm -importcacert -file <file_name> [-pass<password>]

4. To restore the trusted certificate, run the following command:

ovcert -importtrusted -file<file_name>

5. To restore the node certificate, run the following command:

ovcert -importcert -file <file_name> [-pass <password>]

Configuring SSL Certificates for the Agent Install Repository
Virtual Appliance
To secure the Agent Install Repository Virtual Appliance with self-signed certificates or certificates
signed by CA (Certificate Authority), youmust configure the Secure Socket Layer (SSL) certificate.

Create a SSL certificate and copy it on to the Agent Install Repository Virtual Appliance. Configure the
SSL certificate on the Lighttpd server.

Note: Lighttpd is a web server component present in Agent Install Repository.

After the Agent Install Repository is configured, install corresponding certificates on the nodes. You
can then download the oarepo.ps1 or oarepo.sh scripts forWindows and LINUX systems
respectively to install HP Operations Agent.

Follow the steps:

1. "Create a Certificate" below

2. "Configure SSLCertificate on the Lighttpd Server " on page 178

3. "Importing the SSLCertificate on a Node" on page 179

Create a Certificate

You can either create a self-signed certificate or send a certificate signing request to a Certificate
Authority.

Creating a Self-Signed Certificate

Follow the steps:
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1. Create a certificate store on the Lighttpd server to save certificates and key files.

2. Log on to a node and then run the command:

openssl req -x509 -nodes -days <n> -newkey rsa: <nbits> -keyout <your_domain_
name>.key -out <your_domain_name.>crt

In this instance:

Command Description

days Specifies the number of days to certify the certificate.

newkey
rsa :nbits

Newkey option creates a new certificate request and a new private key. The
newkey rsa :nbits option generates an RSA key with the specified size.

keyout Specifies the file name to write the newly created key.

out Specifies the output file name.

For example:

# openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout primary.key
-out cert.crt

Generating a 2048 bit RSA private key
...........................................................+++
..........................................................+++
writing new private key to 'primary.key'
-----
You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a
DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.

-----

Country Name (2 letter code) [XX]:in
State or Province Name (full name) []:ka
Locality Name (eg, city) [Default City]:bangalore
Organization Name (eg, company) [Default Company Ltd]:HP
Organizational Unit Name (eg, section) []:SM
Common Name (eg, your name or your server's hostname) []:16.184.47.108

3. A primary certificate (your_domain_name.crt) and private key (your_domain_name.key) is
generated.

Installation Guide

HP Operations Agent and
Infrastructure SPIs (12.00)

Page 177 of 197



4. Use the primary certificate and private key to configure the SSL certificate on the Lighttpd Server.

Sending a Certificate Signing Request

1. Create a certificate store on the Lighttpd server to save certificates and key files.

2. Log on to a node and then run the following command:

openssl req -new -key <filename>.pem -out <filename>.csr

For Example:

openssl req -new -key privkey.pem -out cert.csr

In this instance:

Command Description

new This command generates a new certificate request. It prompts users for the
relevant field values and creates a certificate after accepting relevant information.

key Specifies the file to read the private key.

out Specifies the output file to output certificates.

3. Send the generated .csr file to the CA authority.

4. After you receive the signed certificate from the CA use the Intermediate (CA_issuing.crt), primary
certificate (your_domain_name.crt) and private key (your_domain_name.key) to configure SSL
certificate on the Lighttpd Server.

Configure SSL Certificate on the Lighttpd Server

Follow the steps to configure SSL certificate on the Lighttpd server:

1. Copy the Intermediate certificate (CA_issuing.crt), primary certificate (your_domain_name.crt)
and private key (your_domain_name.key) to the certificate store.

Note:

A primary certificate (your_domain_name.crt) and private key (your_domain_name.key) is
generated when you create self-signed certificate.

When you request for a CA certificate, the certificate authority provides you the intermediate
(CA_issuing.crt), primary certificate (your_domain_name.crt) and private key (your_
domain_name.key).
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2. Run the following command to combine the private key file and the primary certificate file into a
single .pem file:

cat <your_domain_name.crt > <your_domain_name.key>> <your_domain_name>.pem

For example:

cat sitename.crt sitename.key > iwf0041067.pem

3. Open lighttpd.conf file located at /opt/vmware/etc/lighttpd/lighttpd.conf and change
the following:

ssl.pemfile = "/cert_path/ <your_domain_name.pem>"

Note: Add the following to the lighttpd.conf file only if the certificate is issued by a
certificate authority:

ssl.ca-file = ""/cert_path/CA_issuing.crt"

4. Run the following commands to restart Lighttpd server:

/etc/init.d/vami-sfcb restart

/etc/init.d/vami-lighttp restart

Importing the SSL Certificate on a Node

Follow the steps:

On Linux

1. Copy the SSL certificate to a file in the directory /etc/pki/tls/certs.

2. Run the following command to compute a hash code for the certificate:

openssl x509 -noout -hash -in /etc/pki/tls/certs/<filename.pem>

3. Use the hash code to create a symbolic link in the certs directory. Run the following command to
create a symbolic link:

ln -s /etc/pki/tls/certs/<filename.pem> /etc/pki/tls/certs/<hash code>

For example:

1. Copy the SSL certificate to a file - myserver.pem in the directory /etc/pki/tls/certs.

2. Run the following command to compute a hash code for the certificate:
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openssl x509 -noout -hash -in /etc/pki/tls/certs/myserver.pem

Let us assume the hash code generated is 1a2b3c4d.

3. Use the hash code to create a symbolic link in the certs directory. Run the following
command to create a symbolic link:

ln -s /etc/pki/tls/certs/myserver.pem /etc/pki/tls/certs/1a2b3c4d.0

Note: If there are other certificates in the certs directory that hash to the same hash code
(1a2b3c4d.0), then change the hash code to 1a2b3c4d.1 or 1a2b3c4d.2 and the like.

After the certificate is installed, the node is recognized as a trustedmachine.

On Windows:

Copy the SSL certificate to the node and then import the certificate to the Trusted Root Certification
Authorities folder. After the certificate is installed, the node is recognized as a trustedmachine.

Note: To verify if the certificate is installed correctly, double-click to open the Trusted Root
Certification Authorities folder > Certificate folder and then check if the certificate is installed.

Note: A signed certificate is valid only if you have the HP public key installed on your system.

Download the HP public key either from

Agent Install Repository Virtual Appliance - https://<IP address of your
system>/oarepo/hpPubKey2018.Pub

or from the following link:

https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinuxC
odeSigning

Copy the HP public key to the following location: /etc/pki/rpm-gpg/hppubkey2048.pub

Installing HP Operations Agent on a Trusted Machine

After you import and install SSL certificate, the node is recognized as a trustedmachine. Ensure that
you use the option -sec|-securedwith oarepo to allow only secured connection with Agent Install
Repository Virtual Appliance (or standalone Agent Install Repository) to download and install HP
Operations Agent.

Run the following command to install HP Operations Agent:

oarepo -i|-install -s|-server <server url> [-v|-version <version no.>] [-om|-om_
server <OM server name>] <[-unsec|-unsecure]|[-sec|-secure]>

On Windows
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./oarepo.ps1 -i -s <server url> -v <version no.> -sec

On Linux

./oarepo.sh -i -s <server url> -v <version no.> -sec

In this instance:

<server url>URL of the Standalone Agent Install Repository or Agent Install Repository Virtual
Appliance

<version no.> version number of the HP Operations Agent

<OM server name> IP address or host name of the HP Operations Manager.

For example:

oarepo -i -s https://myhostname:5480/ -v 12.00 -sec
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Chapter 22: Uninstalling the HP Operations Agent and
Infrastructure SPIs

Note: If the node hosts another HP Software product, make sure to stop all the processes of the
product prior to the agent uninstallation. After the agent is completely uninstalled, you can start the
processes of the HP Software product

1. Log on to the node with root or administrator.

2. Stop all agent processes by running the following commands:

opcagt -stop

ttd -k

3. Go to the following directory:

On Windows 64-bit

%OvInstallDir%bin\win64\OpC\install\cscript oainstall.vbs -r -a

On Other Windows

%OvInstallDir%bin\OpC\install\cscript oainstall.vbs -r -a

On Linux/HP-UX/Solaris

/opt/OV/bin/OpC/install/oainstall.sh -r -a

On AIX

/usr/lpp/OV/bin/OpC/install/oainstall.sh -r -a

4. Manually delete the following directories, if there are no other HP Software products installed on
the node:

On Windows:

%OvInstallDir%

%OvDataDir%

On Linux/HP-UX/Solaris

/opt/OV

/var/opt/OV
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/opt/perf

/var/opt/perf

On AIX:

/usr/lpp/OV

/var/opt/OV

/usr/lpp/perf

/var/opt/perf

Alternatively, on aWindows node, you can remove the HP Operations Agent 12.00 with the Programs
and Features (Add/Remove Programs) window by selectingHP Operations-agent.

Installation of the HP Operations Agent 12.00 adds the HP Operations-agent program to the Programs
and Features window.

Many new items such as HP Software E/A Agent, HP SoftwareMeasurement Interface, HP Software
Performance Core, and so on are also added to the Programs and Features window. While removing
the HP Operations Agent, choose only HP Operations-agent (and no other entries) in the Programs
and Features window.
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Chapter 23: Uninstalling the Infrastructure SPIs
Remove the Infrastructure SPI Policies from Managed Nodes

From HPOM for Windows

1. In the HPOM console tree, expand the folders Operations Manager > Policy Management >
Policy groups > Infrastructure Management.

2. Right-click Infrastructure Management, and then select All Tasks > Uninstall from....

3. In the Uninstall Policies dialog box, select All Nodes, and then click OK.

From HPOM on UNIX/Linux

1. Log on to the HPOM console as an administrator.

2. Select All Policy Assignments from the Browsemenu. The All Policy Assignments window
opens.

3. In the All Policy Assignments window, select the policy or policy groups you want to remove from
a node or a node group by clicking the Assignment Mode check box against the policies.

4. Select Delete Assignment... from the Choose an Action box and click Submit. A message
window appears specifying that the operation cannot be undone.

5. Click OK. The selected policy assignment is removed from the nodes.

6. From the HPOM Administration UI, click Node Bank under theObject Banks category. The
Node Bankwindow opens.

7. In theNode Bankwindow, select the nodes or node groups from which you want to remove the
policies.

8. Select Deassign from this Group... from the Choose an Action box and click Submit.

The policies are removed from the selected nodes.

Youmust wait until all policies are uninstalled from all nodes. The status of policy uninstallation can be
viewed in the Deployment jobs window.

Uninstall the Infrastructure SPIs

Note: To remove the Infrastructure SPIs, make sure you have approximately 240MB of total disk
space and 35MB of space in the temporary folders available on themanagement server.
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1. Log on to themanagement server.

2. Go to the following directory:

On Windows

%ovinstalldir%bin\OpC\agtinstall

On UNIX/Linux

/opt/OV/bin/OpC/agtinstall

3. Run the following command:

On Windows

cscript oainstall.vbs -r -m -spiconfig

On UNIX/Linux

./oainstall.sh -r -m -spiconfig

Note: In an HA cluster, perform the above steps on the active node first, and then on all nodes in
the cluster.
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Chapter 24: Troubleshooting
This section helps you troubleshoot such problems experienced during the installation and provides you
with information to help you avoid problems from occurring.

Installation
Installation of the Infrastructure SPIs fails on the HPOM for Windows management server

The installation of the Infrastructure SPIs with the cscript oainstall.vbs -i -m command fails on
the HPOM forWindows management server with the following error:

- VBS message

******* **** Error Number: 3000 - <date> - VBS message

******* **** Error Source: CheckRequirements - <date> - VBS message

******* **** Error Description: - general error checks.: ERRDESC -
Wrong number of arguments or invalid property assignment ; ERRNUM - 450
-<date> - VBS message

*******

- <date> - VBS message

******* !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
!!!!!!! - <date> - VBS message

Action ended <time>: VBSCheckRequirements. Return value 3.

Action ended <time>: INSTALL. Return value 3.

MSI (s) (CC:64) [<time>]: Product: HP Operations Smart Plug-in for
HA Cluster Infrastructure -- Installation operation failed.

MSI (s) (CC:64) [<time>]: Windows Installer installed the product.
Product Name: HP Operations Smart Plug-in for HA Cluster Infrastructure.

To resolve this issue, go to the %ovdatadir%log directory, remove the oainstall.log file (or save
the file with a different name), and then start the installation process. It is recommended that you take a
backup of the oainstall.log file before removing the file from the %ovdatadir%log directory.

Installation of HP Operations agent remotely from HPOM for UNIX/Linux management server
shows error message

When you are installing HP Operations agent for the first time, remotely from the HPOM for
UNIX/Linux management server, and select the force option, the system displays the following error
message:

ERROR: (depl-81) Unable to deploy 'OVO-Agent.xml' to node
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'Management_server_name'.

(depl-153) Bundle is not installable on host.

ERROR: Error occurred during transfer or upgrade of packages.

To stop seeing this error message, update the HP Operations agent version on themanagement server
to 12.00.

HP Performance Agent (PA) 5.0 packages on Windows nodes do not get replaced with
HP Operations agent 12.00 deployment packages after upgrade

When upgrading theWindows nodes, where PA 5.0 is installed, to HP Operations agent 12.00, the
older PA packages are not replaced by the new packages. The PA packages still remain on the node.
Even after applying the hotfix for the issue, the problem exists and you get the following error message:

Failed to deploy package 'Performance-agent' to node ‘xxxx'. Either the package itself or the
requested package version was not found on the management server.
Because of this error, the following package(s) have not been deployed again.
All other packages which are also installed on the node have been successfully re-deployed.

Check the deployment packages and synchronize the HP Operations agent packages to version 12.00
to resolve the issue. Perform the following tasks:

l "Deploy the HP Operations Agent 12.00 package" below

l "View the packages" below

l "Synchronize the deployment packages with the HP Operations agent version 12.00 " on the next
page

Deploy the HP Operations Agent 12.00 package

1. Click Deployment packages in the console tree.

2. Select the packages to deploy.

3. Right-click the selected packages and select All Tasks > Deploy on...

4. Select themanaged nodes to which you want to deploy the packages.

5. Click OK.

Tip: Alternatively, you can also drag-and-drop the packages to deploy.

View the packages

1. In the console tree, right-click the node where you want to check the installed packages.

2. Click View > Package Inventory. A list of installed packages appear in the Details pane. The
package inventory must have 12.00 Operations agent package.
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If the older PA version and hotfix details are available in the package inventory, complete the task
"Synchronize the deployment packages with the HP Operations agent version 12.00 " below.

Synchronize the deployment packages with the HP Operations agent version 12.00

1. From the console tree, right-click a node to open the context menu.

2. Select All Tasks > Synchronize Inventory > packages.

Installation of deployable packages fail on the HPOM for Windows server with the Error 103 -
PMAD corruption error

Installation of HP Operations agent fails if the undo log file is not present for a version (11.xx and 12.00)
but the entry is present in the PMAD database. To resolve this issue, you have to clean the PMAD
database. Use the ovpmad_dbcleanup script to remove the corrupted entries from the PMAD
database. ovpmad_dbcleanup script is provided in the scripts folder in themedia. The ovpmad_
dbcleanup script is designed only for the HPOM forWindows server.

Removing Corrupted Entries with ovpmad_dbcleanup Script:

Caution: Backup the PMAD database before you use the ovpmad_dbcleanup script.

Run the following command to remove corrupted entries:

cscript ovpmad_dbcleanup.vbs -p|-platform <OSname> -a|arch <arch> -v|-version
<version>

In this instance;

l <OSname> specifies the platform-specific packages to be removed from the database and inventory
on themanagement server.

You can use the following values:

n HP-UX

n SOLARIS

n AIX

n LINUX

n LINUX_DEB

n WINDOWS

l <version> specifies the active versions of the platform-specific packages to be removed from the
database entries on themanagement server.

l <arch> specifies the architecture for the platform-specific packages to be removed from the
database entries on themanagement server.
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For example:

cscript ovpmad_dbcleanup.vbs -p Linux -a X64 -v 11.00.044

Note: From the PMAD corruption error message you can get the parameters to run the ovpmad_
dbcleanup script .

For example:

server ERROR[103]: PMAD corruption C:\HPOM\data\shared\\Packages\undo\OA_
Linux2.6_X86_Ver_11.11.025.log not found

ERROR: PMAD corruption found for LINUX x86 11.11.025

In this instance; you get the following parameters from the error message:

l Operating System - LINUX

l Architecture - x86

l Version 11.11.025.

You can use the parameters to run the ovpmad_dbcleanup script as follows:

cscript ovpmad_dbcleanup.vbs -p Linux -a X86 -v 11.11.025

Registration of HP Operations agent fails on the HPOM for Windows Server

Registration of HP Operations Agent fails on the HPOM forWindows server with the following error:

Description: (PMD97) Exception has been caught in method

COvPmdPolicyManager::AddDeploymentPackage2

ERROR: (NPREG1024) Cannot add deployment package (PD: 'E:\Agent

Installer\OMWAgent_11_11\packages\WIN\Windows_X64\OVO-Agent.xml')

to policy management server (PMAD)

Error during registration.

The error occurs if a directory or a file in the %OvDataDir%\shared\Packages\HTTPS directory has a
long file name or path. To resolve this issue, delete the files or directories with long file names and then
try to register HP Operations agent on the HPOM forWindows server.

To prevent this issue from occurring, ensure that you do not havemany nested folders or files with long
file names.

Note: OnWindows, themaximum length for a path is defined as 260 characters.

IPV4/IPV6 configuration check fails during the installation of the HP Operations Agent
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During the installation of the HP Operations Agent, IPV4/IPV6 configuration check fails with the
following error:

[ FAIL ] Check if IPV4/IPV6 configuration is fine

IPV4/IPV6 configuration is not fine. Refer to oainstall.log at
/var/opt/OV/log location.

If the IPV4/IPV6 configuration check fails, HP Operations Agent is successfully installed but the agent
processes fail to function.

To resolve this issue:

l Ensure that at least one IP address is configured

l Ensure that IP address and the host name is mapped correctly.

To configure the HP Operations agent to use a specific IP address, see Configuring Nodes with
Multiple IP Addresses

Remote deployment of HP Operations agent 12.00 to a HP-UX IPF32 node fails

Remote deployment of HP Operations agent 12.00 from the HPOMmanagement server to a HP-UX
IPF32 node fails as the desired agent binary format for the HP Operations Agent12.00 is HP-UX IPF64.

For example:

Youwill get the following error message if you deploy HP Operations Agent12.00 from aHPOM for
Windows management server to a HP-UX IPF32 node:

(PMD936) The package 'Operations-agent' does not support the platform of node
'hpvm38'(OS type 'HP-UX', OS version '11.31', agent binary format 'IPF32', and
agent type 'HTTPS').

You can install the HP Operations agent 12.00 only on HP-UX IA64 systems with the patch level
qpkbase package September 2013 or superseding patches.

To prevent the error during deployment, ensure that the HP-UX node where you want to install HP
Operations Agent12.00 is a HP-UX IA64 systems with the patch level qpkbase package September
2013 or a superseding patch. Run the following command to check the patch level:

swlist | grep -i qpkbase

Note:

If you use the auto discovery option to add a HP-UX node, HP-UX IA64 node is added as HP-UX
IPF32 node. This will cause the remote deployment of HP Operations Agent12.00 to fail on such
nodes. To prevent this, use the expert mode tomanually add a HP-UX IA64 node.

Follow the steps:

1. Log on to the HPOMmanagement server, select Nodes -> Configure -> Nodes

2. In theConfigure Managed NodesWindow, select Nodes -> right click to select New Node
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3. In theBase SettingWindow;

Enter the Fully Qualified Domain Name and Display Name

Select Use discovery service and then click Next

4. In theOS SetupWindow, select the following:

n System Type - Itanium Compatible

n Operating System - HP-UX

n Bit Length - 64

n Version - B.11.31

and then click theExpert Mode

5. In theNode PropertiesWindow -> Go to theSystem tab -> select IPF64 from theAgent
Binary Format drop-down.

Installation of the third-party rpm fails on SLES 11 SP2 after installing the HP Operations
Agent

The installation of the third-party RPM package fails after installing the HP Operations Agent on SLES
11 SP2with the following error:

insserv: warning: script '<Script_Name>' missing LSB tags and overrides

insserv: Default-Start undefined, assuming default start runlevel(s) for script

`<Script_Name>'

insserv: Stopping <Script_Name> depends on OVCtrl and therefore on system
facility

`$all' which cannot be true!

insserv: exiting now without changing boot order!

/sbin/insserv failed, exit code 1

HP Operations Agent 11.12 and above conform to the standard LSB tags. The LSB tags must be
present in the init scripts on SLES 11 SP2 and above. During the installation of the third-party RPM
package on SLES 11 SP2, the error occurs if the LSB tags aremissing in the third-party application init
scripts.

Solution:

The application vendors must add proper LSB tags in the third-party application scripts.

(or)
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Youmust upgrade from SUSE Linux Enterprise Server 11 Service Pack 2 to SUSE Linux Enterprise
Server 11 Service Pack 3. The HP Operations Agent 11.13 supports the SUSE Linux Enterprise Server
11 Service Pack 3.

Installation of the Infrastructure SPIs Fails on HPOM for Solaris Management Server with the
Error “XMLin() requires either XML::SAX or XML::Parser”

Installation of the Infrastructure SPIs fails with the followingmessage:

XMLin() requires either XML::SAX or XML::Parser at ./scripts/oaproductinstall.pl
line 402

Solution:

Ensure that the libgcc_s.so.1 library is present on Solaris system while registering the HP Operations
Agent on theManagement Server.

Remote deployment of HP Operations Agent 8.60.501 downgrades HP Operations Agent
installed on Windows systems.

HP Operations Agent 11.xx installed onWindows nodes are downgraded to HP Operations Agent 6.2 if
you deploy HP Operations Agent 8.60.501 from HPOM forWindows Management Server.

Remote deployment of HP Operations Agent 8.60.501 triggers the installation of 8.60 bits with -force
option. The -force option downgrades any available version of HP Operations Agent to 6.2.

The remote deployment of HP Operations Agent 8.60.501 from HPOM forWindows Management
Server is not supported.

Certificates
Installation of the HP Operations Agent on Linux machines shows warning messages in the
log files associated with rpm signatures

The oainstall.log or oapatch.log files associated with rpm signatures may show the following
warningmessage during the installation of the HP Operations Agent on Linux machines:

<Header V3 RSA/SHA1 signature>: NOKEY, <key ID>

For example:

Warning: /var/opt/OV/installation/standalone/HPOvXpl.rpm: Header V3 RSA/SHA1
signature: NOKEY, key ID 5ce2d476

Warning: /var/opt/OV/installation/standalone/HPOvBbc.rpm: Header V3 RSA/SHA1
signature: NOKEY, key ID 5ce2d476

To resolve this issue, ensure that you import the HP public key before installing the HP Operations
agent.

Follow the steps mentioned in the following link to import the HP public key:
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https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinux
CodeSigning

The warningmessage does not affect installation of the HP Operations Agent. If you do not want to
import the HP public key, ignore the warningmessages appearing in the log files.

Signatures in vbs scripts are slow and causes delay when running some of the HP Operations
Agent commands

Problem: HP Operations Agent contains digitally signed code. This is to protect the integrity of the
software. Sometimes, when you run HP Operations Agent commands on themanaged node, the
response is very slow. The signatures in vbs scripts causes delay when running the commands such
as opcagt -type, status and so on. The delay may occur due to Certificate Revocation List (CRL)
check.

Solution 1:

On Windows

1. Log on to theWindows system.

2. From the Start menu, open the Run prompt.

3. In the Run prompt, typeSecPol.msc, end then press Enter. The Local Security Policy editor
window opens.

4. In the Local Security Policy editor window, click to open thePublic Key Policies folder.

5. In the right pane, double-click Certificate Path Validation Settings. TheCertificate Path
Validation Settings Properties dialog box opens.

6. In theCertificate Path Validation Settings Properties dialog box, click to select theDefine
these policy settings checkbox.

Note: Select the timeout values less than the recommended setting. For example, the
Default retrieval settings can be reduced from 15-20 seconds to 1 second or to any lower
suitable values.

7. Click OK.

Solution 2:

Run the following command in the command prompt to set a proxy, which allows CRL validation with
external site:

netsh winhttp set proxy localhost "<local>"

(or)

1. In the Run prompt, type control inetcpl.cpl, 4 and then press Enter. The Internet Properties
window opens with theConnections tab enabled.

2. Click Lan settings. The Local Area Network (LAN) Settingswindow opens.
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3. Select theUse a proxy server for your LAN checkbox.

4. In theAddress box, type the address of your proxy server.

5. In thePort box, type the port number of the port you want to access.

6. Click OK.

Note: You can set a proxy which allows CRL validation with external site only if you have
environments with internet access. A real proxy can be set if your environment allows, else set a
dummy proxy.

Coexistence of HP Computesensor Standalone Packages
(shippped with vPV) and HP Operations Agent 12.00
Scenario 1:On a VM, after you install HP Operations Agent 12.00, installation of HPComputesensor
2.01.004 (or earlier versions) is not supported.

Scenario 2: Installation of HP Operations Agent 12.00 is not supported on amachine where HP vPV
(HP Virtualization Performance Viewer) 2.2 (or earlier versions) is installed.

Scenario 3: HP Computesensor process is in aborted state

On a VM running with HPComputesensor 2.01.004 (or earlier versions) and HP Operations Agent
12.00, if you uninstall HPComputesensor 2.01.004 (or earlier versions), the functionality of the
hpsensor process is affected.

Workaround:

1. Go to the following directory:

On 64-bit versions of Windows

%ovinstalldir%bin\win64\OpC\install

On 32-bit versions of Windows

%ovinstalldir%bin\OpC\install

On Linux/HP-UX/Solaris

/opt/OV/bin/OpC/install

On AIX

/usr/lpp/OV/bin/OpC/install

2. Run the following command:
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On Windows

cscript oainstall.vbs –c –a

On Linux/HP-UX/Solaris/AIX

./oainstall.sh –c -a

After HP Operations Agent 12.00 is reconfigured, the hpsensor process starts running.

Note: Run the following command to check the status of the hpsensor process:

ovc –status

Scenario 4: The communication between a VM (where HP Computesensor is installed) and the
HP vPV machine is disconnected, after HP Operations Agent 12.00 is installed on the VM.

The issue occurs only with HP vPV 2.20 and earlier versions. To resolve this issue follow the steps:

1. Install HP Operations Agent certificate from a trusted CA onto the vPV machine.

Note: Run the ovcert -list command to ensure the certificate is installed.

2. vPV server reads the certificate from the ovrg namespace. Follow the steps to import the
certificate into ovrg namespace:

a. Log on to the vPV machine and export the certificate to the server resource group:

o Run the following command to export the certificate to a file:

ovcert -exportcert -file -pass

For example:

ovcert -exportcert -file C:\temp\cert -pass 123

o Run the following command to export the trusted certificate to a file:

ovcert -exporttrusted -file

For example:

ovcert -exporttrusted -file C:\temp\cert1

b. Run the following command to import the certificate to the server resource group:

ovcert -importcert -file -ovrg server –pass
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For example:

ovcert -importcert -file c:\temp\cert -ovrg server -pass 123

Note: To import these certificates, use the same password that you used while exporting
the certificate.

c. Run the following command to import the trusted certificate to the server resource group:

ovcert -importtrusted -file -ovrg server

For example:

ovcert -importtrusted -file C:\temp\cert1 -ovrg server

Other
On Solaris 10, the ovc -status command reports the adminui process as stopped

Although the adminui process with a longer path (which exceeds 80 characters) is running on Solaris
10, the ovc –status command reports the process as stopped. This is because on Solaris 10, the
process details beyond 80 characters gets truncated, which is a limitation of Solaris 10.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation Guide (Operations Agent and Infrastructure SPIs 12.00)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to docfeedback@hp.com.

We appreciate your feedback!
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